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1 Introduction

Welcome to this User Guide for Ocula 4.0 on Nuke. Ocula is a collection of tools that solve common problemswith
stereoscopic imagery, improve productivity in post production, and ultimately help to deliver amore rewarding 3D-
stereo viewing experience.

All Ocula nodes integrate seamlessly into Nuke. They are applied to your clips as any other node and they can all be
animated using the standard Nuke animation tools.

About this User Guide
This User Guidewill tell you how to install and use theOcula 4.0 nodes and tools. Each node or tool is described in
detail in later chapters. Licensing Ocula is covered in the separate Foundry Licensing Tools (FLT) User Guide, which
you can download fromhttp://www.thefoundry.co.uk/licensing.

This guide assumes you are familiar with Nuke and themachine it is running on.

NOTE: For themost up-to-date information, please see theOcula on Nuke product page and the latest
Ocula 4.0 user guide on ourwebsite at http://www.thefoundry.co.uk.

Special thanks to Disney Enterprises, Inc. for use of the TRON: LEGACY images throughout this user guide.

What’s New?
Have a look at the new features and improvements in Appendix A.

Example Images
Example images are provided for usewith Ocula. You can download these images fromourwebsite at
http://www.thefoundry.co.uk/support/user-guides#ocula and try Ocula out on them.

http://www.thefoundry.co.uk/support/user-guides#ocula
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Installation
Installing Ocula 4.0 will NOT overwrite any versions of Ocula 3.x, Ocula 2.x, or Ocula 1.x.

To see the installation instructions for your operating system, go to:

• Installation onWindows

• Installation onMac

• Installation on Linux

NOTE: You can put theOcula nodes anywhere as long as you set the environment variable NUKE_PATH to
point to it.

Installation on Windows

Ocula is distributed as a software download fromourwebsite at http://www.thefoundry.co.uk/. To install Ocula on a
computer runningWindows, follow these instructions:

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourwebsite at http://www.thefoundry.co.uk/:
Ocula_4.0v1_Nuke_<version>-win-x86-release-64.zip

2. Unzip the file you downloaded.

3. Double-click on the exe file to launch the installer. Follow the on-screen instructions to install Ocula.

4. Proceed to Licensing Ocula.

Installing Ocula from the command line

To install Ocula from the command line, do the following:

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download and unzip the following file fromourwebsite at http://www.thefoundry.co.uk/:
Ocula_4.0v1_Nuke_<version>-win-x86-release-64.zip

2. To open a command prompt window, select Start > All Programs > Accessories > Command Prompt.

3. Use the cd (change directory) command tomove to the directory where you saved the installation file. For
example, if you saved the installation file in C:\Temp, use the following command and press Return:

1 INTRODUCTION | INSTALLATION
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cd \Temp

4. To install Ocula, do one of the following:

• To install Ocula and display the installation dialog, type the name of the install file without the file extension
and press Return:
Ocula_4.0v1_Nuke_<version>-win-x86-release-64

• To install Ocula silently so that the installer does not prompt you for anything but displays a progress bar,
enter /silent after the installation command:
Ocula_4.0v1_Nuke_<version>-win-x86-release-64 /silent

• To install Ocula silently so that nothing is displayed, enter /verysilent after the installation command:
Ocula_4.0v1_Nuke_<version>-win-x86-release-64 /verysilent

NOTE: By running a silent install of Ocula, you agree to the terms of the End User License Agreement. To
see this agreement, please refer to Appendix D or run the installer in standard, non-silent mode.

Installation on Mac

Ocula is distributed as a software download fromourwebsite at http://www.thefoundry.co.uk/. To install Ocula 4.0
on aMac, follow these instructions:

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourwebsite at http://www.thefoundry.co.uk/:
Ocula_4.0v1_Nuke_<version>-mac-x86-release-64.dmg

2. Double-click on the downloaded dmg file.

3. Double-click on the pkg file that is created.

4. Follow the on-screen instructions to install Ocula.

5. Proceed to Licensing Ocula.

Installing Ocula silently from the command line

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourwebsite at http://www.thefoundry.co.uk/:
Ocula_4.0v1_Nuke_<version>-mac-x86-release-64.dmg

2. Launch a Terminal window.

3. To mount the dmg installation file, use thehdiutil attach command with the directory where you saved the
installation file. For example, if you saved the installation file in Builds/Ocula, use the following command:

1 INTRODUCTION | INSTALLATION
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hdiutil attach /Builds/Ocula/Ocula_4.0v1_Nuke_<version>-mac-x86-release-64.dmg

4. Enter the following command:
pushd /Volumes/Ocula_4.0v1_Nuke_<version>-mac-x86-release-64/

This stores the directory path inmemory, so it can be returned to later.

5. To install Ocula, use the following command:
sudo installer -pkg Ocula_4.0v1_Nuke_<version>-mac-x86-release-64.pkg -target "/"

You are prompted for a password.

6. Enter the following command:
popd

This changes to the directory stored by the pushd command.

7. Finally, use the following command to eject themounted disk image:
hdiutil detach /Volumes/Ocula_4.0v1_Nuke_<version>-mac-x86-release-64/

NOTE: By running a silent install of Ocula, you agree to the terms of the End User License Agreement. To
see this agreement, please refer to Appendix D or run the installer in standard, non-silent mode.

Installation on Linux

Ocula is distributed as a software download fromourwebsite at http://www.thefoundry.co.uk/. To install Ocula 4.0
on a computer running Linux, follow these instructions:

NOTE: Throughout the following instructions, please replace <version> with theNuke release you're
using.

1. Download the following file fromourwebsite at http://www.thefoundry.co.uk/:
Ocula_4.0v1_Nuke_<version>-linux-x86-release-64.tgz

2. Move the downloaded file to the following directory (create the directory if it does not yet exist):
/usr/local/Nuke/

3. In the abovementioned directory, extract the files from the archive using the following command.
tar xvzf Ocula_4.0v1_Nuke_<version>-linux-x86-release-64.tgz

This will create the <version>/plugins/Ocula/4.0 subdirectory (if it doesn’t already exist), and install Ocula in
that directory.

4. Proceed to Licensing Ocula.

1 INTRODUCTION | INSTALLATION
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Licensing Ocula

About Licences

If you simply want to try out Ocula, you can obtain a trial licence, which allows you to run Ocula for free for 15 days.

To useOcula after this trial period, you need either a valid license key or a floating license and server running the
Foundry Licensing Tools (FLT):

• Licence Keys - These can be used to install and activatenode locked (also known as uncounted) licences. Node
locked licences allow you to useOcula on a singlemachine. This licencewill not work on a different machine and if
you need it to, you’ll have to transfer your licence. Node locked licences do not require additional licensing software
to be installed. See Licensing Ocula on a SingleMachine formore information.

• Floating Licences - also known as counted licences, enableOcula to work on any networked client machine. The
floating licence should be put on the server and is locked to a unique number on that server. Floating licences on a
server require additional software to be installed. This softwaremanages those licences on the server, giving
licences out to client stations that want them. The software you need to manage these licenses is called the
Foundry License Tools (FLT) and it can be freely downloaded fromourwebsite. Floating licences often declare a
port number on the server line and a port number on the vendor line. See Licensing Ocula over a Network formore
information.

WARNING: If there is an interruption between the licence server and Ocula, rendering aborts with an exit
code of 1. You can use the --cont command line argument to forceOcula to continue rendering on failure,
producing black licence failure frames rather than aborting thewhole render.

The instructions below run through both licensingmethods, and you can find amore detailed description in the
Foundry Licensing Tools User Guide available on our website: http://www.thefoundry.co.uk/support/licensing/

Licensing Ocula on a Single Machine

Obtaining a Licence Key

You can purchase licence keys by:

• going to our website at http://www.thefoundry.co.uk/,

• e-mailing us at sales@thefoundry.co.uk,

• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.

1 INTRODUCTION | LICENSING OCULA
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To generate a licence key, we need to know your System ID. The System ID (sometimes called Host ID or rlmhostid)
returns a unique number for your computer. We lock our licence keys to the System ID.

To display your System ID, do the following:

• OnWindows andMac

Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. The
System ID is displayed at the bottomof thewindow.

• On Linux

Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it from the
command line:
<download location>/FoundryLicenseUtility -i

NOTE: The <download location> refers to the location where you saved the Foundry Licensing Utility.

Just so you knowwhat a System ID number looks like, here’s an example: 000ea641d7a1.

Installing the Licence

Once a license has been generated for you, we e-mail you the license key and instructions on how to obtain the
correct version of the Foundry LicenseUtility (FLU). Gunzip or untar the file and save the FLU and your license key to
a folder of your choice. The instructions below tell you what to do with these.

OnWindows andMac

Just drop the licence key on the Foundry LicenseUtility (FLU) application to install it. This checks the licence key and
copies it to the correct directory.

On Linux
1. Navigate to the location of the FLU_[version]_linux-x86-release-64.tgz file.

2. Type the following commands to extract and install the FLU. Note that you need to replace [version]with the
version of FLU you are using and [my licence]with the location of your licence key.
tar xvzf FLU_[version]_linux-x86-release-64.tgz

cd FLU_[version]_linux-x86-release-64

./FoundryLicenseUtility -l [my license]

For example, if you saved your licence key to /tmp/Foundry.lic, the last line should be:
./FoundryLicenseUtility -l /tmp/foundry.lic

This checks the licence key and copies it to the correct directory.

1 INTRODUCTION | LICENSING OCULA ON A SINGLEMACHINE
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Licensing Ocula over a Network

Obtaining Floating Licences

You can purchase a floating licence key by:

• going to our website at http://www.thefoundry.co.uk/,

• e-mailing us at sales@thefoundry.co.uk,

• phoning our London office at +44 20 7479 4350 or our Los Angeles office at +1 (310) 399 4555.

To generate you a licence key, we need to know the System ID of themachine that will act as the server. The System
ID (sometimes called Host ID or rlmhostid) returns a unique number for the computer. We lock our licence keys to
the System ID. See Installing Floating Licences.

To display your System ID, do the following:

• OnWindows andMac

Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. The
System ID is displayed at the bottomof thewindow.

• On Linux

Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it from the
command line:
<download location>/FoundryLicenseUtility -i

NOTE: The <download location> refers to the location where you saved the Foundry Licensing Utility.

NOTE: The System ID needs to be from themachine that will act as the server and not one of the client
machines.

Just so you knowwhat a System ID number looks like, here’s an example: 000ea641d7a1.

Installing Floating Licences

Once a floating licence has been created for you, we e-mail you a file containing the license key and instructions on
how to obtain the correct version of the Foundry LicenseUtility (FLU). Gunzip or untar the file and save the FLU and
your license key to a folder of your choice.

Having installed a floating licence key, you need to install some additional software (FLT) to manage the licences on
your network. Then you need to tell the client machines where to find the licences.

1 INTRODUCTION | LICENSING OCULA OVER A NETWORK

http://www.thefoundry.co.uk/support/licensing/
http://www.thefoundry.co.uk/support/licensing/


16

OnWindows andMac
1. Just drop the licence key on the Foundry LicenseUtility (FLU) application to install it. This checks the licence key

and copies it to the correct directory.

The licence server address is displayed on screen:

<number>@<licence server name>

You shouldmake a note of the address as you’ll need it to activate the client machines.

2. In order for the floating licence to work, you need to install the Foundry Licensing Tools (FLT) on the licence
servermachine (not the client machines). Formore information on how to install floating licences, refer to the
FLT user guide, which you can download fromourwebsite:
http://www.thefoundry.co.uk/support/licensing/tools/.

3. Once your licence server is up and running, you need to direct your client machines to the server in order to
obtain a licence. See Telling the Client MachinesWhere to Find the Licences.

On Linux
1. Navigate to the location of the FLU_[version]_linux-x86-release-64.tgz file.

2. Type the following commands to extract and install the FLU. Note that you need to replace [version]with the
version of FLU you are using and [my licence]with the location of your licence key.
tar xvzf FLU_[version]_linux-x86-release-64.tgz

cd FLU_[version]_linux-x86-release-64

./FoundryLicenseUtility -l [my license]

For example, if you saved your licence key to /tmp/Foundry.lic, the last line should be:
./FoundryLicenseUtility -l /tmp/Foundry.lic

This checks the licence key and copies it to the correct directory.

The licence server address is displayed on screen:

<number>@<licence server name>

You shouldmake a note of the address as you’ll need it to activate the client machines.

3. In order for the floating licence to work, you need to install the Foundry Licensing Tools (FLT) on the licence
servermachine (not the client machines). Formore information on how to install floating licences, refer to the
FLT user guide, which you can download fromourwebsite:
http://www.thefoundry.co.uk/support/licensing/tools/.

4. Once your licence server is up and running, you need to direct your client machines to the server in order to
obtain a licence. See Telling the Client MachinesWhere to Find the Licences.

Telling the Client Machines Where to Find the Licences

In order for the client machines to get a licence from the server, they need to be told where to look.

1 INTRODUCTION | LICENSING OCULA OVER A NETWORK
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OnWindows andMac
1. Launch the Foundry LicenseUtility (FLU).

2. Make sure you are viewing the License Install tab and copy and paste in an RLM server line:
HOST <server name> any <port>

For example: HOST red any 4101

This creates and installs both a FLEXlm and an RLM client license.

3. Repeat this process for eachmachine you wish to have access to licenses on the server.

On Linux
1. Launch a shell and navigate to the location of the FLU_[version]_linux-x86-release-64.tgz file.

2. Type the following commands, replacing [version]with the version of FLU you are using:
tar xvzf FLU_[version]_linux-x86-release-64.tgz

cd FLU_[version]_linux-x86-release-64

./FoundryLicenseUtility -c <port>@<server name>

For example, the last linemay be:
./FoundryLicenseUtility -c 4101@red

This creates and installs both a FLEXlm and an RLM client license.

3. Repeat this process for eachmachine you wish to have access to licenses on the server.

Further Reading

There is a lot to learn about licenses, much of which is beyond the scope of thismanual. Formore information on
licensing Ocula, displaying the System ID number, setting up a floating license server, adding new license keys and
managing license usage across a network, you should read the Foundry Licensing Tools (FLT) User Guide, which can be
downloaded fromourwebsite, www.thefoundry.co.uk/support/licensing/

Other Foundry Products
The Foundry is a leading developer of visual effects and image processing technologies for film and video post
production. Its stand-alone products includeNuke, Modo, Mari, Hiero, Katana, and Flix. The Foundry also supplies a
suite of plug-ins, including Ocula, CameraTracker, Keylight, Kronos, and Furnace and FurnaceCore for a variety of
compositing platforms, including Adobe® After Effects®, Autodesk® Flame®, Avid® DS™, and Apple’s Final Cut
Pro®. For the full list of products and supported platforms, visit our website at http://www.thefoundry.co.uk.

Nuke is an Academy Award®winning compositor. It has been used to create extraordinary images on scores of
feature films, including Avatar, District 9, TheDark Knight, IronMan, Quantumof Solace, The Curious Case of
Benjamin Button, Transformers, and Pirates of the Caribbean: At World’s End.

1 INTRODUCTION | OTHER FOUNDRY PRODUCTS
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Modo brings you the next generation of 3D modeling, animation, sculpting, effects and rendering in a powerful
integrated package.

Mari is a creative texture-painting tool that can handle extremely complex or texture-heavy projects. It was
developed at Weta Digital and has been used on films, such as District 9, TheDay the Earth Stood Still, The Lovely
Bones, and Avatar.

Hiero is a collaborative, scriptable timeline tool that conforms edit decision lists and parcels out VFX shots to artists,
allowing progress to be viewed in context, and liberating your finishing systems and artists formore creative tasks.

Katana is a look development and lighting tool, replacing the conventional CG pipelinewith a flexible recipe-based
asset workflow. Its node-based approach allows rapid turnaround of high-complexity shots, while keeping artists in
control and reducing in-house development overheads. Extensive APIsmean it integrates with a variety of renderers
and your pre-existing shader libraries and workflow tools.

Flix is a collaborative, visual story-development tool. It allows directors, editors, cinematographers, storyboard
artists, and pre-visualization artists to explore ideas quickly, saving valuable time, and to easily collaborate on the
visual story development of a film.

Ocula is a collection of tools that solve common problemswith stereoscopic imagery, improve productivity in post
production, and ultimately help to deliver amore rewarding 3D-stereo viewing experience.

CameraTracker is an After Effects plug-in allowing you to pull 3D motion tracks andmatchmoves without having to
leave After Effects. It analyses the source sequence and extracts the original camera's lens andmotion parameters,
allowing you to composite 2D or 3D elements correctly with reference to the camera used to film the shot.

Keylight is an industry-proven blue/green screen keyer, giving results that look photographed, not composited. The
Keylight algorithmwas developed by the Computer Film Company who were honoured with a technical achievement
award for digital compositing from the Academy of Motion Picture Arts and Sciences.

Kronos is a plug-in that retimes footage usingmotion vectors to generate additional images between frames.
Utilising NVIDIA’s CUDA technology, Kronos optimises your workflow by using both the CPU and GPU.

Furnace and FurnaceCore are collections of film tools. Many of the algorithms utilisemotion estimation technology
to speed up common compositing tasks. Plug-ins includewire removal, rig removal, steadiness, deflicker, degrain and
regrain, retiming, and texture tools.

1 INTRODUCTION | OTHER FOUNDRY PRODUCTS



2 DisparityGenerator

Description
TheO_DisparityGenerator node is used to create disparity maps for stereo images. A disparity map describes the
location of a pixel in one view in relation to the location of its corresponding pixel in the other view. It includes two
sets of disparity vectors: onemaps the left view to the right, and the othermaps the right view to the left.

NOTE: O_DisparityGenerator only requires an O_Solver node as one of its inputs if you intend to use the
Alignment control. Alignment defaults to 0, but increasing it forces the disparity map to match the
camera geometry to remove noise on the vertical component of disparity. Youmight want to do this if
your plates don't containmuch detail, such as bluescreen images withmarkers in the background or plates
with a lot of featureless areas like sky.

The following Ocula nodes rely on disparity maps to produce their output:

• O_OcclusionDetector

• O_ColourMatcher

• O_FocusMatcher

• O_VerticalAligner (in Local Alignmentmode)

• O_NewView

• O_InteraxialShifter

• O_DisparityToDepth, and

• O_DisparityViewer.

If you havemore than one of these nodes in theNodeGraph with one ormore of the same inputs, they might well
require identical disparity map calculations. O_DisparityGenerator is a utility node designed to save processing time
by allowing you to create the disparity map separately, so that the results can then be reused by other Ocula nodes.

The final disparity vectors are stored in disparity channels, so youmight not see any image data appear when you
first calculate the disparity map. To see the output insideNuke, select a disparity channel from the channel controls
in the top-left corner of the Viewer. Examples of what a disparity mapmight look like using the RGB and R channels,
after adjusting the Viewer gain and gamma controls, are shown below. As you can see, the RGB layers on the left
are harder to read than the single R channel.
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In general, once you have generated a disparity map that describes the relation between the views of a particular clip
well, it will be suitable for use inmost of theOcula nodes. We recommend that you insert aWrite node after O_
DisparityGenerator to render the original images and the disparity channels as a stereo .exr file (sometimes referred
to as .sxr). This format allows for the storage of an imagewithmultiple views and channel sets embedded in it. Later,
whenever you use the same image sequence, the disparity map is loaded into Nuke together with the sequence and
is readily available for other Ocula nodes. For information on how to render disparity in to an .exr file, seeWriting
Disparity into a Clip.

If you have a CG scenewith camera information and a z-depthmap available, you can also create disparity maps
using theO_DepthToDisparity node. Formore information, see DepthToDisparity.

Inputs
O_DisparityGenerator has the following inputs:

Source A stereo pair of images. If you intend to use theAlignment control, O_
DisparityGenerator requires an O_Solver node as one of its inputs. Alignment
defaults to 0, but increasing it forces the disparity map to match the camera
geometry to remove noise on the vertical component of disparity.

2DISPARITYGENERATOR | INPUTS
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Mask An optionalmask that specifies areas to exclude from the disparity calculation. You
can use this input to prevent distortions at occlusions or to calculate disparity for a
background layer by ignoring foreground elements.

Note that masks should exist in both views, and O_DisparityGenerator treats the
alpha values of 1 as foreground and blurs to the 0 value using nearby disparity to
recreate object boundaries, rather than image data. When you create amask using
Roto or RotoPaint, you can use the feather control to extend the calculation. For
example, the disparity mapmay have a sharper transition at depth edges with a
binary mask, but applying feather on themask can help smooth the resulting
image.

The left view. Amask to select the dancers in the left
view.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B.

Generating Disparity Maps
To generate a disparity map, do the following:

1. Launch Nuke and press S on theNodeGraph to open the project settings. Go to theViews tab and click the Set
up views for stereo button.

2. From the Toolbar, select Image > Read to load your stereo clip into Nuke. If you don’t have both views in the
same file, select Views > JoinViews to combine them, or use a variable in the Read node’s file field to replace the
name of the view (use the variable%V to replace an entire view name, such as left or right, and%v to replace
an initial letter, such as l or r). Formore information, refer to theNuke User Guide.

3. Select Ocula > Ocula 4.0 > O_DisparityGenerator to insert an O_DisparityGenerator node after the Read
node.

NOTE: If you intend to use theAlignment control, O_DisparityGenerator requires an O_Solver node as
one of its inputs. Alignment defaults to 0, but increasing it forces the disparity map to match the camera
geometry to remove noise on the vertical component of disparity. See Generating Disparity Using
Alignment formore information.
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4. Open theO_DisparityGenerator controls. O_DisparityGenerator renders using the Local GPU specified, if
available, rather than the CPU. The output between theGPU and CPU is identical, but using theGPU can
significantly improve processing performance.

If no suitable GPU or the required NVIDIA CUDA drivers are available, O_DisparityGenerator defaults to the CPU.
You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an alternative
card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.

5. From theViews to Usemenu or buttons, select which views you want to use for the left and right eyewhen
creating the disparity map.

6. If there are areas in the image that you want to ignorewhen generating the disparity map, supply amask either
in theMask input or the alpha of the Source input. In theO_DisparityGenerator controls, setMask to the
component you want to use as themask.

Note that masks should exist in both views, and O_DisparityGenerator treats the alpha values of 1 as
foreground and blurs to the 0 value using nearby disparity to recreate object boundaries, rather than image
data. When you create amask using Roto or RotoPaint, you can use the feather control to extend the
calculation. For example, the disparity mapmay have a sharper transition at depth edges with a binary mask, but
applying feather on themask can help smooth the resulting image.

7. Attach a Viewer to theO_DisparityGenerator node, and display one of the disparity channels in the Viewer by
selecting it from the channels dropdown above the Viewer.

O_DisparityGenerator calculates the disparity map and stores it in the disparity channels.

The Source clip. A disparity map.

TIP: Reading depth in disparity maps can be tricky in RGB. There are a number of ways to make the depth
easier to read, but the simplest is to:

• Set the Viewer channels control to disparityL and theR layer within the channel.

• Move the pointer around the image to locate the highest positive or negative red value using the Viewer
info bar.

• Set the gain field to +/-1 divided by the red value. For example, 1/20 for positive values or -1/20 for
negative values.
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• Adjust the gain and gamma controls to reveal edges and areas of contrast. Darker areas of the image
are closer to the camera and lighter areas farther away. If you use a positive gain, the light and dark
colours are flipped.

8. If the calculated disparity map does not produce the results you’re after (and you have already checked the
quality of the solve as described in Reviewing and Editing the Results), use theO_DisparityGenerator controls to
adjust theway the disparity map is calculated. You can either adjust the controlsmanually or use the Preset
dropdown to automatically make adjustments for you:

• Custom - automatically selected when you adjust the controlsmanually,

•Normal - the default values for all controls.

• Strong - reducesmatch Stabilisation between images and concentrates on the Strength of imagematching.

• Aggressive - increases the Strength to reconstruct images as close as possible to the source, but reduces
Stablilisation in favour of accuracy.

• Smooth - reducesmatch Strength between images and concentrates on Stabilisation.

• Aligned - enables theAlignment control, which requires an O_Solver upstream. See Solver and Generating
Disparity Using Alignment formore information.

• Fast - disables the Stabilisation control, speeding up processing time.

The available controls are described in O_DisparityGenerator Controls.

9. You can also use the Parallax Histogram display in O_DisparityViewer to review the disparity range. Formore
details, see DisparityViewer.
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TIP: To check the quality of the generated disparity map, you can add aDisparityReviewGizmo from the
Ocula > Ocula 4.0menu. This gizmo allows you to view the disparity in each view using the output and
background dropdowns to control what is displayed in the Viewer. SeeQuality Control Tools formore
information.

You can then use a RotoPaint (Draw > RotoPaint) node to edit the generated disparity channels. For
example, if a specific region in the image is producing incorrect disparity vectors and you know that those
vectors shouldmatch the vectors in the surrounding areas, you can use theClone tool to clone out the
problematic area.

You can also useO_MultiSample to fill or replace problematic areas. SeeMultiSample formore
information.

Generating Disparity Using Alignment

Using O_DisparityGenerator in conjunction with O_Solver alignment data allows you to constrain the resulting
disparity vectors to match global plate alignment. Youmight want to do this if your plates don't containmuch detail,
such as bluescreen images withmarkers in the background or plates with a lot of featureless areas like sky.

Using theO_Solver alignment data can reduce changes in vertical disparity with depth that are required for Local
alignment in O_VerticalAligner and cause a vertical shift in O_NewView, where disparity doesn't pick up the local
vertical shift required to match the images.

To generate a disparity map using O_Solver alignment data, do the following:

1. Start Nuke and press S on theNodeGraph to open the project settings. Go to theViews tab and click the Set
up views for stereo button.

2. From the Toolbar, select Image > Read to load your stereo clip into Nuke. If you don’t have both views in the
same file, select Views > JoinViews to combine them, or use a variable in the Read node’s file field to replace the
name of the view (use the variable%V to replace an entire view name, such as left or right, and%v to replace
an initial letter, such as l or r). Formore information, refer to theNuke User Guide.

3. Select Ocula > Ocula 4.0 > O_Solver to insert an O_Solver node after either the stereo clip or the JoinViews
node.

NOTE: Solve data passed downstream to O_VerticalAligner is updated to match the aligned plates, except
when Vertical Skew or Local Alignment is enabled. See VerticalAligner formore information.

O_Solver calculates the geometrical relationship between the two views in the input clip and requires at least one
keyframe. Formore instructions on how to useO_Solver, see Solver.

4. Select Ocula > Ocula 4.0 > O_DisparityGenerator to insert an O_DisparityGenerator node after the Read
node.

5. Set theAlignment control to a value greater than 1, so that disparity requires solve data upstream.
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6. Continue from step 4 in Generating Disparity Maps to generate disparity vectors, including alignment data from
the solve.

Writing Disparity into a Clip

When you're happy with the disparity map generated, you can save time down the line by writing the disparity into a
new clip combining the source and disparity channels.

1. Select theO_DisparityGenerator node in theNodeGraph.

2. Select Image >Write (or pressW on the keyboard) to insert aWrite node after O_DisparityGenerator.

3. In theWrite node controls, select all from the channels dropdown and set file type to exr.

4. Enter a name for the clip in the file field (for example,my_clip.####.exr), and click Render.

The newly created disparity channels are saved in the channels of your stereo clip. When you need to manipulate
the same clip again later, the disparity vectors are loaded into Nuke together with the clip. The disparity channels
are represented on nodes in theNodeGraph by the dark green chip on the right of the node.

Rendering the output to combine the clip and the disparity
channels for future use.

O_DisparityGenerator Controls

Use GPU

Open theO_DisparityGenerator controls. O_DisparityGenerator renders using the Local GPU specified, if available,
rather than the CPU. TheGPU may significantly improve processing performance.

If there is no suitable GPU, or the required NVIDIA CUDA drivers are unavailable, O_DisparityGenerator defaults to
using the CPU. You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an
alternative card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.
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Views to Use

From the views that exist in your project settings, select the two views you want to use to create the disparity map.
These views aremapped for the left and right eye.

Preset

Use the Preset dropdown to automatically make adjustments to the disparity results by changing the appropriate
refinement controls:

Custom Automatically selected when you adjust the controlsmanually,

Normal The default value for all controls.

Strong Increasesmatch Strength between images at the expense of Stabilisation.

You can use Strong when picture building is poor using O_NewView, O_
ColourMatcher, and O_FocusMatcher.

Aggressive Increases the Strength used to reconstruct images as close as possible to the
source, but reduces Stablilisation in favour of accuracy.

This option gives the best result in O_NewView to reproduce the appearance of one
view from another and is useful for colour or focusmatching.

NOTE: Aggressive calculation can produce poor stability, whichmakes it
unsuitable for copying fixes fromone view to the other.

Smooth Reducesmatch Strength between images and concentrates on Stabilisation.

This option produces smoother, temporally stable vectors. Use Smooth to
generate clean depthmaps and to prevent flicker when copying a fix fromone view
to the other.

NOTE: Smooth vectors are cleaner and stable fromone frame to the
next, but the imagemay not reconstruct well with O_NewView.

Aligned This option enables theAlignment control, which requires an O_Solver upstream.

Fast This option disables the Stabilisation control, reducing processing time.
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Mask

An optionalmask that specifies areas to exclude from the disparity calculation. You can use this input to prevent
distortions at occlusions or to calculate disparity for a background layer by ignoring all foreground elements.

Note that masks should exist in both views, and O_DisparityGenerator treats the alpha values of 1 as foreground
and blurs to the 0 value using nearby disparity to recreate object boundaries, rather than image data. When you
create amask using Roto or RotoPaint, you can use the feather control to extend the calculation. For example, the
disparity mapmay have a sharper transition at depth edges with a binary mask, but applying feather on themask
can help smooth the resulting image.

None Use the entire image area.

Source Alpha Use the alpha channel of the Source clip as an ignoremask.

Source Inverted Alpha Use the inverted alpha channel of the Source clip as an ignoremask.

Mask Luminance Use the luminance of theMask input as an ignoremask.

Mask Inverted
Luminance

Use the inverted luminance of theMask input as an ignoremask.

Mask Alpha Use the alpha channel of theMask input as an ignoremask.

Mask Inverted Alpha Use the inverted alpha channel of theMask input as an ignoremask.

Vector Detail

Adjusts the density of the calculated disparity vectors. Higher detail picks up finer disparity changes, but takes longer
to calculate.

Strength

Sets the strength applied whenmatching pixels between the left and right views. Higher values allow you to
accurately match similar pixels in one image to another, concentrating on detail matching even if the resulting
disparity map is jagged. Lower valuesmay miss local detail, but are less likely to provide you with the odd spurious
vector, producing smoother results.

Often, it is necessary to trade one of these qualities off against the other. Youmay want to increase Strength to
force the views to match where fine details aremissed, or decrease it to smooth out the disparity map.

2DISPARITYGENERATOR | O_DISPARITYGENERATORCONTROLS



28

Low Strength values smooth the disparity
map, but canmiss local detail.

High Strength values add detail, but can
cause jagged disparity.

Consistency

Sets how accurately the same points in the left and right views aremapped to each other. Increase the value to
encourage the left and right disparity vectors to match.

Smoothness

Controls how image edges are used as clues for sharp transitions in depth in the scene. The higher the value, the
smoother the transition between depths at edges in the image.

Low Smoothness can produce better
depth definition at edges.

High Smoothness produces smoother
disparity maps, but can lose depth detail at

edges.

Alignment

Sets howmuch to constrain the disparities to match the vertical alignment defined by an upstreamO_Solver node.
Increasing the value forces the disparities to be aligned and requires at least one keyframematch.

NOTE: The default Alignment value of 0 calculates the disparity using unconstrainedmotion estimation,
and therefore, does not require O_Solver data.
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Using O_DisparityGenerator in conjunction with O_Solver alignment data allows you to constrain the resulting
disparity vectors to match global plate alignment. Youmight want to do this if your plates don't containmuch detail,
such as bluescreen images withmarkers in the background or plates with a lot of featureless areas like sky.

NOTE: Using theO_Solver alignment data can reduce changes in vertical disparity with depth that are
required for Local alignment in O_VerticalAligner and cause a vertical shift in O_NewView, where disparity
doesn't pick up the local vertical shift required to match the images.

Stabilisation

Sets how heavily vectors are forced to be temporally consistent by generating disparity overmultiple frames, rather
than a single stereo frame. Increasing the value produces smoother vectors, which aremore stable over time, but at
the expense of increased processing time.

TIP: Decreasing the value can producemore accurate results when rebuilding views using O_NewView. See
NewView formore information.

Default Stabilisation can lose detail at
edges in the image.

High Stabilisation produces smoother
vectors, which aremore stable over time.

O_DisparityGenerator Example
In this example, we read in a stereo image, useO_DisparityGenerator to calculate its disparity map, review the results
using DisparityReviewGizmo, and render the result as a single .exr file that contains the left and the right view and
the newly created disparity channels. Later, whenever you use the same image, the disparity map is loaded into Nuke
together with the image. Thismakes the disparity map readily available for the other Ocula nodes, many of which
need it to produce their output.

The stereo image used in this example can be downloaded fromourwebsite at
http://www.thefoundry.co.uk/support/user-guides#ocula.
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Step by Step
1. Start Nuke and press S on theNodeGraph to open the project settings. Go to theViews tab and click the Set

up views for stereo button.

2. Select Image > Read to import Dance_Group.exr. The .exr format allows both views to exist in a single file, so
Nuke reads in both the left and the right view using the same Read node.

3. Select Ocula > Ocula 4.0 > O_DisparityGenerator to insert an O_DisparityGenerator node.

The node treewith O_DisparityGenerator.

4. Display one of the disparity channels by selecting it from the channel set and channelmenus in the upper-left
corner of the Viewer.

O_DisparityGenerator calculates the disparity map. You will probably see something colourful and seemingly
unreadable, much like the image below. Don’t worry - that’s what the disparity channels are supposed to look
like.

Reading depth in disparity maps can be tricky in RGB. There are a number of ways to make the depth easier to
read, but the simplest is to adjust the Viewer controls to display the results:

• Set the Viewer channels control to disparityL and theR layer within the channel.

• Move the pointer around the image to locate the highest negative red value using the Viewer info bar.

• Set the Viewer gain numeric field to -1/<red value>, such as -1/40.

• Adjust the Viewer gain and gamma controls to reveal edges and areas of contrast. Darker areas of the image
are closer to the camera and lighter areas farther away.

The calculated RGB disparity map. The samemap, but with the Viewer
adjusted.
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Ocula also ships with a disparity checking gizmo, called DisparityReviewGizmo, to help you check that your
disparity calculations are correct before you pass the data down theNodeGraph.

5. Select Ocula > Ocula 4.0 > DisparityReviewGizmo to insert the gizmo after theO_DisparityGenerator node.

NOTE: To use the gizmo's full toolset, you'll also need an occlusionmap. SeeOcclusionDetector formore
information on how to generate occlusionmaps.

6. The gizmo's default settings display your stereo source image, desaturated so that the overlay generated by the
gizmo is easily visible. Disparity on the X and Y axes are displayed in red and green, respectively, and occlusions
are displayed in blue (if you've generated an occlusionmap).

In our example, we haven't added occlusion data (blue) and there isn't any appreciable Y axis displacement
(green). The red overlay is generally picking out the changes in depth pretty well.

7. Select Image >Write to insert aWrite node between theO_DisparityGenerator and the Viewer.

8. In theWrite node controls, select all from the channelsmenu to include the disparity channels in the rendered
file.

9. In the file field, enter a file name and location for the new .exr file. Make sure file type is set to exr. Then, click
theRender button to render the image as usual.

10. Import the .exr file you created. Using the Viewer controls, check that it contains the left and the right view and
the disparity channels.

You can now use the .exr file you created together withmany of the other Ocula nodes without having to insert
an O_DisparityGenerator node before them.
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Description
O_OcclusionDetector generates amask for the occluded regions in each view. Occluded regions are pixels that are
visible in one view but not the other.

The left view of a stereo image. The occlusionmask generated
for the left view (pixels occluded in the left

view).

An occlusionmask identifies areas that cannot be rebuilt as some of the pixels in one view are not visible in the
other. You can use it to quality check the result of O_DisparityGenerator and to identify image regions that are likely
to fail when using theOcula nodes that rely on rebuilding one view from the other. If the pixel information isn’t there
in one view, it cannot be generated for the other. After you have identified the areas which are not suitable for
picture building, you can choose how to handle these in order to get the best possible result.

Youmay want to generate an occlusionmask for each viewwhen using the following nodes:

FocusMatcher This node requires an occlusionmask upstream to produce its output.

ColourMatcher This node requires an occlusionmask upstream to produce its output.

DisparityGenerator This node does NOT require an occlusionmask, but you can use one downstream to
quality check the generated disparity map.
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NewView This node requires an occlusionmask upstream to produce its output.

InteraxialShifter This node requires an occlusionmask upstream to produce its output.

Retimer This node does NOT require an occlusionmask to produce its output, but you can
use one upstream to previewwhere they may struggle to generate a new view.

The final occlusionmasks for each view are stored in themask_occlusion channel. You can view them in Nuke by
setting the alpha channelmenu tomask_occlusion.alpha and pressingM on the keyboard with the Viewer
selected. This superimposes the occlusionmask for the current view as a red overlay on top of the image’s RGB
channels as shown below.

An occlusionmask displayed on top of the colour channels.

After you have generated an occlusionmask, you can use aWrite node to render themask into the channels of your
stereo .exr file along with the colour and disparity channels. When you use the same image sequence at a different
time, the occlusionmask is loaded into Nuke along with the sequence.

TheO_OcclusionDetector requires upstreamdisparity channels to produce its output. For an in-depth explanation of
how to create disparity channels, refer to theDisparityGenerator chapter.

Inputs
O_OcclusionDetector has one input:

Source A stereo pair of images. If disparity channels are not embedded in the images, you
need to add an O_DisparityGenerator node after the image sequence.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B.
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Creating and Editing Occlusion Masks

Creating an Occlusion Mask

NOTE: Disparity vectors are required to generate an occlusionmask.

To generate an occlusionmask, do the following:

1. If disparity vectors do not yet exist in the script, insert an O_DisparityGenerator node after your image sequence
to calculate the disparity vectors. SeeDisparityGenerator formore information.

NOTE: Disparity vectorsmay already exist in the image sequence, in which case you do not need to insert
an O_DisparityGenerator node to generate an occlusionmask.

2. From the toolbar, select Ocula > Ocula 4.0 > O_OcclusionDetector to add an O_OcclusionDetector node.
Insert theO_OcclusionDetector node either after theO_DisparityGenerator node (if you added one in the
previous step), or the stereo image sequence. Your node tree should now look something like this:

3. Open theO_OcclusionDetector controls. O_OcclusionDetector renders using the Local GPU specified, if
available, rather than the CPU. The output between theGPU and CPU is identical, but using theGPU can
significantly improve processing performance. SeeO_OcclusionDetector Controls formore details.

4. In theO_OcclusionDetector controls, you can see all the views that exist in your project settings underViews to
Use. Select the two views you want to use to calculate the occlusionmask. The two views you select aremapped
for the left and right eye. O_OcclusionDetector calculates the occlusionmask and stores it in themask_
occlusion.alpha channel.

5. In the Viewer controls, set the alpha channelmenu tomask_occlusion.alpha as shown below.

Set thismenu tomask_occlusion.alpha.

This sets the occlusionmask that O_OcclusionDetector generated as the channel displayed in the alpha channel.
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6. Next, you can either selectMatte overlay from theRGB dropdown or pressM on the keyboard with the
Viewer selected, to superimpose that channel as a red overlay on top of the image’s RGB channels.

Set RBG toMatte overlay

The red overlay indicates occluded regions where picture building
operations are likely to fail.

7. Adjust theGradient Threshold, Consistency Threshold andDilate Occlusions controls as required to
generate the best possible result. SeeO_OcclusionDetector Controls for information about the controls.

8. When you’re happy with the results, pressM again to return to the RGB display.

Manually Editing an Occlusion Mask

If there are occluded regions in themask, which have not beenmarked correctly, you canmanually edit themask by
doing the following:

1. Press P on theNodeGraph to add a RotoPaint node after O_OcclusionDetector.

2. To add regions to the occlusionmask, set output tomask_occlusion in the RotoPaint controls, and use the
paint tools to mark additional regions.

3. To remove or correct existing occluded regions, set output tomask_occlusion in the RotoPaint controls, and
set the paint brush colour to black to manually paint out or correct the occluded areas.
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Rendering Out and Loading Occlusion Masks

To render and save the colour channels, disparity channels and occlusionmask into the channels of a stereo .exr file,
insert aWrite node after theO_OcclusionDetector node. When you load the image sequence at a different time, the
occlusionmask is loaded with it.

NOTE: If you correct occlusions using RotoPaint, insert aWrite node after the RotoPaint node to include
your corrections in the occlusion channel.

Editing Rendered Occlusion Masks

You can edit the rendered occlusionmask that you have loaded for usewith O_FocusMatcher or O_ColourMatcher,
using two different methods:

• Insert a RotoPaint node to adjust the occlusionsmanually with paint.

• Replace the occlusions by inserting a newO_OcclusionDetector. This overwrites the original occlusionmask.
However, you can disable or delete the newO_OcclusionDetector node to revert back to the original mask.

O_OcclusionDetector Controls

Use GPU

Open theO_OcclusionDetector controls. O_OcclusionDetector renders using the Local GPU specified, if available,
rather than the CPU. TheGPU may significantly improve processing performance.

If there is no suitable GPU, or the required NVIDIA CUDA drivers are unavailable, O_OcclusionDetector defaults to
using the CPU. You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an
alternative card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.

Views to Use

From the views that exist in your project settings, select the two views you want to use to generate an occlusion
mask. These views aremapped for the left and right eye.
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Gradient Threshold

The gradient measures the change in depth fromhorizontal disparity. You can use theGradient Threshold control
to definewhere occlusions occur at depth changes. The lower the gradient threshold, the greater the number of
occluded regions.

The occlusionmask with the default
Gradient Threshold.

The occlusionmask with a lowGradient
Threshold set.

Consistency Threshold

TheConsistency Threshold control allows you to set occlusions where the left and right disparities are not
consistent. A low Consistency Threshold value, detectsmore inconsistencies.

The occlusionmask with a low Consistency
Threshold set.

The occlusionmask with a high
Consistency Threshold set.

Dilate Occlusions

You can use the Dilate Occlusions control to expand the occluded regions by a specified number of pixels. The
maximum you can dilate the occlusions by is 20 pixels.
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Occlusion Dilate = 1. Occlusion Dilate = 15.

O_OcclusionDetector Example
SeeO_FocusMatcher Example for an example of how to useO_OcclusionDetector with O_FocusMatcher.
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Description
You can use theO_NewView node to reconstruct a view – either left or right – using the pixels from the other view.
For example, you can choose to reconstruct the left view using the pixels from the right view. This can be useful if
you want to manipulate one view (with a gizmo, node, or graphics editor for example) and replicate the changes into
the other view.

NOTE: TheO_NewView node requires disparity vectors that relate the two views. If they don't already
exist, you can use theO_DisparityGenerator node to calculate these vectors. SeeDisparityGenerator for
how to do this.

If there are no occlusions (features visible in one view but not the other), O_NewView generally produces a good
result. When there are occlusions, the result may require further editing but can often save you time over not using
the node at all.

If you useO_NewView to reproduce changesmade to one view in the other view, youmay want to create the
disparity vectors using either themodified view and its corresponding view, or the original views with no changes
applied. It's recommended to choose the views that produce the best disparity vectors. For example, the former
methodmay be preferable if you are correcting an unwanted colour shift between views. The lattermethodmay be
preferable if your changes in one view produce an occlusion or a change in texture appearance, whichmakes the
process of finding correspondences between themodified images harder.

When you are using Ocula to update one view tomatch another, it is advised to quality check the updated view using
theDisparityReviewGizmo. SeeDisparityReviewGizmo formore information.

NOTE: To reproduce changes you havemade using Nuke’s Roto node, RotoPaint node, or any node or
gizmo that has controls for x and y coordinates, see the Stereoscopic Projects chapter in theNuke User
Guide.
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Inputs
O_NewView has the following inputs:

CleanPlate A clean background plate used to fill areas of occlusion when Correction is set to
Use CleanPlate.

NOTE: If no image is connected, a Channels missing at CleanPlate
input. Please connect RGB input to CleanPlate error is displayed.

Source A stereo pair of images. If disparity channels are not embedded in the images, you
need to add an O_DisparityGenerator node after the image sequence. O_NewView
also requires an occlusionmask, which you can generate using an O_
OcclusionDetector node.

To see a table listing the nodes or channels each Ocula node requires in its inputs, see Appendix B.

Creating a New View
NOTE: O_NewView requires disparity vectors and an occlusionmask to operate correctly.

To create a new view, complete the following steps:

1. If disparity vectors don’t yet exist in the script, you can insert an O_DisparityGenerator node to calculate the
disparity vectors.

2. Select Ocula > Ocula 4.0 > O_OcclusionDetector to insert an O_OcclusionDetector node. Insert theO_
OcclusionDetector node after either theO_DisparityGenerator node (if you added one in the previous step) or
the stereo image sequence.

3. Select Ocula > Ocula 4.0 > O_NewView to insert an O_NewView node after theO_OcclusionDetector node.

4. Attach a Viewer to theO_NewView node. Your node tree should now look something like this:
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5. In theO_NewView controls, select the two views you want to use underView to Use. The two views you select
aremapped for the left and right eye.

6. From theView to build dropdownmenu, select either Left from Right orRight from Left, depending on
which view you want to rebuild.

7. Adjust the required controls to get the best possible result. SeeO_NewView Controls formore information.

O_NewView Controls

Use GPU

Open theO_NewView controls. O_NewView renders using the Local GPU specified, if available, rather than the CPU.
TheGPU may significantly improve processing performance.

If there is no suitable GPU, or the required NVIDIA CUDA drivers are unavailable, O_NewView defaults to using the
CPU. You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an alternative
card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.

Views to Use

From the views that exist in your project settings, select the two views you want to use to generate the new view.
These views aremapped for the left and right eye.

View to Build

Select which inputs to use to generate the new view.

Left from Right Use the pixels from the right view to build a new left view.

Right from Left Use the pixels from the left view to build a new right view.

Pass through other view

Select the Pass through other view checkbox to output both views; the new view and the original source view. If
this checkbox is disabled, only the new view is output.

4 NEWVIEW | O_NEWVIEW CONTROLS
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Occlusions

Output occlusions to alpha

Select theOutput occlusions to alpha checkbox to output the occlusions to the alpha channel. Occlusions occur
when somepixels are not visible in the source view, and therefore cannot be used to create the new view. You can
use the alpha channel as an overlay to determinewhere the occlusion correction is applied.

Correction

You can use theOcclusions – Correction control to determine how occluded regions are dealt with.

Use original Select this option to retain the original view in the occluded regions. For example, if
you are using the original left view to build a new right view, the original right view is
retained in the occluded regions to help build the new right view.

Expand foreground Select this option to fill occluded regions by expanding the surrounding area from
the original source view. For example, if you are using the original left view to build
a new right view, the foreground of the original left view is expanded to help build
the new right view.

NOTE: Expanding the foregroundmay offset the edges.

Use CleanPlate Select this option to fill occluded areas using a clean background which is connected
using theCleanPlate input.

NOTE: If no image is connected, a Channels missing at CleanPlate
input. Please connect RGB input to CleanPlate error is displayed.

None Select this option to avoid filling the occluded regions.

Edges

Output edges to alpha

You can use theOutput edges to alpha checkbox to output the edges to the alpha channel. Use the alpha channel
as an overlay to determinewhere the edge correction is applied.
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Correction

You can use the Edges – Correction control to determine how image edges at depth boundaries are handled.

Match original Select this option to match the appearance of the original view at the edges. For
example, if you are using the original left view to build a new a right view, the edges
arematched from the original right view to help build the new right view.

Match foreground Select this option to match the edges from the original source view that was used
to build the new view. For example, if you are using the original left view to build a
new right view, the edges arematched from the original left view to help build the
new right view.

None Select this option to avoid applying edge correction.

Adjust Edges

You can use theAdjust Edges control to set the extent of the region where the edge correction is applied. To blend
the correction into the background, use a positive value. To restrict the correction to the edges, use a negative value.

O_NewView Example
In this example, we have a stereo image of a cathedral. In the left view, one of the cathedral windows ismissing. Our
aim is to reproduce themissing window from the right view into the left view using O_NewView. To do this. we can
useO_NewView to produce a completely new left view, using the pixels from the right view.

The stereo image used in the example can be downloaded fromourwebsite. Formore information, see Example
Images.

The necessary disparity channels have been embedded in the download image, so you don’t need to insert an O_
Solver node and an O_DisparityGenerator node in this example.

Step by Step
1. Launch Nuke and open the project settings (press S on theNodeGraph). Go to theViews tab and click the Set

up views for stereo button.

2. Import cathedral1.exr and attach a Viewer to the image. Switch between the left and the right view using the
Viewer controls (or the ; and ' hotkeys). Notice that the cathedral ismissing awindow in the left view, as shown
below.

4 NEWVIEW | O_NEWVIEW EXAMPLE
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The left view. The right view.

Wewant to build a new left view to replicate the additional window, using theO_NewView node.

3. Select Ocula > Ocula 4.0 > O_OcclusionDetector to insert an O_OcclusionDetector node after the stereo
image.

4. Select Ocula > Ocula 4.0 > O_NewView to insert an O_NewView node after theO_OcclusionDetector node.

5. In theO_NewView controls, select Left from Right from theView to Buildmenu to generate the new left view
using the right view as a source. The image below shows the new left view. As you can see, it now includes the
window that was previously missing.

6. Select the Pass through other view checkbox. Thismeans both the new view and the original source view are
output.

7. Using the Viewer controls, switch between the left and the right views. Thewindow that was previously missing
from the left view, is now present in both views.
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The new left view. The original right view.
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5 ColourMatcher

Description
TheO_ColourMatcher node enables youmatch the colours of one viewwith those of another. It has been specifically
designed to deal with the subtle colour differences that are sometimes present between stereo views.

The original left view. The original right view. The colour corrected right view.

Colour discrepancies between views can be caused by several factors. For example, stereo footagemay have been
shot with cameras which had different polarisation, or theremay have been slight differences between the physical
characteristics of the two camera lenses or image sensors. If the colour differences are not corrected, viewersmay
experience difficulty in fusing objects and as a result may not enjoy the viewing experience.

Correcting colour differencesmanually in post-production can be a time-consuming process and requires
considerable skill. O_ColourMatcher enables you to automate the colour grading required.

O_ColourMatcher has two different modes you can use to perform a colourmatch; Basicmode and Local
Matchingmode. Bothmodes require an O_DisparityGenerator node and an O_OcclusionDetector node upstream
of theO_ColourMatcher node.

Basic Mode

TheBasic colourmatchingmode takes the colour distribution of one entire view andmodifies it to match the
distribution of the other view.
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Local Matching Mode

The Local Matchingmode first divides the two images into square blocks according to theBlock Size control.
Then, it matches the colour distribution from the view that want to modify to a reconstructed version of the same
view, which has been constructed using the pixels of the source view. When an occluded pixel is detected by an
upstreamocclusionmask, O_ColourMatcher finds the closest unoccluded pixel and then uses this to make the colour
match for the occluded pixel.

Local Matchingmode can be useful if there are local colour differences between the views, such as highlights that
are brighter in one view than the other.

Inputs
O_ColourMatcher has the following inputs:

Source A stereo pair of images. If disparity channels and occlusionmasks are not
embedded in the images and you are using the Local Matchingmode, you need
to add an O_Solver, an O_DisparityGenerator, and an O_OcclusionDetector node
after the image sequence.

Mask An optionalmask that determines where to take the colour distribution from. For
example, if you have a clip showing a person in front of a green screen, youmight
want to use amask to exclude the green area so the node concentrates on
matching the person.

In theBasicmode, O_ColourMatcher calculates the transform on themasked area
of the source view but applies it to thewhole of the view it's correcting. In the
Local Matchingmode, it calculates the transform on themasked area and applies
it to that area only.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B.

Performing a Colour Match
O_ColourMatcher has two different modes you can use to perform a colourmatch; Basicmode and Local
Matchingmode. Bothmodes require an O_DisparityGenerator and an O_OcclusionDetector node upstreamof the
O_ColourMatcher node.

To perform a colourmatch, complete the following steps:
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1. If they don't exist already, insert an O_DisparityGenerator node and an O_OcclusionDetector node after your
stereo clip. SeeDisparityGenerator and OcclusionDetector

2. Select Ocula > Ocula 4.0 > O_ColourMatcher to insert an O_ColourMatcher node after theO_
DisparityGenerator and O_OcclusionDetector nodes.

3. Connect a Viewer to theO_ColourMatcher node. Your node tree should now look something like this:

O_ColourMatcher node tree.

4. In theO_ColourMatcher controls, select the two views you want to use for the colourmatch underView to Use.
The two views you select aremapped for the left and right eye.

5. From theMatchmenu, select either Left to Right orRight to Left depending on the direction in which you
want to perform the colourmatch.

6. Select the requiredmode from theMode dropdown in theO_ColourMatcher controls. SeeO_ColourMatcher
Controls formore information about the different modes.

7. Adjust theO_ColourMatcher controls to get the best possible result. SeeO_ColourMatcher Controls formore
information about the controls.

Editing Colour Match Results

If you can see areas where the colourmatch is wrong, make sure they are included in the upstreamocclusionmask.
You can edit the occlusionmask in two ways:

• Adjust O_OcclusionDetector controls.

• Use a RotoPaint node beforeO_ColourMatcher andmanually edit themask by using the paint tool to add occluded
regions into themask_occlusion channel.

O_ColourMatcher Controls

Use GPU

Open theO_ColourMatcher controls. O_ColourMatcher renders using the Local GPU specified, if available, rather
than the CPU. TheGPU may significantly improve processing performance.
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If there is no suitable GPU, or the required NVIDIA CUDA drivers are unavailable, O_ColourMatcher defaults to using
the CPU. You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an
alternative card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.

Views to Use

From the views that exist in your project settings, select the two views you want to use to generate an occlusion
mask. These views aremapped for the left and right eye.

Match

TheMatch control allows you specify the direction in which to perform the colourmatch.

Left to Right Adjust the colours of the left view to match with those of the right.

Right to Left Adjust the colours of the right view to match with those of the left.

Mode

You can use two different modes to perform a colourmatch:

Basic Thismode takes the colour distribution of one entire view andmodifies that to
match the distribution of the other view.

Local Matching Thismode first divides the two images into square blocks according to theBlock
Size control. Then, it matches the colour distribution from the view that want to
modify to a reconstructed version of the same view, which has been constructed
using the pixels of the source view. This can be useful if there are local colour
differences between the views, such as highlights that are brighter in one view than
the other.

NOTE: Bothmodes require an O_DisparityGenerator node and an O_OcclusionDetector node upstreamof
theO_ColourMatcher node.
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Mask

If there are areas in the image that you want to ignorewhen calculating the colour transformation, you can use the
Mask control to supply amask. In theO_ColourMatcher controls, setMask to the component you want to use as
themask. The followingMask settings are available:

None Use the entire image area.

Source Alpha Use the alpha channel of the Source clip as amask.

Source Inverted Alpha Use the inverted alpha channel of the Source clip as amask.

Mask Luminance Use the luminance of theMask input as amask.

Mask Inverted
Luminance

Use the inverted luminance of theMask input as amask.

Mask Alpha Use the alpha channel of theMask input as amask.

Mask Inverted Alpha Use the inverted alpha channel of theMask input as amask.

NOTE: You can also use the alpha channel of the Source input to supply amask.

ViewMenu Button

TheView menu button allows you to select different settings for the left and right view. It is displayed to the right
of a control that it can be applied to. SeeBlock Size further in this section for an example of how to use it.

Local Matching

NOTE: These settings are only available with the Local Matchingmode selected.

Preview colour correction

Enable this control to preview the areas of colour correction applied to the original image as a difference overlay.

Block Size

This control defines thewidth and height (in pixels) of the square blocks that the images are divided into when
calculating the colourmatch. You can set different block sizes for each view by doing the following:
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1. Click theView menu button to the right of the block size.

2. Select Split off left.

This displays two fields forBox Size, one for the left view and one for the right view.

3. To revert back to using the same size for both views, click theView menu button again and select Unsplit left.

Scale

Set the image scale for local colourmatching. You can increase the Scale to broaden the colour update and preserve
the image structure, helping to prevent image shift and wobble. Decrease the Scale to pick up highlights and
detailed colour changes.

Limit

Sets a limit on local colourmatching against the average correction in a region. If you notice excessive colour changes
in areas of highlight, try reducing the Limit.

Noise

TheNoise control allows you to set howmuch noise to retain fromoriginal image. If the colourmatching smooths
the input noise, increase theNoise value. If the value is too high, colour differences at very fine details are retained.

Occlusions

NOTE: These settings are only available with the Local Matchingmode selected.

Output corrected area to alpha

Select theOutput corrected area to alpha checkbox to output the corrected area to the alpha channel. The
corrected area can consist of the occlusionmask and the disparity edgemask set using theAdjust Edges control,
depending on what theCorrection control is set to (Occlusions,Occlusions and Edges, orNone).

Correction

Defines which areas receive the colour correction when local colourmatching is not valid.
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Occlusions Fill occluded pixels only, where colour ismissing from the other view.

Occlusions and Edges Fill occluded pixels, where colour ismissing from the other view, and compensate
for disparity changes at edges wherematching and/or reconstruction can fail.

None Apply no occlusion or edge correction.

Adjust Edges

TheAdjust Edges control allows you to set the threshold for treating image edges as occlusions to reduce haloing
and edge flicker. The higher the value, themore image edges are considered occlusions even if they are not marked
as such in the upstreamocclusionmask.

Colour Tolerance

TheColour Tolerance control allows you to set the amount of blurring across edges in the colourmatch at
occluded regions. Decrease this to restrict the colour correction in occluded regions to similar colours. Increase the
value to blur the colour correction.

Support Size

Use the Support Size control to set the size of the region (in pixels) of unoccluded pixels used to calculate the colour
correction at an occluded pixel. O_ColourMatcher first finds the closest unoccluded pixel and then expands that
distance by this number of pixels to determine the amount of unoccluded pixels to use.

Stabilise occlusions

Enabling this control can reduce flicker in occluded areas by using data frommultiple frames.

O_ColourMatcher Example
In this example, there is a subtle colour discrepancy between our stereo views and reflections that are present in one
view but not the other. To fix this, we need to match the colours of the right viewwith those of the left using the
Local Matchingmode. The stereo image used in the example can be downloaded fromourwebsite. Formore
information, please see Example Images.

Step by Step
1. Start Nuke and open the project settings by pressing S on theNodeGraph. Select theViews tab and click the

Set up views for stereo button.
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2. Import thedance_group_disp.exr footage. This image already includes both the left and the right view, and the
necessary disparity channels.

3. Attach a Viewer to the image. Using the Viewer controls (or the ; and ' hotkeys), switch between the left and the
right view. As you can see, there is a subtle colour difference between the views.

The original left view. The original right view.

We are going to match the colours of the left viewwith those of the right.

4. Select Ocula > Ocula 4.0 > O_OcclusionDetector to add an O_OcclusionDetector node after the stereo
images.

5. Insert an O_ColourMatcher node after O_OcclusionDetector by selecting select Ocula > Ocula 4.0 > O_
ColourMatcher.

The node treewith O_ColourMatcher.

6. In theO_ColourMatcher controls, you can select either Left to Right orRight to Left from theMatch
dropdown, depending on the direction in which you want to perform the colourmatch. TheMatchmenu is
already set to Left to Right, which is what wewant.

7. SetMode to Local Matching.

In thismode, O_ColourMatcher first divides the two images into square blocks according to theBlock Size
control. Then, it matches the colour distributions between corresponding blocks in the two views.

As theOcclusion options are enabled in the Local Matchingmode, O_ColourMatcher can produce better
results in the occluded areas defined by the upstreamocclusionmask. In these areas, O_ColourMatcher cannot
correct the colour in one view by using the colour from the other. Instead, it looks for similar colours in the
nearby unoccluded areas that it has already been able to match and uses the closest colour it finds.

8. View the result and switch between the two views again. Compare the new left view to the original left view by
displaying the left view in the Viewer, selecting theO_ColourMatcher node, and pressingD a couple of times to
disable and enable the node. Notice that the colours of the left view nowmatch those of the right, but there are
some artefacts in themiddle of the image.
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The colour corrected left view.

9. To fix this, we are going to addmore areas to the occlusionmask. Press P on theNodeGraph to add a RotoPaint
node after O_OcclusionDetector.

The node treewith RotoPaint.

10. In the Viewer controls, set the alpha channelmenu tomask_occlusion.alpha as shown below.

This sets the occlusionmask that O_OcclusionDetector generated as the channel that is displayed in the alpha
channel.

Next, pressM on the keyboard with the Viewer selected to superimpose that channel as a red overlay on top of
the image’s RGB channels.
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The occlusionmask in a Viewer overlay.

11. Open the RotoPaint controls and set output tomask_occlusion. Activate the Brush tool in the Viewer toolbar
and paint over any areas that were producing poor results. If it helps, pressD on theO_ColourMatcher node to
disable it and stop it updating after each paint stroke. PressingD again re-enables the node.

Addingmore areas to the occlusionmask.

12. PressM on the Viewer to hide the occlusionmask overlay.

13. Enable and disable O_ColourMatcher to compare the original and the colour corrected view. The results should
now bemore accurate. If you still see some problematic areas, you can add them to the occlusionmask too or
adjust the Local Matching andOcclusion controls in theO_ColourMatcher Properties.

The final left view. The original right view.
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6 FocusMatcher

Description
O_FocusMatcher is designed to correct subtle focus differences that are sometimes present between the left and
right views of a stereo image. It does this by matching the focus distribution of one view to the other, based on the
disparity vectors upstream. For details on how to calculate disparity vectors, see DisparityGenerator.

The original left view. The corrected left view.

The focusmatching can be done using two different modes; theMatch Edgesmode and theReconstruct Edges
mode.

NOTE: Bothmodes require an O_DisparityGenerator node and an O_OcclusionDetector node upstreamof
theO_FocusMatcher node.

Match Edges Mode

TheMatch Edgesmodematches the appearance of the edges fromone view to the other. If you want to preserve
the original image structure, it is recommended to use thismode. Also, if the blurring in your input images is subtle,
theMatch Edgesmodemay produce the best result.
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Reconstruct Edges Mode

TheReconstruct Edgesmode rebuilds the edges in one view from scratch, using the pixels from the other. If you
want to rebuild focus exactly, or if the blurring in your image is heavy or varying, it is recommended that you use this
mode.

NOTE: The result of thismode depends on the accuracy of the existing disparity vectors.

Inputs
O_FocusMatcher has the following inputs:

Source A stereo pair of images. If disparity channels and occlusionmasks are not
embedded in the images, you need to insert an O_DisparityGenerator and an O_
OcclusionDetector node after the image sequence.

Mask An optionalmask that determines where to perform the focusmatching
calculation.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B.

Performing a Focus Match
O_FocusMatcher has two different modes you can use to perform a colourmatch;Match Edgesmode and
Reconstruct Edgesmode. Bothmodes require an O_DisparityGenerator node and an O_OcclusionDetector node
upstreamof theO_FocusMatcher node.

To perform a focusmatch, complete the following steps:

1. If they don't exist already, insert an O_DisparityGenerator node and an O_OcclusionDetector node after your
stereo clip. SeeDisparityGenerator and OcclusionDetectorformore information.

2. From the toolbar, select Ocula > Ocula 4.0 > O_FocusMatcher to insert an O_FocusMatcher node after theO_
OcclusionDetector node. Your node tree should now look something like this:
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3. Select the requiredmode from theMode dropdown in theO_FocusMatcher controls. You can use theMatch
Edges mode or theReconstruct Edgesmode. SeeO_FocusMatcher Controls formore details about the
different modes.

4. Select the two views you want to use for the colourmatch underView to Use. The two views you select are
mapped for the left and right eye.

5. From theMatchmenu, select either Left to Right orRight to Left depending on the direction in which you
want to perform the focusmatch.

6. Adjust the Local Matching andOcclusion controls to get the best possible result. SeeO_FocusMatcher
Controls formore information about the controls.

O_FocusMatcher Controls

Use GPU

Open theO_FocusMatcher controls. O_FocusMatcher renders using the Local GPU specified, if available, rather than
the CPU. TheGPU may significantly improve processing performance.

If there is no suitable GPU, or the required NVIDIA CUDA drivers are unavailable, O_FocusMatcher defaults to using
the CPU. You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an
alternative card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.

Views to Use

From the views that exist in your project settings, select the two views you want to use to generate an occlusion
mask. These views aremapped for the left and right eye.

Match

TheMatch control allows you specify the direction in which to perform the focusmatch in.
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Left to Right Deblur or rebuild the left view to match the right.

Right to Left Deblur or rebuild the right view to match the left.

Mode

You can use two different modes to perform a focusmatch:

Match Edges TheMatch Edgesmodematches the appearance of the edges fromone view to
the other. If you want to preserve the original image structure, it is recommended
to use thismode. If the blurring in your input images is subtle, theMatch Edges
modemay produce the best possible result.

Reconstruct Edges TheReconstruct Edgesmode rebuilds the edges in one view from scratch using
the pixels from the other. If you want to rebuild focus exactly, or if the blurring in
your image is heavy or varying, it is recommended that you use thismode. The
result of thismode depends on the accuracy of the existing disparity vectors.

Mask

If there are areas in the image that you want to ignorewhen calculating the focus calculation, you can use theMask
control to supply amask. In theO_FocusMatcher controls, setMask to the component you want to use as the
mask. The followingMask settings are available:

None Use the entire image area.

Source Alpha Use the alpha channel of the Source clip as amask.

Source Inverted Alpha Use the inverted alpha channel of the Source clip as amask.

Mask Luminance Use the luminance of theMask input as amask.

Mask Inverted
Luminance

Use the inverted luminance of theMask input as amask.

Mask Alpha Use the alpha channel of theMask input as amask.

Mask Inverted Alpha Use the inverted alpha channel of theMask input as amask.

NOTE: You can also use the alpha channel of the Source input to supply amask.
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Local Matching

Edge Scale

This allows you to scale the edges where focusmatching is performed. To restrict matching to sharp edges, use a
small scale value. To match wider edges in the image, increase the scale value.

Strength

You can use the Strength control to set the amount of focus correction to apply. Set this to 0 for no correction, or 1
for complete correction.

Noise

NOTE: This option is only available when theReconstruct Edgesmode is selected.

TheNoise control allows you to preserve the noise of the original imagewhen using theReconstruct Edgesmode.
To ignore noise, set this control to a low value. Thismatches the focus of fine details and can reconstruct noise from
the other view. To retain asmuch of the original noise as possible, use higher values. This ensures that noise is not
coherent between views, but may not match the focus at fine details in the image.

Occlusions

Output occlusions to alpha

Select theOutput occlusions to alpha checkbox to output the corrected area to the alpha channel.The corrected
area can consist of the occlusionmask and the disparity edgemask set using theAdjust Edges control, depending
on what theCorrection control is set to (Occlusions,Occlusionsand Edges, orNone).

Correction

Defines which areas receive the focus correction when local focusmatching is not valid.

Occlusions Fill occluded pixels only, where colour ismissing from the other view.

Occlusions and Edges Fill occluded pixels, where colour ismissing from the other view, and compensate
for disparity changes at edges wherematching can fail.

None Apply no occlusion or edge correction.
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Adjust Edges

TheAdjust Edges control allows you to set the threshold for treating image edges as occlusions to reduce haloing
and edge flicker. The higher the value, themore image edges are considered occlusions, even if they aren’t marked as
such in the upstreamocclusionmask.

Colour Tolerance

TheColour Tolerance control allows you to set the amount of blurring across edges in the focusmatch at occluded
regions. Decrease this to restrict the colour correction in occluded regions to similar colours. Increase the value to
blur the focus correction.

Support Size

Use the Support Size control to set the size of the region (in pixels) of unoccluded pixels used to calculate the focus
correction at a corrected pixel.

Stabilise occlusions

Enabling this control can reduce flicker in occluded areas by using data frommultiple frames.

O_FocusMatcher Example
In this example, we correct the focus distribution in the right view of a stereo image by rebuilding it using the pixels
from the left view.

You can download the stereo image used here fromourwebsite - please see Example Images.

Step by Step
1. Launch Nuke. Open the project settings (press S on theNodeGraph), select theViews tab, and click the Set up

views for stereo button.

2. Import lobby.exr. This image already includes both the left and the right view as well as the necessary disparity
channels.

3. Attach a Viewer to the image and zoom in. Switch between the left and the right view using the Viewer controls
(or the ; and ' hotkeys). As you can see, the focus distribution of the right view doesn’t match that of the left.
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The left view. The right view.

O_FocusMatcher can fix this by rebuilding the right view using pixels from the left. In order to do so, it needs an
upstreamocclusionmask that identifies occluded pixels in each view. You can generate an occlusionmask using
theO_OcclusionDetector node.

4. From the toolbar, select Ocula > Ocula 4.0 > O_OcclusionDetector to insert an O_OcclusionDetector node
between the image and the Viewer.

O_OcclusionDetector calculates amask for the occluded pixels in each view and stores it in themask_occlusion
channel. You can adjust themask using theO_OcclusionDetector controls, but for this example, we’re going to
go with the default settings.

5. Next, add an O_FocusMatcher node after O_OcclusionDetector.

6. By default, O_FocusMatcher is set to rebuild the left view to match the focus of the right. We need it to do the
opposite, so set theMatchmenu to Right to Left.

O_FocusMatcher now rebuilds the right view using pixels from the left. If the upstreamdisparity map is accurate
and there are no occlusions (pixels visible in one view but not the other), this generally produces good results.
We have already generated an occlusionmask in step 4, so we can use it to check which areas are occluded.

7. To see the occlusionmask for the right view, select the right view from the Viewer controls and set the alpha
channelmenu tomask_occlusion.alpha. Then, pressM on the Viewer.

The occlusionmask is shown in a red overlay on top of the colour channels. Any pixels highlighted in red are only
visible in the right view but not the left.
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Because these pixels don’t exist in the left view, they cannot be used to rebuild the right view. In other words, O_
FocusMatcher is likely to produce poor results in these occluded areas.

8. To get the best result, adjust the Local Matching andOcclusion controls. If required, you canmanually edit
the occlusionmask using a RotoPaint node (see Creating and Editing OcclusionMasks).

9. You now have your final result, so compare the rebuilt right view to both the original right view and the left view
in the Viewer. You should see that the focus distribution of the right view bettermatches that of the left.
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7 Solver

Introduction
TheO_Solver node defines the geometric relationship between the two views in the input images (that is, the camera
relationship or solve). This is necessary when aligning footagewith O_VerticalAligner. It is also required to calculate
aligned disparity vectors, when using the alignment control inDisparityGenerator. O_Solver data is not necessary for
colour and focusmatching using O_ColourMatcher and O_FocusMatcher.

To define the camera relationship, O_Solver detects a number of features in one view and locates the corresponding
features in the other (see the image below). The featurematches and analysis data are not available until you have
set at least one analysis key on O_Solver. Any frames set as analysis keys show up on the Viewer timeline and can be
visualised in the Curve Editor and Dope Sheet.

O_Solver detects features in each view and tries to match them.

O_Solver calculates alignment data at the keyed analysis frames. Alignment at other frames is created by
interpolating between the results at the analysis frames. This ensures that the alignment data delivered to O_
DisparityGenerator and O_VerticalAligner varies smoothly across the sequence.
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TIP: If you have an interactive licence (ocula_i and nuke_i), you can run O_Solver from the terminal to
automatically set up analysis frames. Running from the terminal also removes the need to manually set up
an Ocula node tree. See Solving Using Python formore information.

The output of theO_Solver node consists of:

• the unaltered input images, and

• the results of the feature detection and analysis, which are passed down the node tree as hiddenmetadata.

Because the results of the analysis are available downstream, you can usemultiple Ocula nodes in the treewithout
having to re-analyse the camera relationship. However, if a node generates ormodifies views, the current metadata
becomes invalid and is removed from the tree from that point forward.

To get the best possible results, you can identify features to ignore in the analysis. This can be done by supplying a
mask in the Ignore input.

You can also add your own featurematches to the automatically detected ones. O_Solver considers any feature
matches you’ve added yourself superior to the ones it detects automatically and pays themmore attention. This can
also influencewhich of the automatically detected features are included in the final solve. To force the feature
matches to be recalculated based on themanual featurematches, use theRe-analyse Frame button.

If you have a pre-tracked camera that describes the camera setup used to shoot the images, you can also supply this
in theCamera input. If you connect the Camera node before adding a keyframe, the automatically-detected feature
matches are validated against the input camera. Alternatively, you can add the Camera node after the analysis and
use theRe-analyse Frame button to recalculatematches based on the input camera. Formore information, see
Inputs below.

TIP: You can improve the alignment data calculated by O_Solver by adding usermatches. This can be used
to correct O_VerticalAligner in tricky shots, where there are few automaticmatches, such as on bluescreen
or greenscreen footage. See Solver formore information.

Inputs
O_Solver has the following inputs:
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Camera A pre-tracked Nuke stereo camera that describes the camera setup used to shoot
the Source image. This can be a camera you have tracked with the CameraTracker
node or imported to Nuke from a third-party camera tracking application. This
input is optional.

TIP: In Nuke, a stereo camera can be either:

• a single Camera node in which some or all of the controls are split, or

• two Camera nodes (one for each view) followed by a JoinViews node
(Views > JoinViews). The JoinViews node combines the two cameras
into a single output.

Ignore Amask that specifies areas to ignore during the feature detection and analysis. This
can be useful if an area in the Source image is producing incorrectly matched
features. This input is optional.

Source A stereo pair of images. These can either be the images you want to work on, or
another pair of images shot with the same camera setup.

To seewhat data each Ocula node requires in its inputs, turn to Appendix B.

Solving the Camera Relationship
1. Launch Nuke and press S on theNodeGraph to open the project settings. Go to theViews tab and click the Set

up views for stereo button.
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2. From the Toolbar, select Image > Read to load your stereo clip into Nuke. This can either be the clip you want to
work on, or another clip shot with the same camera setup.

If you don’t have both views in the same file, select Views > JoinViews to combine them, or use a variable in the
Read node’s file field to replace the name of the view (use the variable%V to replace an entire view name, such
as left or right, and%v to replace an initial letter, such as l or r). Formore information, refer to theNuke User
Guide.

3. Select Ocula > Ocula 4.0 > O_Solver to insert an O_Solver node after either the stereo clip or the JoinViews
node (if you inserted one in the previous step).

4. Connect a Viewer to theO_Solver node.

The node treewith O_Solver.

5. Open theO_Solver controls. UnderViews to Use, you can see all the views that exist in your project settings.
Select the two views you want to use for the left and right eyewhen calculating the camera relationship.

The two views you selected aremapped for the left and right eye.

6. If you have a pretracked Nuke stereo camera that describes the camera setup used to shoot the Source image,
connect that to O_Solver’s Camera input. O_Solver uses the camera information to calculate the relationship
between the two views.

7. Set keyframes on your sequence for O_Solver to analyse:

• Key Frame - if the camera rig doesn't change, you can set analysis keys only on one or two frames (for
example, on the first and last frames). If you do set a few analysis keys, you can also check Single Solve From
All Keys in theO_Solver controls. This tells O_Solver to calculate a single solve using all keyframes, which can
improve the results.

• Key Sequence - click to analyse thewhole sequence automatically. This adds analysis keys where a change in
camera alignment is detected.

• Key Nominated - click to analyse the frames specified in theRender dialog. You can specify frames using
Nuke's regular frame expressions. For example, if you enter "1-5 8 10 15 22-25", only those 12 frames are
keyed.

If you know there is a zoomor change in the camera setup on certain frames, you need to addmore
keyframes in between. Leave Single Solve From All Keys unchecked to use a separate solve for each analysis
key, and place keyframeswhere the camera alignment changes.
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NOTE: You can remove analysis keys one at a time by scrubbing the playhead to the required frame and
clickingDelete Key or remove all the analysis keys from the sequence by clickingDelete All.

O_Solver analyses the frames you added and, if it findsmore than one analysis key, it interpolates the results
between them. Interpolating between analysis keys ensures that the calculated camera relationship varies
smoothly across the sequence.

To visualise the analysis in the Curve Editor or Dope Sheet, right-click on theAnalysis Key field and select Curve
editor orDope sheet. Note, however, that you cannot edit the curve in either.

8. Proceed to Reviewing and Editing the Results.

NOTE: OnceO_Solver has detected featurematches, they are fixed and do not update in response to
changes in the node tree. You can edit themmanually, however, or click Re-analyse Frame to forceO_
Solver to recalculate the current frame.

Solving Using Python

If you have an interactive licence (ocula_i and nuke_i), you can run O_Solver using Python. Running from the
command line, with the -i argument for interactive licences, allows you to automate the setup of O_Solver for
different shots without having to open theUI andmanually analyse frames.

WARNING: If there is an interruption between the licence server and Ocula, rendering aborts with an exit
code of 1. You can use the --cont command line argument to forceOcula to continue rendering on failure,
producing black licence failure frames rather than aborting thewhole render.

Using Python, you can:

• Scan the entire sequence automatically, adding keyframeswhen a change in camera is detected using
analyseSequence.
# Create an O_Solver to analyse the whole sequence

def autoKeyOculaTree(filename, first_frame, last_frame):

# set up views

nuke.root()["setlr"].execute()

# create the read and set up for the frame range

reader = nuke.createNode("Read",inpanel=False)

reader.knob("file").setValue(filename)

reader.knob("first").setValue(first_frame)

reader.knob("last").setValue(last_frame)

# set up the O_Solver node and create a key
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solver = nuke.createNode('O_Solver4_0',inpanel=False)

solver.setInput(0, reader)

solver['analyseSequence'].execute()

# set the file path and frame range

autoKeyOculaTree('/myFilePath/myFootage.####.sxr',1,206)

# save the script once complete

nuke.scriptSaveAs('/Users/OculaExpert/shot001.nk', True)

• Script the analysis of a specific set of frames through python.
frameList = [25, 73, 123]

frameRanges = nuke.FrameRanges( frameList )

nuke.execute(solver, frameRanges)

O_Solver also has a Python tab in the Properties panel, allowing you to call Python functions automatically when
various events happen in Nuke. SeeHelp > Documentation > Python Developers Guide formore information.

Reviewing and Editing the Results
1. Set Display to Keyframe Matches, if it's not displaying them already, andmake sure you are viewing a

keyframe.

The features andmatches used to calculate the camera relationship are shown in a Viewer overlay. The views set
up in the Project Settings dictate the colour of the features in the overlay. If you used Set up views for
stereo to create the views, red indicates a feature in the left view and green a feature in the right view.

2. You can specify areas of the footage to ignore using amask in either the Ignore input or the alpha of the Source
image. In theO_Solver controls, setMask to the component you want to use as themask.

NOTE: Features generated on reflections often produce bad featurematches, but you can add user
matches around reflective areas if the auto-matches are poor. See Adding UserMatches formore
information.

3. To preview howwell the detected features describe the alignment of the stereo camera, set Display to Preview
Alignment.

Preview Alignment shows the alignedmatches at keyframes, but also calculatesmatches at non-keyframes.
This allows you to review howwell the interpolated solveworks and whether additional keyframes are required.
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Display set to Preview Alignment.

4. Ideally, most lines in the overlay should be horizontal. Any matches that aren’t horizontal and have a vertical
error greater than Error Threshold are pre-selected and displayed in yellow. These are considered poor
matches. If you scrub through the timeline and find frameswith a lot of yellowmatches, addmore keyframes
for O_Solver to analyse or add usermatchesmanually. See Adding UserMatches formore information.

Matches displayed with a low Error
Threshold.

Matches displayed with a high Error
Threshold.

5. Increase theMatch Offset value to artificially increase the disparity, so you can better see how horizontal the
featurematches are. Again, if you scrub through the timeline and find frameswith a lot of yellowmatches, add
more keyframes for O_Solver to analyse or add usermatchesmanually. See Adding UserMatches formore
information.

6. Next, decreaseMatch Offset to examine different points in the image. Accurate featurematches should sit on
top of each other when you converge on them. If you can see a vertical offset between any featurematches,
addmore keyframes for O_Solver to analyse or add usermatchesmanually. See Adding UserMatches formore
information.
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Adding User Matches

Usermatches assist O_Solver when calculating the camera relationship. The solve considers thesemanually added
matches superior to the ones detected automatically by Ocula, and pays themmore attention when calculating the
final results.

You can addmore featurematchesmanually if the automatic feature detection didn’t produce enoughmatches in
some parts of the image. In cases like this, it’s a good idea to add at least four usermatches (one in each corner of
the image), but themore (accurate) matches you have, the better.

This is a feature you’ve addedmanually.

This is a featureO_Solver has detected automatically.

To add a featurematch:

1. Click theAdd User Match button above the Viewer to enable addmode.

2. Locate a feature in either view that is easily recognisable in both views (for example, edges or areas of high
contrast), and then click in the Viewer to place the usermatch. TheAdd User Match button stays enabled so
you can continue adding usermatches.

TIP: You can also add usermatches by holding Ctrl/Cmd+Alt and clicking in the Viewer.

A cross is placed in the Viewer, representing the usermatch in that view, and then O_Solver automatically adds a
correspondingmatch in the other view.

3. You can fine-tunematches by dragging a usermatch in one view to its corresponding position in the other view.
By default, the two views are overlaid using a differencemerge, in a 256px texture at x2magnification.
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You can change the size of the overlay andmagnification using the texture size andmagnification
dropdowns above the Viewer.

TIP: Holding Ctrl/Cmd displays the left view and Ctrl/Cmd+Shift the right view, allowing you to ping-pong
between views. Holding Shift displays a left/right mix, using an overmerge, to help you locate bad
matches.

4. If you’re not happy with the results, you can try using O_Solver on another sequence shot with the same camera
setup.

WARNING: If you use another sequence to calculate the solve, check Single Solve From All Keys or
you'll be taking the interpolated solve fromone sequence and applying it to the frames on the other.

5. Then, connect theO_Solver node to the Solver input of O_DisparityGenerator, if you intend to use the camera
Alignment to generate disparity, or O_VerticalAligner.

6. Once you are happy with the results of O_Solver, proceed to Feeding the Results to Other Ocula Nodes.

Feeding the Results to Other Ocula Nodes

You can use the sameO_Solver output throughout your script, so you don't have to calculate the camera
relationship several times.

Do one of the following:

• Select Ocula > Ocula 4.0 > O_DisparityGenerator to insert an O_DisparityGenerator node after O_Solver. This is
necessary if you want to useO_DisparityGenerator'sAlignment control to constrain the resulting disparity
vectors to match global plate alignment. Youmight want to do this if your plates don't containmuch detail, such as
bluescreen images withmarkers in the background.
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O_Solver followed by O_DisparityGenerator.

NOTE: If you don't intend to useO_DisparityGenerator'sAlignment control, you don't need an O_Solver
node. SeeDisparityGenerator formore information.

• Select Ocula > Ocula 4.0 > O_VerticalAligner to insert an O_VerticalAligner node after O_Solver. This node can
be used to correct the vertical alignment of either O_Solver’s input clip or another clip shot with the same camera
setup.

O_Solver followed by O_VerticalAligner.

NOTE: If you intend to useO_VerticalAligner's Local alignment control, you also need an O_
DisparityGenerator node. SeeDisparityGenerator formore information.

To learnmore about O_DisparityGenerator and O_VerticalAligner, review the chapters on DisparityGenerator and
VerticalAligner.

O_Solver Controls

O_Solver Tab

Views to Use

From the views that exist in your project settings, select the two views you want to use to calculate the features and
the camera relationship. These viewswill bemapped for the left and right eye.
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Analysis

Mask

If an area in the Source clip is producing poor featurematches, you can use this control to select areas of the image
to ignore during the feature detection and analysis.

NOTE: Masks should exist in both views, and O_DisparityGenerator expects alpha values of either 0 (for
regions to use) or 1 (for regions to ignore).

None Use the entire image area.

Source Alpha Use the alpha channel of the Source clip as an ignoremask.

Source Inverted Alpha Use the inverted alpha channel of the Source clip as an ignoremask.

Mask Luminance Use the luminance of the Ignore input as an ignoremask.

Mask Inverted
Luminance

Use the inverted luminance of the Ignore input as an ignoremask.

Mask Alpha Use the alpha channel of the Ignore input as an ignoremask.

Mask Inverted Alpha Use the inverted alpha channel of the Ignore input as an ignoremask.

Analysis Key

This shows the analysis keys that have been created. When you add an analysis key, O_Solver calculates feature
matching and analysis and then sets an analysis key. The solves for all other frames are created by interpolating
between the results on the analysis keys on either side. This field is for display only. To edit the keyframes, useKey
Frame andDelete Key.

NOTE: Keyframe interpolation helps to ensure smooth changes in the calculated camera relationship
between views. We recommend using Key Sequence to analyse the entire sequence, and then adding
additional analysis keys where the offsets betweenmatches occur. You can visualise howwell the
interpolated geometry matches the images by settingDisplay to Preview Alignment in theO_Solver
controls. If you see a lot of yellowmatches (matches that have a vertical error greater than the Error
Threshold), youmay need to addmore keyframes.
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TIP: Alternatively, you can quality check the interpolated geometry by using O_VerticalAligner followed by
an Anaglyph node. EnableGlobal > Preset > Full to interpolate the calculated camera relationship and
check whether there is any vertical displacement between the aligned views in the anaglyph view. SeeO_
VerticalAligner Example for an example of how to useO_Solver, O_VerticalAligner, and Anaglyph.

Delete Key Delete an analysis key at the current frame.

Delete All Delete all analysis keys.

Key Frame Set an analysis key at the current frame.

Key Sequence Analyse thewhole sequence automatically and set analysis keys when a change in
camera alignment is detected.

TIP: Key Sequence detects changes in camera alignment automatically,
but can be time-consuming on longer sequences.

Key Nominated Set analysis keys at the frames specified in theRender dialog. You can specify
frames using Nuke's regular frame expressions. For example, if you enter "1-5 8 10
15 22-25", only those 12 frames are keyed.

Single Solve From All
Keys

When enabled, O_Solver calculates a single solve using all the keyframes you have
set. Use this for rigs that don’t change over time to get more accurate results than
when using a single keyframe orwhen theO_Solver analysis is performed on one
clip and then re-used for another clip.

Do not use this if there is jitter in the alignment or there is a change in separation,
convergence, or zoom. Instead, use a separate solve for each keyframe and place
keys where the alignment changes.

Display

Display Dropdown

Change the display mode:

Nothing Only show the Source image.
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Keyframe Matches Show the features andmatches for the camera relationship calculation in a Viewer
overlay. Featurematches are only calculated for the keyframes.

Features and Keyframe Matches for the camera relationship calculation in a
Viewer overlay.

You can use thismode to seewhereO_Solver has found features andmatches, and
evaluate how accurate they are. You can also edit the featurematchesmanually. To
delete a poormatch, right-click on it and select delete selected. To addmatches
manually, see Adding UserMatches.

You can also activate thismode by selecting display matches from the Viewer’s
right-click menu.
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Preview Alignment Preview howwell the calculated featurematches describe the alignment of the
stereo camera. This shows the alignedmatches at keyframes, but also calculates
matches at non-keyframes, allowing you to review howwell the interpolated solve
works and whether additional keyframes are required. If the lines between feature
matches are horizontal, they describe the alignment of the camera rig well. If any
lines are skewed (and displayed in yellow), youmay want to delete the feature
matches in question. If necessary, you can also addmanual featurematches to
replace them and preview the effect of themanualmatches in the overlay.

Visualising the alignment of the calculated
featurematches.

You can also activate thismode by selecting preview alignment from the Viewer’s
right-click menu.

Match Offset

The offset (in pixels) applied to the aligned featurematches. You can:

• increase this value to artificially increase the disparity, so it’s easier to see how horizontal the featurematches are.

• decrease this value to set the disparity of particularmatches to zero and examine the vertical offset at each
feature. Thematches should sit on top of each other.

NOTE: If you find a lot of yellowmatches, you can add usermatchesmanually. SeeO_Solver Controls for
more information.

TheMatch Offset control is only available whenDisplay is set to PreviewAlignment. You can also adjust it by
selecting decrease offset or increase offset from the Viewer’s right-click menu.
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Error Threshold

The threshold on the vertical alignment error in pixels. WhenDisplay is set to Preview Alignment, any matches
with a vertical error greater than the threshold are highlighted in the Viewer. This allows you to easily delete poor
matches with large errors when previewing alignment at keyframes - adjust the Error Threshold to highlight poor
matches and pressBackspace to remove them.

Current Frame

Re-analyse Frame Clear the automatic featurematches from the current frame and recalculate them.
This can be useful if there have been changes in the node tree upstream fromO_
Solver, you have deleted toomany automatic featurematches, or you want to
calculate the automaticmatches based on any usermatches you have created.

Delete Auto Matches Delete all automatically generatedmatches added to the current frame.

Delete User Matches Delete all usermatches you havemanually added to the current frame.

Python Tab

These controls are for Python callbacks and can be used to have Python functions automatically called when various
events happen in Nuke.

before render These functions run prior to starting rendering in execute(). If they throw an
exception, the render aborts.

before each frame These functions run prior to starting rendering of each individual frame. If they
throw an exception, the render aborts.

after each frame These functions run after each frame is finished rendering. They are not called if the
render aborts. If they throw an exception, the render aborts.

after render These functions run after rendering of all frames is finished. If they throw an error,
the render aborts.

render progress These functions run during rendering to determine progress or failure.
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O_Solver Example
In this example, we read in a stereo image, useO_Solver to calculate the camera relationship, review the results, and
add a usermatch to improve the solve data.

Step by Step
1. Start Nuke and press S on theNodeGraph to open the Project Settings. Go to theViews tab and click the Set

up views for stereo button.

2. Select Image > Read to import Dance_Group.exr. The .exr format allows both views to exist in a single file, so
Nuke reads in both the left and the right view using the same Read node.

3. Insert an O_Solver node after the stereo image by choosingOcula > Ocula 4.0 > O_Solver from the Toolbar.

The purpose of this node is to define the geometrical relationship between the two views in the input image
(that is, the camera relationship or solve). The solve information can then be fed to an O_DisparityGenerator, if
you want to use the alignment information to create a disparity map, or to an O_VerticalAligner to correct
vertical offset between views.

For now, we’ll concentrate on creating an accurate solve using O_Solver.

4. Attach a Viewer to theO_Solver node.

5. In theO_Solver controls, click Key Frame to set a keyframe for O_Solver to analyse.

Our example here consists of just one frame, but if you were using a sequence, click Key Sequence to
automatically analyse the sequence and add keyframeswhen the camera setup changes. If the setup doesn’t
change, you can get away with using just one or two keyframes. Remember that keyframes should be placed on
frames that are easy to match between views - ideally, with enough picture detail, but nomotion blur, occluding
fog, or dust.

Every time you add a keyframe, O_Solver analyses the footage and calculates the solve.

6. O_Solver displaysKeyframe Matches by default, but you can changemodes using the right-click menu in the
Viewer or theDisplay dropdown on the Viewer toolbar.

NOTE: Matches are only displayed when the playhead is on a keyframe, marked with a blue chip.

The calculated featurematches are displayed in a Viewer overlay, and you can switch between views to compare
them.
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Display set to Keyframe Matches.

7. Now, set Display to Preview Alignment. This allows you to check the quality of your solve by previewing the
alignment of the calculated featurematches in the Viewer.

Ideally, the lines should all be horizontal. If they have a vertical error greater than the Error Threshold, they are
considered poormatches and displayed in yellow.

8. To help guide the solve, we can add featurematchesmanually. It’s a good idea to do this if you have a
particularly tricky part of a shot where the automatic featurematching has produced a few yellowmatches.

There's an area in the top-right of the frame containing badmatches, so zoom in on it.

9. Locate a feature in either view that is easily recognisable in both views (for example, edges or areas of high
contrast).

10. Hold Ctrl/Cmd+Alt and then click in the Viewer to place the usermatch.

TIP: You can also click theAdd User Match button above the Viewer to enable addmode.

A cross is placed in the Viewer, representing the usermatch in that view, and then O_Solver automatically adds a
correspondingmatch in the other view.

11. You can align views by dragging a usermatch in one view to its corresponding position in the other view. By
default, the two views are overlaid using a differencemerge, in a 256px texture at x2magnification.

You can change the size of the overlay andmagnification using the texture size (in pixels) andmagnification
dropdowns above the Viewer.

TIP: Holding Ctrl/Cmd displays the left view and Ctrl/Cmd+Shift the right view, allowing you to ping-pong
between views. Holding Shift displays a left/right mix, using an overmerge, to help you locate bad
matches.

You can add asmany manual featurematches as you like, so if you see any other areas that might benefit from
them, feel free to addmore.

O_Solver considers any featurematches you’ve added yourself superior to the ones it detects automatically and
pays themmore attention. This can also influence the automaticmatches displayed in the Preview Alignment
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mode. Any automaticmatches that don't agreewith the alignment defined by your usermatches are highlighted
in yellow and should be deleted.

Poor auto-match alignments are highlighted
yellow in the Viewer.

Adding usermatches allows you delete poor
matches by pressing Backspace.

12. Next, decrease theMatch Offset value gradually until somematches have no horizontal offset. This sets the
disparity of thosematches to zero, whichmeans accurate featurematches should sit on top of each other. You
may need to zoom in to see if they do.

Thematches in the top-left of the Viewer display vertical offset between the featurematches, and are
highlighted in yellow. Place a usermatch on the corner of the building to correct them.

13. Fine-tunematches by dragging the usermatch in one view to its corresponding position in the other view. By
default, the two views are overlaid using a differencemerge, in a 256px texture at x2magnification.

You can change the size of the overlay andmagnification using the texture size (in pixels) andmagnification
dropdowns above the Viewer.

TIP: Holding Shift when lining up the usermatch displays a left/right mix of the views, using an over
merge, holding Ctrl/Cmd shows the left view, and Ctrl/Cmd+Shift shows the right view in the overlay.

14. The yellowmatches can be deleted by pressing Backspace to improve the solve. We recommend adding at least
five usermatches, one toward each corner of the image to correct the overall alignment, and one at the centre
on the subject to focus alignment where it is important.
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Description
If the cameras used to shoot stereoscopic images are poorly positioned or converge (point inwards), some features
in the resulting two viewsmay be vertically misaligned. In the case of converging cameras, themisalignment may be
due to keystoning. Unlike converging cameras, parallel cameras do not produce keystoning.

Parallel cameras do
not cause keystoning.

Converging cameras
do cause keystoning.

Keystoning is when an image is distorted because the angle created by converging cameras affects the perspective in
the two views. As a result, corresponding points in the two views are vertically misaligned.

The left image. The right image.

Whether the vertical misalignment was caused by poorly positioned or converging cameras, it can result in an
unpleasant 3D stereo viewing experience. When a vertically misaligned stereo image is viewed with 3D glasses, the
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viewer’s brain attempts to line up the corresponding points in the images, often causing eye strain and headaches.
To avoid this, stereo images should only contain horizontal disparity, not vertical.

O_VerticalAligner allows you to warp views vertically so that their corresponding features align horizontally. The
Vertical Skew and Local Alignment options allow you to warp the views, while keeping the horizontal position of
each pixel the same so that there is no change in convergence.

BeforeO_VerticalAligner. Notice that the
curved line at the bottomof the image and
the controls on the left aremisaligned.

After O_VerticalAligner. Notice that the
curved line at the bottomof the image and
the controls on the left have now been

aligned.

There are several modes: Global Alignment, Local Alignment, Fix Scale and Fix Offset. If the none of the
method checkboxes are selected in the Local, Fix Scale, or Fix Offset sections of theO_VerticalAligner controls, the
Global Alignmentmode is on by default.

Global Alignment Mode

In the Global Alignment mode, O_VerticalAligner performs a global transform to align the views. You can choose
between several alignment types. All methods concatenate. Thismeans that if you select several alignment types
from theGlobal section in theO_VerticalAligner controls, their functions are combined. SeeO_VerticalAligner
Controls for information about each alignment type.

If you have a pre-tracked Nuke stereo camera that describes the camera setup used to shoot the Source images,
you can attach it to theO_Solver node and useO_VerticalAligner in theGlobal Alignmentmode to analyse the
sequence and output a vertically-aligned camera pair. This works with all globalmethods except Vertical Skew
(which can't be represented by a camera transform). Formore information, see Using O_VerticalAligner.

Local Alignment Mode

In the Local Alignmentmode, O_VerticalAligner rebuilds the image per-pixel to account for any local distortions in
themirror or lens, and changes in alignment with depth using O_Solver data.

The Local Alignmentmode always requires a disparity map upstream. You can create one using an O_
DisparityGenerator node upstreamof theO_VerticalAligner node.
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NOTE: You can create disparity once and it is aligned to match the aligned plate. There is no need to
recalculate disparity.

Fix Scale Mode

The Fix Scalemethod allows you to zoom the plate if the original footagewas not over-scanned, and the alignment
pulls black into the format.

You can scale the image to prevent pulling pixels fromoutside the input image. To minimise the scale change, align
Both Views.

WARNING: The scale has to be applied to both images, even when aligning Left to Right orRight to
Left.

Fix Offset Mode

The Fix Offsetmethod allows you to correct any convergence change that has happened on the subject to preserve
the original subject parallax and hence depth.

You can shift the image to preserve the parallax at the fix-point.

NOTE: The Fix Offsetmode requires upstreamdisparity vectors. If they do not already exist in the image
sequence, insert an O_DisparityGenerator node to calculate them.

Inputs
O_VerticalAligner has the following inputs:

Source A stereo pair of images. Global Alignmentmode is on by default. In all modes the
images should be followed by an O_Solver node. If you are using the Local
Alignment, or Fix Offsetmode, you also need an O_DisparityGenerator node (if
disparity vectors do not already exist) upstreamof O_VerticalAligner.

To see a table listing the nodes or channels each Ocula node requires in its inputs, see Appendix B.
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Using O_VerticalAligner
To vertically align a pair of stereo images, you can several modes: Global Alignment, Local Alignment, Fix Scale,
and Fix Offset. You can choose to use amixture of thesemodes, for example, you can perform a global alignment
and a local alignment which are concatenated into a single filter operation.

You can apply a global image transform to align the featurematches generated by an upstreamO_Solver node, or
you can rebuild the view(s) to remove vertical disparity calculated by an upstreamO_DisparityGenerator using the
Local Alignmentmode.

NOTE: TheGlobal Alignmentmode is on by default.

To use theO_VerticalAligner, complete the following steps:

1. Select Ocula > Ocula 4.0 > O_Solver to insert an O_Solver node after your stereo clip. Formore information on
how to useO_Solver, see Solver.

2. Select Ocula > Ocula 4.0 > O_VerticalAligner to insert an O_VerticalAligner node after either O_Solver.

3. Connect a Viewer to theO_VerticalAligner node. Your node tree should now look something like this:

4. Open theO_VerticalAligner controls. UnderViews to Use, you can see all the views that exist in your project
settings. Select the two views you want to use for the left and right eyewhen correcting the alignment. The two
views you select aremapped for the left and right eye.

5. From theAlignmenu, select how tomove the images to align the views: Both Views, Left to Right, orRight
to Left. SeeO_VerticalAligner Controls for information about theAlign options.

6. Select the filter to handle the vertical alignment transform, or use the default Lanczos6, which is a good
sharpening and scaling down filter. Formore information on the available filters, see Filter under O_
VerticalAligner Controls or Choosing a Filtering Algorithm in theNuke User Guide.

7. EnableOutput STMap to include theGlobal or Local correction as a uv coordinatemap along with alignment
information.

8. From theGlobal section, select types of alignment you want to use. You can select preset options including
Transform,Match Camera, Keystone Only, and Full. You can also select Custom andmanually select the
types of alignment you want to include. SeeO_VerticalAligner Controls formore information about the types of
alignment.

9. If you want to perform a local alignment, insert an O_DisparityGenerator node after O_Solver, and select the
Local Alignment checkbox in the Local section of theO_VerticalAligner controls. You can now adjust the Local
controls. SeeO_VerticalAligner Controls formore details.

10. To view the effect of O_VerticalAlignermore accurately, you can:
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• Insert an Anaglyph node between theO_VerticalAligner node and the Viewer,

OR

• Add a StereoReviewGizmo to view alignment. See StereoReviewGizmo formore information.

11. Adjust the required settings to get the best possible result. SeeO_VerticalAligner Controls for information about
the settings.

Analysing and Using Output Data

In all globalmethods except Vertical Skew, you can use theAnalyse Sequence control to create output data and
use the data for the following:

• Vertically align a pre-tracked Nuke stereo camera. This allows you to continue using pre-tracked cameras after your
footage has been vertically aligned. Note that you can only create a vertically aligned stereo camerawhen a pre-
tracked camera is connected to theCamera input of O_Solver.

• Create a Nuke CornerPin2D node that produces the same result as O_VerticalAligner.

The output data is also stored on theOutput tab of the node controls, where you can see the transform
represented as a four-corner pin and a transformmatrix per view.

To analyse and use the output data, complete the following steps:

1. After performing a vertical alignment, click Analyse Sequence under theAnalysis section in theO_
VerticalAlignet controls.

NOTE: You cannot useAnalyse Sequence with the Local Alignment checkbox selected.

2. When prompted, enter a frame range to analyse. O_VerticalAligner analyses the sequence.
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3. You can now use the output data in the following ways:

• To output a vertically aligned camera pair, click either Create Camera or Create Rig. Create Camera
produces a single Camera nodewith split controls to hold the left and right view parameters. Create Rig
produces two Camera nodes and a JoinViews node that combines them.

• To create a Nuke CornerPin2D node that represents the result of O_VerticalAligner, click Create Corner Pin. A
CornerPin2D node that produces the same result as O_VerticalAligner appears in theNodeGraph.

Scripting Analysis and CornerPin Creation

Given a standard NodeGraph containing your footage, an O_Solver, and an O_VerticalAligner, Ocula allows you to
automate the setup of a CornerPin for a range of frameswithout having to manually create the required analysis
frames.

The following Python script examines featurematches in the entire sequence, analyses the vertical alignment for a
given frame range for both views, and then creates a CornerPin node containing to data for the four pinned points in
the Viewer.

TIP: If you don't want the analysis to continue on failure, remove the 1 after the frame range in the
second Python call.

# Run the analysis pass on the Solver

nuke.toNode('O_Solver1')['analyseSequence'].execute()

# Run the analysis pass on the VerticalAligner between frames 1001 and 1085

nuke.execute("O_VerticalAligner1", 1001, 1085, 1, ['left','right'])

# Create the cornerPin

nuke.toNode('O_VerticalAligner1')['createPin'].execute()

O_VerticalAligner also has a Python tab in the Properties panel, allowing you to call Python functions automatically
when various events happen in Nuke. SeeHelp > Documentation > Python Developers Guide formore
information.
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O_VerticalAligner Controls

O_VerticalAligner Tab

Views to Use

From the views that exist in your project settings, select the two views you want to use to generate an occlusion
mask. These views aremapped for the left and right eye.

Align

Select how tomove the views to align the images.

Both Views Move both the left and right views so that they are aligned.

Left to Right Move the left view only to line up with the right.

Right to Left Move the right view only to line up with the left.

Filter

Select the filtering algorithm you want to usewhen remapping pixels from their original positions to new positions.
This helps avoid problemswith image quality, particularly in high contrast areas of the frame (where highly aliased, or
jaggy, edgesmay appear if pixels are not filtered and retain their original values).

Impulse This optionmeans no filtering is done. Each output pixel equals an input pixel.

Cubic Remapped pixels receive some smoothing.

Keys Remapped pixels receive some smoothing andminor sharpening.

Simon Remapped pixels receive some smoothing andmedium sharpening.

Rifman Remapped pixels receive some smoothing and significant sharpening.

Mitchell Remapped pixels receive some smoothing and blurring to hide pixelation.
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Parzen Remapped pixels receive the greatest smoothing of all filters. Use this option to
prevent ringing on sharp edges.

Notch Remapped pixels receive flat smoothing (which tends to hideMoiré patterns).

Lanczos4 This filter is good for scaling down.

Lanczos6 Remapped pixels receive some sharpening. This filter is good for scaling down and
imagewarping.

NOTE: Note that this option is not ideal for vertical alignment; instead
Cubic or Parzen are recommended for this.

Sinc4 Remapped pixels receive a lot of sharpening. This filter is good for scaling down.

Output STMap

When enabled, this allows you to output an STMap along with an aligned image and disparity vectors.

Global

Select the types of alignment you want to use to vertically align the images. You can select preset options, or you can
select Custom andmanually define the types of alignment you want to include. See the table below for the types of
alignment each preset option includes.

Preset
Option

Description Camera
Correction

Focal
Length

Vertical
Shift

2D
Rotation

Perspective
Warp

Vertical
Skew

Transform Use this option to
perform a 2D
correction without
any change in pixel
aspect or skew.

Match
Camera

Use this option to
correct using a
matchmove
camera connected
to the upstreamO_
Solver.
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Keystone
Only

Use this option to
correct vertical
alignment without
changing the
parallax.

Full Use Full to include
all the alignment
options except
Vertical skew.

All alignment methods concatenate. Thismeans that if you select several alignment types, their functions are
combined. You can also analyse the data to create corner pin and camera information in all methods except Vertical
Skew. See the table below for a description of what each alignment type does. The alignment types are applied in
the following order.

Camera correction Correct the vertical alignment for amatch-move camera connected to an upstream
O_Solver. If there is no camera connected, this uses the internal camera calculated
by O_Solver. The correction is refined by other alignment options that are selected.

Focal length Align the features by calculating a 2D scale to correct focal length differences.

Vertical shift Align the features vertically by moving the entire image up or down. Calculate a 2D
vertical shift to correct a global offset.

2D rotation Align the features vertically by rotating the entire image around a point. The centre
of the rotation is determined by the algorithm.This helps correct in-plane camera
roll.

Perspective warp Do a four-corner warp on the images to align themon the y axis. Thismay move
the features slightly along the x axis. Perspective warp can help correct camera
tilt as well as roll.

NOTE: A perspective change can alter pixel aspect ratio and introduce
pixel skew.

Vertical skew Align the features along the y axis using a skew. This does not move the features
along the x axis. Vertical skew allows you to correct keystoning without changing
horizontal disparity. This varies the vertical shift across the imagewithout changing
the horizontal position of pixels. However, thismay also introduce pixel skew.
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NOTE: If you select or deselect an alignment type after selecting a preset option, the preset Type
dropdown, automatically updates to Custom.

Local Options

There are twomodes you can use for vertical alignment. TheGlobal Alignmentmethod is on by default. Select the
Local Alignment checkbox to perform a local alignment in addition to the global alignment.

Global Alignment This applies a global image transform to align the featurematches generated by an
upstreamO_Solver node.

Local Alignment This rebuilds the view(s) to remove vertical disparity calculated by an upstreamO_
DisparityGenerator. Use thismode to create a per-pixel correction if there are any
local distortions in themirror or lens and changes in alignment with depth.

Pre-blur

The Pre-blur control allows you to set the size of the blur applied to the disparity before performing a local
alignment. To smooth out the correction across depth boundaries, increase the blur size.

Correction

TheCorrection control allows you to set the amount of local correction to apply between the global transform at 0
and the full correction at 1. This would be useful, for example, if you want to tone down the local distortion that is
applied.

Fix Scale Options

Zoom to Prevent Black in the Frame

Select the Zoom to prevent black in frame checkbox to scale the image in order to prevent pulling pixels from
outside the input image. To minimise the scale, change theAlign dropdown to Both Views.

WARNING: The scale has to be applied to both images, even when aligning Left to Right orRight to
Left.
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Calculate Scale

TheCalculate scale control allows you to calculate the scale at the current frame. If the alignment options change,
the scale needs to be recalculated. You can lock the scale correction to prevent any changes by selecting the Lock
scale checkbox.

Scale

The Scale control allows you to set the global scale that is applied to prevent black in the frame. You can set a key to
interpolate the scale calculated at different frames.

WARNING: Animating the Scale control creates a dynamic zoomon the shot, whichmay not be the
stereographer's original intent. In this case, it is recommended to use a static zoom from a single frame, to
preserve the original intent of the shot.

Fix Offset Options

Preserve Subject Parallax

Select the Preserve subject parallax checkbox to shift the image in away that preserves the parallax at the
specified Fix Point. This requires the input to have disparity vectors. If disparity vectors do not already exists, you
need to add an O_Solver node and an O_DisparityGenerator node upstreamof O_VerticalAligner.

Fix Point

You canmove the Fix Point to sample the input disparity and update the applied offset to preserve the parallax.
View the output of O_VerticalAligner to set the Fix Point when theOutput is set to Image. You can lock this to
prevent any changes by selecting the Lock offset checkbox.

To change the Fix Point, drag the fixPoint widget from the bottom-left corner of the Viewer and drop it in the new
position. Disparity is then recalculated according to the new Fix Point. You can also use the usermatches
determined by O_Solver to set the Fix Point.

Offset

You can use theOffset control to set the correction in pixels, that is applied to prevent parallax changes at the Fix
Point. To interpolate the offset calculated at different frames, set a key.

NOTE: Note that you can re-converge the views after you have aligned the plates to preserve depth.
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Analyse Sequence

Analyse the sequence to create a corner pin or an aligned camera output. UseAnalyse Sequence to create the
output data in all globalmethods except Vertical Skew (the default). Then, you can apply the data to theCreate
Corner Pin, Create Camera, or Create Rig controls.

NOTE: You cannot useAnalyse Sequence with the Local alignment checkbox selected.

Create Corner Pin Click this to create a corner pin representing the result of O_VerticalAligner after
you have clicked Analyse Sequence. This works in all globalmethods except
Vertical Skew.

Create Camera If you have a pre-tracked Nuke stereo camera connected to theCamera input of
theO_Solver up the tree and you click Analyse Sequence, you can then click
Create Camera to create a vertically aligned camera from the analysis. This gives
you a single Camera nodewith split controls to hold the left and right view
parameters. This works in all globalmethods except Vertical Skew.

Create Rig If you have a pre-tracked Nuke stereo camera connected to theCamera input of
theO_Solver up the tree and you click Analyse Sequence, you can then click
Create Rig to create a vertically aligned camera rig from the analysis. This gives you
two Camera nodes and a JoinViews node that combines them. This works in all
globalmethods except Vertical Skew.

Output Tab

Four Corner Pin This represents the 2D corner pin that can be applied to the input image to create
the same result as O_VerticalAligner (in all globalmethods except Vertical Skew).
This allows you to do the analysis in Nuke, but take thematrix to a third-party
application – such as Baselight – and align the image or camera there.

Transform Matrix This provides the concatenated 2D transform for the vertical alignment. Thematrix
is calculated when you click Analyse Sequence on theO_VerticalAligner tab.
There is onematrix for each view in the source.
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Python Tab

These controls are for Python callbacks and can be used to have Python functions automatically called when various
events happen in Nuke.

before render These functions run prior to starting rendering in execute(). If they throw an
exception, the render aborts.

before each frame These functions run prior to starting rendering of each individual frame. If they
throw an exception, the render aborts.

after each frame These functions run after each frame is finished rendering. They are not called if the
render aborts. If they throw an exception, the render aborts.

after render These functions run after rendering of all frames is finished. If they throw an error,
the render aborts.

render progress These functions run during rendering to determine progress or failure.

O_VerticalAligner Example
In this example, we correct the vertical alignment of a stereo image using theGlobal Alignmentmode. The image
used here can be downloaded fromourwebsite. Formore information, please see Example Images.

Step by Step
1. Launch Nuke. Open the project settings (press S on theNodeGraph), select theViews tab, and click the Set up

views for stereo button.

2. Import the steep_hill.exr image and connect it to a Viewer. The image includes both the left and the right view.

3. Select Ocula > Ocula 4.0 > O_Solver to insert an O_Solver node after the stereo clip. See Solver formore
information.

4. Click Key Frame to set at least one keyframe.

5. Insert an O_VerticalAligner (Ocula > Ocula 4.0 > O_VerticalAligner), followed by an Anaglyph node (Views >
Stereo > Anaglyph) after O_Solver.

NOTE: The Anaglyph node is for illustrative purposes in this example. You could just as easily use the
DisparityReviewGizmo to view the alignment.
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6. By default, O_VerticalAligner is inGlobal alignment modewith the Local alignment checkbox disabled. In this
mode, O_VerticalAligner applies a global image transform to align the featurematches generated by the
upstreamO_Solver node. InGlobal alignment mode, O_VerticalAligner does not need disparity vectors
upstream.

7. To see the effect more accurately, select theO_VerticalAligner node and pressD repeatedly to disable and enable
the node. With the node disabled, the views remain vertically misaligned. However, when you enable theO_
VerticalAligner node, the views align nicely.

The zoomed in imagewith theO_
VerticalAligner
node disabled.

The zoomed in imagewith O_VerticalAligner
enabled.
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9 InteraxialShifter

Description
TheO_InteraxialShifter node allows you to adjust the interaxial distance of stereo images. Interaxial distance is the
distance between the left and right cameras. Using this O_InteraxialShifter node, you can generate two new views at
specified positions between the left and right images.

Changing interaxial distance is the equivalent of moving the cameras closer together or further apart. The greater the
interaxial distance, the greater the depth perception. This is illustrated below, where the grey rectangles represent
elements depicted in a stereo image.

When the 3D imagewas shot with the
cameras far apart, objects on the screen
seem further apart from each other; the
foreground objects look closer to you, and
the background objects look further away.

When the 3D imagewas shot with cameras
closer together, objects on the screen seem
close to each other; the foreground objects
don't look much closer to you than the

background objects.

Youmay want to change interaxial distance during post-production for a variety of reasons. For example, it can be
useful when trying to match the depths between scenes in order to make transitionsmore comfortable for the
viewer, or simply because the desired depth of a shot has been reconsidered as the final film evolves. It might also
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help in the process known as depth grading, where the depth of field is adjusted in order to ensure the stereo effect
can be comfortably viewed on the intended screen size. The apparent depth of the scene depends upon a
combination of the screen size and the distance from the screen to the viewer.

To generate new viewswith a different interaxial distance, theO_InteraxialShifter node requires upstreamdisparity
vectors that relate the two views. You can use theO_DisparityGenerator node to calculate these vectors. See
DisparityGenerator for how to do this.

NOTE: This node does not pass through any disparity channels fed into it. This is because, after warping
the input images, the original disparity map is no longer valid. If you need disparity channels further down
the tree, add another O_DisparityGenerator node after O_InteraxialShifter.

TIP: Changing interaxial distance is different to changing convergence (the inward rotation of the
cameras). You can change convergence using Nuke’s ReConverge node. This way, you can have any
selected point in the image appear at screen depth when viewed with 3D glasses.

Inputs
O_InteraxialShifter has the following inputs:

Source A stereo pair of images. If disparity channels and occlusionmasks are not
embedded in the images, you need to insert an O_DisparityGenerator and an O_
OcclusionDetector node after the image sequence.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B.

Using O_InteraxialShifter
NOTE: O_InteraxialShifter requires disparity vectors and an occlusionmask to operate correctly.

To change the interaxial distance, do the following:

1. If disparity vectors don’t yet exist in the script, insert an O_DisparityGenerator node after your image sequence
to calculate the disparity vectors. SeeDisparityGenerator for how to do this.

2. O_InteraxialShifter requires an occlusionmask. Insert an O_OcclusionDetector node after either theO_
DisparityGenerator node (if you added one in the previous step) or the stereo image sequence.

3. From the toolbar, select Ocula > Ocula 4.0 > O_InteraxialShifter to insert an O_InteraxialShifter node after
theO_OcclusionDetector node.
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4. In theO_InteraxialShifter controls, select the two views you want to use for creating the new views underView
to Use. The two views you select aremapped for the left and right eye.

5. Use the Left Position and Right Position sliders to indicatewhere you want to build the new left and right
views. The values are expressed as a fraction of the distance between the two views. For example, if the Left
Position is set to 0.25, it is at a quarter of the total distance between the cameras.

6. Attach a Viewer to theO_InteraxialShifter node. Your node tree should now look something like this:

7. Adjust the Edges settings to get the best possible result. SeeO_InteraxialShifter Controls formore information.

O_InteraxialShifter Controls

Use GPU

Open theO_InteraxialShifter controls. O_InteraxialShifter renders using the Local GPU specified, if available, rather
than the CPU. TheGPU may significantly improve processing performance.

If there is no suitable GPU, or the required NVIDIA CUDA drivers are unavailable, O_InteraxialShifter defaults to using
the CPU. You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an
alternative card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.

Views to Use

From the views that exist in your project settings, select the two views you want to use to create the new views.
These views aremapped for the left and right eye.

Left Position

Select a position between the viewswhere you want to generate the new left view. The position is expressed as a
fraction of the distance between the views.
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Right Position

Select a position between the viewswhere you want to generate the new right view. The position is expressed as a
fraction of the distance between the views.

Edges

Output edges to alpha

You can use theOutput edges to alpha checkbox to output the edges to the alpha channel. Use the alpha channel
as an overlay to determinewhere the edge correction is applied.

Adjust Edges

Use theAdjust Edges slider to change the size of the edgemask. To dilate themask, use a positive value. You can
use a negative value to erode themask.

Feather

You can use the Feather slider to specify howmuch feathering to apply to the edges. Increasing the Feather value,
softens the edges; decreasing the value, sharpens the edges.
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Description
O_VectorGenerator generatesmotion vector fields for each view in a stereo image. Motion vectorsmap the location
of a pixel on one frame to the location of the corresponding pixel in a neighbouring frame. It has the same
dimensions as the image, but contains an (x,y) offset per pixel. These offsets show how to warp a neighbouring
image onto the current image.

Clearly, asmost of the images in a sequence have two neighbours, each can have two vector fields. These are called
the forwardmotion vectors where they represent thewarp of the next frame on to current frame, and backward
motion vectors where they represent thewarp of the previous frame on to current frame.

Disparity vectorsmap pixels between views, whereasmotion vectorsmap
thembetween frames.

O_VectorGenerator stores themotion vectors in the backward and forwardmotion channels. To view these in Nuke,
selectmotion, forward, or backward from the channel set menu in the top left corner of the Viewer.
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Source frame. Themotion channel generated by Ocula.

Forwardmotion vectors. Backwardmotion vectors.

If you want to use pre-calculatedmotion vectors rather than generate vector fields each time you need them, you
can use aWrite node to render them into the channels of your stereo .exr file along with the colour and disparity
channels. Later, whenever you use the same image sequence, themotion vectors are loaded into Nuke together with
the sequence.

Ocula’s Retimer node relies onmotion vectors to produce its output, but youmay also want to useO_
VectorGenerator for other purposes (for example, for generatingmotion blur).

Inputs
O_VectorGenerator has the following inputs:

Source A stereo pair of images.
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Mask An optionalmask that specifies areas to exclude from themotion calculation. You
can use this input to prevent distortions at occlusions or to calculatemotion for a
background layer by ignoring all foreground elements.

Note that masks should exist in both views, and O_VectorGenerator treats the
alpha values of 1 as foreground and blurs to the 0 value using nearby vectors to
recreate object boundaries, rather than image data. When you create amask using
Roto or RotoPaint, you can use the feather control to extend the calculation. For
example, the vectormapmay have a sharper transition at edges with a binary
mask, but applying feather on themask can help smooth the resulting image.

The left view. Amask to select the dancers in the
left view.

To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B.

Generating Motion Vectors
To generatemotion vectors for a stereo pair of images, do the following:

1. Select Ocula > Ocula 4.0 > O_VectorGenerator to add an O_VectorGenerator node after either a stereo clip or
a JoinViews node.

2. Make sure you are viewing the output fromO_VectorGenerator.

3. In theO_VectorGenerator controls, you can see all the views that exist in your project settings underViews to
Use. Select the two views you want to use to calculate themotion vectors. The two views you selected are
mapped for the left and right eye.

4. If there are areas in the image that you want to ignorewhen generating themotion vector field, supply amask
either in theMask input or the alpha of the Source input. In theO_VectorGenerator controls, setMask to the
component you want to use as themask.

If there are areas in the image that you want to ignorewhen generating vectors, supply amask either in the
Mask input or the alpha of the Source input. In theO_VectorGenerator controls, setMask to the component
you want to use as themask.
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Thewhite areas of the image have their vectors calculated as normal, whereas black areas take their vectors from
nearby areas. When you create amask using Roto or RotoPaint, you can use the feather control to tune the
calculation.

5. Set the Viewer’s channel set menu tomotion, forward, or backward.

O_VectorGenerator calculates themotion vectors and displays them in the Viewer.

6. If necessary, adjust Vector Detail, Strength, Consistency, and Smoothness and view their effect on the
motion vector field. Formore information on these parameters, seeO_VectorGenerator Controls.

Writing Motion Vectors into a Clip

When you're happy with themotion vectors generated, you can save time down the line by writing the vectors into a
new clip combining the source andmotion channels.

1. Select theO_VectorGenerator node in theNodeGraph.

2. Select Image >Write (or pressW on the keyboard) to insert aWrite node after O_VectorGenerator.

3. In theWrite node controls, select all from the channels dropdown and set file type to exr.

4. Enter a name for the clip in the file field (for example,my_clip.####.exr), and click Render.

The newly createdmotion channels are saved in the channels of your stereo clip. When you need to manipulate
the same clip again later, themotion vectors are loaded into Nuke together with the clip.

Rendering the output to combine the clip and themotion
channels for future use.
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O_VectorGenerator Controls

Use GPU

Open theO_VectorGenerator controls. O_VectorGenerator renders using the Local GPU specified, if available, rather
than the CPU. TheGPU may significantly improve processing performance.

If there is no suitable GPU, or the required NVIDIA CUDA drivers are unavailable, O_VectorGenerator defaults to
using the CPU. You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an
alternative card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.

Views to Use

From the views that exist in your project settings, select the two views you want to use to calculate themotion
vectors. These views aremapped for the left and right eye.

Mask

An optionalmask that specifies areas to exclude from themotion calculation. You can use this input to prevent
distortions at occlusions or to calculatemotion for a background layer by ignoring all foreground elements.

Note that masks should exist in both views, and O_VectorGenerator treats the alpha values of 1 as foreground and
blurs to the 0 value using nearby vectors to recreate object boundaries, rather than image data. When you create a
mask using Roto or RotoPaint, you can use the feather control to extend the calculation. For example, the vector
mapmay have a sharper transition at edges with a binary mask, but applying feather on themask can help smooth
the resulting image.

None Use the entire image area.

Source Alpha Use the alpha channel of the Source clip as an ignoremask.

Source Inverted Alpha Use the inverted alpha channel of the Source clip as an ignoremask.

Mask Luminance Use the luminance of theMask input as an ignoremask.
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Mask Inverted
Luminance

Use the inverted luminance of theMask input as an ignoremask.

Mask Alpha Use the alpha channel of theMask input as an ignoremask.

Mask Inverted Alpha Use the inverted alpha channel of theMask input as an ignoremask.

Vector Detail

Adjusts the detail of the calculatedmotion vectors. Higher detail picks up finermovement, but takes longer to
calculate.

Strength

Sets the strength inmatching pixels between frames. Higher values allow you to accurately match similar pixels in
one image to another, concentrating on detail matching even if the resultingmotion field is jagged. Lower values
may miss local detail, but are less likely to provide you with the odd spurious vector, producing smoother results.
Often, it is necessary to trade one of these qualities off against the other. Youmay want to increase this value to
force the images to match, for example, where fine details aremissed, or decrease it to smooth out themotion
vectors.

Consistency

Sets how heavily the forward and backward vectors are forced to match. Increase theConsistency to make the
forward and backward vectorsmore similar to each other, but thismay cause the vectors to match the image less.

Smoothness

Applies extra smoothing to themotion vector field as a post-process, after imagematching. The higher the value, the
smoother the result.

O_VectorGenerator Example
SeeO_Retimer Example for an example of how to useO_VectorGenerator and O_Retimer to calculate amotion
vector field for a stereo image and use it to retime the sequence.
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11 Retimer

Description
O_Retimer is designed to retime footage so that it plays back faster or in slow-motion. O_Retimer uses upstream
motion vectors generated by an O_VectorGenerator node to retime the footage. Thesemotion vectors describe how
each pixel moves from frame to frame (see VectorGenerator). With accuratemotion vectors, it is possible to
generate an output image at any point in sequence timeline by interpolating along the direction of themotion.

Simplemix of two frames to achieve an in-
between frame.

O_Retimer vector interpolation of the same
two frames.

By default, O_Retimer is set to perform a half-speed slow down. This is achieved by generating new frames at quarter
and three-quarter positions (.25 and .75) between the original frames at 0 and 1. In this way, none of the original
frames are used in the retimed sequence, as shown in the following diagram:

Timing Methods

You can retime footage using two different methods; the Speedmethod and the Source Framemethod. By
default, the Timing control is set to the Speedmethod.
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The Speedmethod allows you to set a new speed at which to play the footage back. A speed value below 1 slows the
clip down; and a speed value above 1, speeds it up. The default value is 0.5, which creates a half-speed retime.

NOTE: When using the Speedmethod, we recommend adding a FrameRange node before theO_Retimer
to control the input frame range. This allows you to visualise the retime using the Curve Editormore easily.

Alternatively, you can perform a retime using the Source Framemethod. This retimes the footage in terms of
specifying source frames at different outputs on the timeline. For example, you can specify frame 1 in the output
clip to read frame 1 of the source clip, and specify frame 100 in the output clip to read frame 50 of the source clip.
This is the equivalent of doing a half-speed retime.

Inputs
O_Retimer has the following inputs:

Motion If a vectors are supplied here, O_Retimer uses them and does not requiremotion in
the Source input. This can be useful if, for example, your input sequence is very
noisy, as toomuch noise interferes with themotion estimation. In that case, you
should supply a smoothed version of the sequence and an O_VectorGenerator
node here.

Source A stereo pair of images. If motion vectors are not embedded in the images, you
need to insert an O_VectorGenerator node after the image sequence to calculate
them.

To see a table listing the nodes or channels each Ocula node requires in its inputs, see Appendix B.

Using O_Retimer
NOTE: O_Retimer requires upstreammotion vectors to operate correctly.

Retiming Stereo Footage Using Speed

To perform a linear retime using the Speedmethod, do the following:

1. If motion vectors don’t yet exist in the script, you can use theO_VectorGenerator node to calculate them. See
VectorGenerator for information on how to do this.
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2. Select Ocula > Ocula 4.0 > O_Retimer to insert O_Retimer either after theO_VectorGenerator node if you
added one in the previous step, or after the stereo image sequence.

3. In theO_Retimer controls, select the two views you want to use for retiming underView to Use. The two views
you select aremapped for the left and right eye.

4. Connect a Viewer to theO_Retimer node. Your node tree should now look something like this:

5. Select a new speed value by either entering it the Speed box or dragging the Speed slider to the required value.

6. Play through the clip to calculate the retiming for all the frames.

NOTE: Constant retimes produce a number of frames equal to last frame - first frame / speed. For
example, a 10 frame clip at half speed would produce 10-1/0.5 = 18 frames.

Retiming Stereo Footage Using Source Frame

NOTE: You need to set aminimumof two keyframes to retime footage using the Source Framemethod.

To perform a linear retime using the Source Framemethod, do the following:

1. Repeat steps 1 to 4 in the Retiming Stereo FootageUsing Speed section.

2. Select Source Frame from the Timing dropdown.

3. Move the playhead to the first frame you want to change the output for on the Viewer timeline.

4. Set the source frame number that you want to appear at the selected output position by either entering it in the
Frame box, or dragging the Frame slider to the required frame.

5. Set a keyframe for this by selecting the animationmenu next to the Frame parameter, and clicking Set key. A
keyframe is indicated by a bluemarker.

6. Move the playhead on the Viewer timeline to the next frame you want to change the output for.

7. Set the source frame number that you want to appear at the selected output position by either entering it in the
Frame box, or dragging the Frame slider to the required frame. A keyframe is set automatically, identified with a
bluemarker.

8. Play through the clip to calculate the retiming for all the frames.
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NOTE: Constant retimes produce a number of frames equal to last frame - first frame / speed. For
example, a 10 frame clip at half speed would produce 10-1/0.5 = 18 frames.

Varying the Retime Speed

To vary the speed in your sequence, you can use either of the Timingmethods. As with the Source Frames
method, you add keyframes at different points on the Viewer timeline and specify varying speeds. Thismeans, the
speed changes at every keyframe, varying the speed throughout the clip.

NOTE: When you are retiming footage using the Speedmethod, ensure that you set the keyframes on the
input frames by using a FrameRange node, as setting keyframes on the input frames alters the number of
output frames.

Varying Retimes Using Speed

To vary the speed throughout the footage using the Speedmethod, do the following:

1. Repeat steps 1 to 4 in the Retiming Stereo FootageUsing Speed section.

2. Add a FrameRange (Time > FrameRange) node between theO_VectorGenerator and O_Retimer.

3. Set the timeline range to Input using the dropdown under the Viewer.

4. In the FrameRange node's Properties, specify the first and last frames you want to retime. For example, 1021 -
1040. This sets the input frames and allows you to visualise the retime using the Curve Editormore easily.

5. Set a keyframe on the first frame specified by the FrameRange node and then set the required keyframes to
retime the footage as required.

6. In theO_Retimer Properties, right-click the keyframed Speed control and select Curve editor.

TheCurve Editor tab displays the keyframes you added to retime the footage.
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7. If youmove points on the curve, you can see the out point on the Viewer timeline updates to show you how
many frames of output are created from the input frames.

TIP: You can add points to a curve by holding Ctrl/Cmd+Alt and clicking on the curve. This also adds a
corresponding keyframe to the Viewer timeline.

The left-hand curve creates 1042 output frames, whereas the shallower retime curve on the right produces
fewer output frames - just 1035 frames. However, the input frames displayed on the x axis of theCurve Editor
remain constant between 1021 and 1040.

Frames 1021 to 1040 with a steep
slowdown curve produces 1042 frames

output in the Viewer.

Frames 1021 to 1040 with a shallow
slowdown curve produces 1035 frames

output in the Viewer.

Varying Retimes Using Source Frames

To vary the speed throughout the footage using the Source Framesmethod, do the following:

1. Repeat steps 1 to 4 in the Retiming Stereo FootageUsing Speed section.

2. Select Source Frame from the Timing dropdown.

3. Move the playhead to the first frame you want to change the output for on the Viewer timeline.

4. Set the source frame number that you want to appear at the selected output position by either entering it in the
Frame box, or dragging the Frame slider to the required frame.

5. Set a keyframe for this by selecting the animationmenu next to the Frame parameter, and clicking Set key. A
keyframe is indicated by a bluemarker.

6. Move the playhead on the Viewer timeline to the next frame you want to change the output for.

7. Set the source frame number that you want to appear at the selected output position by either entering it in the
Frame box, or dragging the Frame slider to the required frame. A keyframe is set automatically, identified with a
bluemarker.
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8. Add asmany keyframes as necessary to produce the required retime. For example, if you had a clip consisting of
15 frames, you could:

• Set frame 1 to output frame 1, and frame 5 to output frame 2.5, resulting in a half-speed retime.

• Set frame 10 to output frame 15, resulting in a third speed up.

This creates a retime curve, which you can see if you right-click the Frame control and select Curve editor or
Dope sheet from the animationmenu. The graph would look something like this:

The y axis shows the source frames, and the x axis shows the output frames. By using theCurve Editor or
Dope Sheet to adjust this curve, you can create an arbitrarily changing speed for the sequence.

TIP: You can add points to a curve by holding Ctrl/Cmd+Alt and clicking on the curve. This also adds a
corresponding keyframe to the Viewer timeline.

O_Retimer Controls

Use GPU

Open theO_Retimer controls. O_Retimer renders using the Local GPU specified, if available, rather than the CPU. The
GPU may significantly improve processing performance.

If there is no suitable GPU, or the required NVIDIA CUDA drivers are unavailable, O_Retimer defaults to using the
CPU. You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an alternative
card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.
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Views to Use

From the views that exist in your project settings, select the two views you want to use to perform the retime. These
views aremapped for the left and right eye.

Timing

Use the Timing control to set the retimingmethod.

Speed Select thismethod if you want to define the retiming in terms of speed of playback
and total duration: double-speed halves the duration of the clip and half-speed
doubles the duration of the clip.

NOTE: When you are retiming footage using the Speedmethod, ensure
that you set the keyframes on the input frames, as setting keyframes on
the input frames alters the number of output frames.

Source Frame Select thismethod if you want to define the retiming in terms of specifying source
frames at different output points in the Viewer timeline. You need to set a
minimumof two keyframes to use the Source Framemethod.

Speed

The Speed control is only available when the Timingmethod is set to Speed. Use this to alter the playback speed.
Values below 1 slow down the clip. Values above 1 speed upmovement. For example, to slow down the clip by a
factor of two (half speed), set this value to 0.5. Quarter speed would be 0.25.

Frame

The Frame control is only available when the Timingmethod is set to Source Frame. Use this to specify the source
frame at the currently selected output frame on the Viewer timeline. For example, to slow down a 50 frame clip by
half, set the Source Frame to 1 at frame 1 and the Source Frame to 50 at frame 100. The default expression
results in a half-speed retime.
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Edges

Output edges to alpha

You can use theOutput edges to alpha checkbox to output the edges to the alpha channel. Use the alpha channel
as an overlay to determinewhere the edge correction is applied.

Adjust Edges

Use theAdjust Edges slider to change the size of the edgemask. To dilate themask, use a positive value. You can
use a negative value to erode themask.

Feather

You can use the Feather slider to specify howmuch feathering to apply to the edges. Increasing the Feather value
softens the edges; decreasing the value, sharpens the edges.

O_Retimer Example
In this example, we generatemotion vectors using O_VectorGenerator and feed them to O_Retimer in order to vary
the speed throughout the clip.

You can download the image used here fromourwebsite. Formore information, please see Example Images.

Step by Step

Generating Motion Vectors
1. Launch Nuke and open the project settings by pressing S on theNodeGraph. Go to theViews tab and click the

Set up views for stereo button.

2. Import dance_group.##.exr. This image already includes both the left and the right views.

3. Add a Viewer to the image.

4. Select Ocula > Ocula 4.0 > O_VectorGenerator to insert an O_VectorGenerator node after the image
sequence.
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The purpose of O_VectorGenerator is to calculate themotion vectors required later for retiming the sequence.

5. In the Viewer, selectmotion from the channel dropdown. The calculated forward and backwardmotion vectors
are displayed in the Viewer.

6. You can render out themotion vectors with the image by selecting Image >Write to insert aWrite node after
O_VectorGenerator. In theWrite node controls, select all from the channels dropdownmenu. Choose exr as
the file type. Select a location for the clip in the file field and enter dance_group_motion.##.exr as the name.
Click Render. The newly createdmotion vectors are saved in the channels of the clip.

7. Continue to the next section to retime the sequence using thesemotion vectors.

Retiming the Sequence
1. Import thedance_group_motion.##.exr clip you rendered in the previous step and connect a Viewer to it.

2. Play through the clip in the Viewer to get a sense of themotion.

3. Insert an O_Retimer node after the clip.

By default, this node is set to perform a half speed slow down. However, in this example, wewant to speed up
the sequence.

4. Instead of changing the clip’s playback speed in terms of overall duration, we are going to define the retiming by
specifying source frames at selected output frames in the Viewer timeline. In order to do this, set Timing to
Source Frame in theO_Retimer controls.
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Notice that the Speed control is not available and the Frame control is activated. The default Frame setting is 1,
which sets the first frame on the timeline to frame 1 of the input image.

NOTE: You need to set aminimumof two keyframes to use the Source Framemethod.

5. Click the animationmenu next to Frame and select Set key in order to set a keyframe at the first frame on the
timeline.

A keyframe is indicated by a blue chip.

6. Move the playhead to frame 8 and set the Frame value to 4. A keyframe is set automatically. O_Retimer sets
frame 8 on the timeline to frame 4 of the source image, effectively reducing the playback speed by half leading
up to frame 8.

7. Move the playhead to frame 15 and set the Frame value to 15. O_Retimer sets frame 15 on the timeline to the
last frame of the input clip, effectively returning the playback speed to normal at frame 15.

8. Press Play in the Viewer to process and review the results. After the process is complete, you are able to see the
result of the retime. Youmay have to reduce the fps control to see the result clearly.

9. Return to the beginning of the clip and play through each framewith theNext Frame arrow in the Viewer. You
should notice that the Frame value changes over time – slowly up to frame 8 andmore quickly towards the final
frame.
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12 DepthToDisparity

Description
Many Ocula nodes rely on disparity maps to produce their output. Usually, disparity maps are created using a
combination of theO_Solver (see Solver) and O_DisparityGenerator (see DisparityGenerator) nodes.

However, if you have a CG scenewith stereo camera information and a z-depthmap available, you can also use the
O_DepthToDisparity node to generate the disparity map. Provided that the camera information and z-depthmap
are correct, this is both faster andmore accurate than using theO_Solver and O_DisparityGenerator nodes.

Using one of the camera transforms and the corresponding depthmap, O_DepthToDisparity does a back projection
fromone view to find the position of each image point in 3D space. It then projects this point with the other camera
transform to find the position of the point in the other view. The difference between the two positions gives the
disparity in one direction.

As with theO_DisparityGenerator node, the final disparity vectors are stored in disparity channels, so youmight not
see any image data appear when you first calculate the disparity map. To see the output insideNuke, select the
disparity channels from the channel set and channel controls in the top left corner of the Viewer. Examples of what a
disparity mapmight look like using the RGB and R channels are shown below. As you can see, the RGB layers on the
left are harder to read than the single R channel.

Once you have generated a disparity map that describes the relation between the views of a particular clip well, it is
suitable for use inmost of theOcula nodes. We recommend that you insert aWrite node after O_DepthToDisparity
to render the original images and the disparity channels as a stereo .exr file. This format allows for the storage of an
imagewithmultiple views and channel sets embedded in it. Whenever you use the same image sequence, the
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disparity map is loaded into Nuke together with the sequence and is readily available for theOcula nodes. For
information on how to generate a disparity map using O_DepthToDisparity and render it as an .exr file, see
Generating a Disparity Map fromDepth.

NOTE: To useO_DepthToDisparity, you need the positions of the stereo camera rig for the two views.

Inputs
O_DepthToDisparity has the following inputs:

Camera ANuke stereo Camera node. This is the camera the scenewas rendered with. In
most cases, you would import this into Nuke from a third-party 3D application. For
information on how to do this, see theNuke User Guide.

In Nuke, a stereo camera can be either:

• a single Camera node in which some or all of the controls are split, or

• two Camera nodes (one for each view) followed by a JoinViews node (Views >
JoinViews). The JoinViews node combines the two cameras into a single output.

A single Camera nodewith split controls. Two cameras combined using Nuke’s
JoinViews node.

Depth This is a stereo pair of images (usually, a scene you’ve rendered from a 3D
application). In the depth channel, there should be a z-depthmap for each view.

NOTE: If this input is an .exr file, the z-depthmapmay already be
embedded in the clip.

If you’re using another file format and have saved the depthmap as a separate
image, you can use aNuke Shuffle node (Channel > Shuffle) to get the z-depth
map in the depth channel of theDepth image. For information on how to do this,
see theNuke User Guide.
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To see a table listing the nodes or channels each Ocula node requires in its inputs, turn to Appendix B.

Generating a Disparity Map from Depth
To generate a disparity map from a depth channel, do the following:

1. Start Nuke and press S on theNodeGraph to open the Project Settings. Go to theViews tab and click the Set
up views for stereo button.

2. From the Toolbar, select Image > Read to load your stereo clip (usually, a rendered 3D scene) into Nuke. If you
don’t have both views in the same file, select Views > JoinViews to combine them, or use a variable in the Read
node’s file field to replace the name of the view (use the variable%V to replace an entire view name, such as left
or right, and%v to replace an initial letter, such as l or r). Formore information, refer to theNuke User Guide.

Make sure the stereo clip contains a z-depthmap for each view in the depth channels. If this is not the case and
you have saved the depthmaps as separate images, you can use aNuke Shuffle node (Channel > Shuffle) to
shuffle them into the depth channels.

3. Select Ocula > Ocula 4.0 > O_DepthToDisparity to insert an O_DepthToDisparity node after either the stereo
clip or the JoinViews node (if you inserted one in the previous step).

4. Connect the camera that the scenewas rendered with to theCamera input of O_DepthToDisparity. It is
important the camera information is correct for the scene.

5. Open theO_DepthToDisparity controls. From theViews to Usemenu or buttons, select which views you want
to use for the left and right eyewhen creating the disparity map.

6. Attach a Viewer to theO_DepthToDisparity node, and display one of the disparity channels in the Viewer.

O_DepthToDisparity calculates the disparity map and stores it in the disparity channels.

7. Select Image >Write to insert aWrite node after O_DepthToDisparity. In theWrite node controls, select all
from the channels dropdownmenu. Choose exr as the file type. Render the clip.

The newly created disparity channels are saved in the channels of your stereo clip. When you need to manipulate
the same clip again later, the disparity vectors are loaded into Nuke together with the clip.

Rendering the output to combine the clip and the disparity
channels for future use.
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O_DepthToDisparity Controls

Views to Use

From the views that exist in your Project Settings, select the two views you want to use to create the disparity map.
These views aremapped for the left and right eye.

O_DepthToDisparity Example
This example shows you how to calculate a disparity map for a stereo pair of images using O_DepthToDisparity.

You can download the script used here fromourwebsite. Formore information, please see Example Images.

Step by Step
1. Start Nuke and select File > Open to import the gherkin.nk script.

2. This script has the left and the right view set up in the Project Settings. In theNodeGraph, there is a stereo
camera node.

3. Select Image > Read to import gherkin.exr and attach a Viewer to the image.

The image is a render of a 3D scene. It already includes the left and the right view, and a depth channel for both
views.

4. Select Ocula > Ocula 4.0 > O_DepthToDisparity to insert an O_DepthToDisparity node between the Read
node and the Viewer. Make sure the Read node is connected to theDepth input of O_DepthToDisparity.

5. Connect the Camera node to theCamera input of O_DepthToDisparity. This node is the camera the 3D scene
was rendered with. Your node tree should now look something like the one shown below.

6. Use the channelmenus in the top left corner of the Viewer to display one of the disparity channels.

O_DepthToDisparity calculates the disparity map and stores it in the disparity channels.

7. Temporarily decrease the gain value in the Viewer to see detail in the disparity channels and then switch back to
viewing the rgba channels.

8. To evaluate the quality of the disparity map, select Ocula > Ocula 4.0 > DisparityReviewGizmo.
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The default settings show that the disparity map is pretty good, with clearly defined depth edges picked out in
red. SeeDisparityReviewGizmo formore information.

It is worth noting that the results achieved with O_DepthToDisparity are usually better than those achieved with O_
Solver and O_DisparityGenerator for rendered 3D scenes, though this is not the casewith non-CG footage.

12 DEPTHTODISPARITY | O_DEPTHTODISPARITY EXAMPLE



13 DisparityToDepth

Description
TheO_DisparityToDepth node produces a z-depthmap for each view of a stereo clip, based on the clip’s disparity
map and stereo camera setup.

A z-depthmap is an image that uses the brightness of each pixel to specify the distance between the 3D scene point
and the virtual camera used to capture the scene. For example, youmay use a z-depthmap if you want to introduce
fog and depth-of-field effects into a shot. In Nuke, the ZDefocus node (Filter > ZDefocus) requires a depthmap in
its input.

O_DisparityToDepth stores the final z-depthmap in thedepth channel. Select depth from the channel dropdown
above the Viewer to display the z-depthmap. You can then select the red only channel (R) and adjust the gain and
gamma sliders above the Viewer to display the depthmapmore clearly.

The left view of a stereo image. The associated depthmap of the left view.

Inputs
O_DisparityToDepth has the following inputs:
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Camera A pre-tracked Nuke stereo camera that describes the camera setup that is used to
shoot the Source images. This can be a camera you have tracked with the
CameraTracker node or imported to Nuke from a third-party camera tracking
application.

In Nuke, a stereo camera can be either:

• a single Camera node in which some or all of the controls are split, or

• two Camera nodes (one for each view) followed by a JoinViews node (Views >
JoinViews). The JoinViews node combines the two cameras into a single output.

A single Camera nodewith split controls. Two cameras combined using Nuke’s
JoinViews node.

Disparity A stereo pair of images. O_DisparityToDepth requires upstreamdisparity vectors. If
they do not already exist, insert an O_DisparityGenerator node after the image
sequence to calculate them. SeeDisparityGenerator formore information.

To see a table listing the nodes or channels each Ocula node requires in its inputs, see Appendix B.

Using O_DisparityToDepth
NOTE: O_DisparityToDepth requires upstreamdisparity vectors to operate correctly.

To generate a z-depthmap for a stereo clip, do the following:

1. If disparity vectors do not yet exist in the script, you need to insert an O_DisparityGenerator node after your
image sequence to calculate the disparity vectors. SeeDisparityGenerator for how to do this.

TIP: O_DisparityGenerator'sAlignment control can reduces noise on the vertical component of disparity
and produce smoother variations in depth, but requires solve data upstream. See Solver formore
information on calculating solve data.
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2. Select Ocula > Ocula 4.0 > O_DisparityToDepth to insert an O_DisparityToDepth node either after theO_
DisparityGenerator node if you added one in the previous step, or after the image sequence.

3. Connect a pre-tracked Nuke stereo camera to theCamera input of O_DisparityToDepth.

4. Open theO_DisparityToDepth controls. From theViews to Usemenu, select which views you want to use for
the left and right eyewhen creating the z-depthmap.

5. Connect a Viewer to theO_DisparityToDepth node. Your node tree should now look something like this:

6. Select depth from the channel dropdown above the Viewer.

7. Select the red channel (R) from theRGB dropdown.

8. Adjust the gain and gamma controls to display the z-depthmapmore clearly.

9. To render out the stereo clip with the depthmap stored in the depth channel, select Image >Write to insert a
Write node after O_DisparityToDepth. In theWrite node controls, select all from the channels dropdown
menu. Choose exr as the file type. Render the clip.

When you need to use the same clip again later, the z-depthmap is loaded into Nuke along with the clip. To view
it, select depth from the channel dropdown.

Using O_DisparityToDepth with DeepMerge

You can use choose to useDeepMergewith O_DisparityToDepth to insert objects at specific depth positions. For
example, if you have an image of dancers, youmay want to add in smoke around them.

NOTE: The original image or image sequence you are usingmust contain an alpha channel for DeepMerge
to operate correctly.

To useO_DisparityToDepth with DeepMerge, you can do the following:

1. Ensure your footage has an alpha channel and repeat steps 1 to 5 from the previous section to calculate the
depth fromdisparity.

2. Insert a DeepFromImage node after theO_DisparityToDepth node by selectingDeep > DeepFromImage.
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3. Insert a DeepMerge node after the DeepfromImage node, and change the input from theDeepMerge node so
that theDeepFromImage node is connected using theB input.

4. Now, insert a separate DeepRead node by selectingDeep > DeepRead and navigate to the deep footage that
you want to insert into your original image. In this case, we are inserting smoke around dancers in a stereo
scene.

5. Attach theDeepRead node to theA input of DeepMerge. Your node tree should now look something like this:

6. The smoke does not appear in the image. Thismust mean that the depth values of the image and the deep
smoke are vastly different; one is too far in front of the other to be visible.

7. You can visualise the different depth positions by using a point cloud. To do this, insert a DeepToPoints node
after the DeepMerge node.

8. Attach the camera input of the DeepToPoints node to the existing camera. This shows you a 3D viewwith a
camera detailing the xyz coordinates of the footage in space.

As you can see, the smoke footage ismuch too far back and also too large.

9. To change the position and scale of the smoke footage, insert a DeepTransform node after the smoke footage
DeepRead node and before theDeepMerge node. Your node tree should now look something like this:
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10. Open theDeepTransform controls. To move the position of the smoke footage forward, you need to increase
the z value in the translate control. To decrease the depth of the smoke footage, you need to increase the
zscale value. This is a divisor, so numbers above 1 decrease the depth.

TheDeepToPoints view of the original stereo
image from the side .

TheDeepToPoints view of the smoke footage and
the original stereo image from the side .

The sameDeepToPoints view of the original stereo
image from the front.

The sameDeepToPoints view of the smoke
footage and the original stereo image from the

front.

11. PressD over theDeepToPoints node to disable it and display the result. Press Tab to revert back to 2D.
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O_DisparityToDepth Controls

Views to Use

From the views that exist in your project settings, select the two views you want to use to generate the z-depthmap.
These views aremapped for the left and right eye.

O_DisparityToDepth Example
In this example, we first generate a depthmap for a stereo pair of images using O_DisparityToDepth. Then, we blur
the image according to the depthmap.

Step by Step
1. Launch Nuke and select File > Open to import thedepth.nk script. This script has the left and the right view set

up in the Project Settings. In theNodeGraph, there is a stereo Camera node.

2. Select Image > Read to import Dance_Group.exr into Nuke.

3. To calculate disparity vectors, insert an O_DisparityGenerator node after the image. SeeDisparityGenerator for
more information.
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4. Select Ocula > Ocula 4.0 > O_DisparityToDepth to insert an O_DisparityToDepth node after theO_
DisparityGenerator node. Ensure theO_DisparityGenerator node is connected to theDisparity input of O_
DisparityToDepth.

5. Connect the Camera node to theCamera input of O_DisparityToDepth. Your node tree should now look
something like this:

6. Select depth from the channel dropdown above the Viewer to display the z-depthmap.

7. Select the red channel (R) from theRGB dropdown, and adjust the gain and gamma sliders above the Viewer to
see the depthmapmore clearly.

The left view of a stereo image. The red channel of the depthmap (with
adjusted gain and gamma).

8. To useO_DisparityToDepth with ZDefocus, continue to the next section.

An Example of Using O_DisparityToDepth with ZDefocus

The ZDefocus node blurs the image background according to the depth channels we’ve just created in the previous
section.

1. Continuewith the node tree you created in the previous section.

2. If you inserted a DisparityReviewGizmo node, either disable or delete it.

3. Select Filter > ZDefocus to add a ZDefocus node between O_DisparityToDepth and the Viewer. Your node tree
should now look something like this:
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4. Open the ZDefocus controls. A focal_point widget is displayed in the Viewer. Click and drag the focal_point
widget to the area on the image you want to be in focus. In this case, wewant the dancer at the front to be the
focus point.

5. Then set the ZDefocus controls as follows:

• channels to rgba

•math to far=0

• size to 63

6. View the output. To see the effect of the ZDefocus nodemore accurately, select the node in the node tree and
pressD once to disable and again to enable it.

The left viewwhen the ZDefocus node is
disabled.

The left viewwhen the ZDefocus node is
enabled.

7. You can save the depth in the channels of the input clip for later use. To do this, select Image >Write to insert a
Write node between O_DisparityToDepth and ZDefocus. In theWrite node controls, select all from the
channels dropdownmenu. Use the file control to give the file a location and a new name. Choose exr as the
file type and click Render to render the image.
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Description
TheO_MultiSample node allows you to use a Sample input to sample a selected area for one of the following uses:

• Fill thewhole imagewith a smooth interpolation of the data from the sample area. Any channels can be used
including depth, colour, disparity, and so on. For example, if you like the disparity vectors in a certain area, you can
expand them to fill the rest of the image by selecting the area you like in the Sample input and choosing disparity
from theChannels dropdown.

• Fill the area defined in the Sample input with the surrounding channel data. This allows you to fill holes or replace
unwanted areas. Any channels can be used including depth, colour, disparity, and so on. For example, if you had an
irregular area in a depthmap, you can select the irregular area and input it as a sampled area. You can then invert
the sampled area to fill it with the surrounding depth data.

The original left view of the
depthmap with an irregularity

in the top-right area.

A bezier is drawn around the
irregular area so that it can be

input as a sampled area.

O_MultiSample fills the
selected area by expanding the

surrounding pixels.

• Fill a different area specified in theMask input, with the channel data from the area specified in the Sample input.
This allows you to correct areas that have not been rebuilt correctly, or replace any irregular areas. Any channels
can be used including depth, colour, disparity, and so on. For example, if you had an area that has not been rebuilt
correctly when using O_NewView, you can correct it using O_MultiSample. SeeUsing O_MultiSamplewith the
Sample andMask Inputs formore information.

Inputs
O_MultiSample has the following inputs:
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Sample An input that defines an area to sample channel data from. This can be used for
filling thewhole imagewith a smooth interpolation of the data from the sample
area, inverting the sampled area and therefore filling the it with the surrounding
channel data, or using the sample channel data to fill another area specified in the
optionalMask input.

Source An image or a stereo pair of images.

Mask An optionalmask to define an area that you want to fill or replace using the channel
data from the area defined by Sample input.

To see a table listing the nodes or channels each Ocula node requires in its inputs, see Appendix B.

Using O_MultiSample
You can useO_MultiSamplewith only the Sample input to fill in holes or replace data, or you can useO_MultiSample
with theMask and Sample input, to apply the sample data to a different area specified in theMask input.

Using O_MultiSample with the Sample Input

You can useO_MultiSample to replace an area of channel data that is not accurate. For example, if you have
generated a disparity map and there is a section that you are not happy with, you can useO_MultiSample to fill the
specified shapewith the surrounding disparity vector data from thewhole image. Thismeans that the disparity
vectors in the selected area are replaced.

To useO_MultiSample to remove an area of disparity, you can do the following:

1. If disparity vectors do not already exist in the image sequence, insert an O_DisparityGenerator node after your
image sequence to calculate the disparity vectors. SeeDisparityGenerator formore information.

2. Select Ocula > Ocula 4.0 > O_MultiSample to insert an O_MultiSample node, either after theO_
DisparityGenerator node if you added one in the previous step, or after the image sequence.

3. Create a Roto node and connect it to the Sample input of theO_MultiSample node.

4. Connect a Viewer to theO_MultiSample node. Your node tree should now look something like this:

5. Open the Roto controls. Draw a bezier around the area of disparity you want to remove.
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6. Select disparity from the channel dropdown. Select Luminance from theRGB dropdown.

7. Adjust the gain and gamma controls to display the disparity mapmore clearly.

8. Open theO_DisparityGenerator controls. You can set the Strength control to 2, and the Smoothness control
to 3.

9. Open theO_MultiSample controls and set theChannels control to disparity.

10. Set the Sample control to Sample Inverted Alpha. This removes the disparity from the selected area by filling
it using the surrounding disparity vector data.

The original left view disparity map. The left viewwith the selected area of
disparity removed.

Using O_MultiSample with the Sample andMask Inputs

You can useO_MultiSample to correct a specific areawith data from the defined sample area. For example, if you use
O_NewView to create a new left view and an area of it doesn't build correctly, you can useO_MultiSample to correct
it.

In this case, you first create a new view:

1. O_NewView requires disparity vectors to operate correctly. If disparity vectors do not exist already, insert an O_
DisparityGenerator to calculate them either after the image sequence, or – if you added one – the JoinViews
node.
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2. O_NewView also requires an O_OcclusionDetector node. Insert this after theO_DisparityGenerator node.

3. Select Ocula > Ocula 4.0 > O_NewView to insert an O_NewView node and attach a Viewer to theO_NewView
node. Your node tree should now look something like this:

4. In theO_NewView controls, select Left from Right from theView to Build dropdown to rebuild the left view
using the pixels from the right.

The rebuilt left view from the right. Notice
the shoulder has not been reconstructed

correctly.

The original right view.

In this case, the left view has not been reconstructed correctly as a result of an irregular area in the disparity. This
can be corrected by using O_MultiSample:

5. Insert an O_MultiSample node before theO_NewView node.

6. Create a Roto node and attach it to the Sample input of O_MultiSample. Draw a bezier around an area of
disparity that you want to sample. In most cases, sampling the disparity from an area that is close produces the
best results (see screenshot below). In this case, we need to sample the disparity from a close area at the same
depth / or surface to get the best result.
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7. Create a RotoPaint node and attach it to theMask input of O_MultiSample. Your node tree should now look
something like this:

8. From the RotoPaint node, use a paint brush to paint a stroke over the area of disparity that you want to correct.
To view the stroke on the image, connect thebg input of the RotoPaint node to theO_DisparityGenerator node
and then attach the RotoPaint to Viewer. Choose to display Viewer input 2. Your node tree should now look
something like this:
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In this case, when you have the node tree set up like this and you display Viewer input 2, this is what you see:

9. Choose to display Viewer input 1.

10. Open theO_MultiSample controls, set theChannels control to disparity.

11. Set the Sample control to Sample Alpha, and theMask control toMask Alpha. This now fills the area
specified area in theMask input, with the data sampled from the specified area in the Sample input. In the
image, the painted area is now rebuilt correctly. To compare the result to the original, pressD several times with
theO_MultiSample node selected, to disable and re-enable it.
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The imagewith theO_MultiSample node
disabled, showing the incorrectly built

shoulder.

The imagewith theO_MultiSample node
enabled, showing the correctly rebuilt view.

O_MultiSample Controls

Use GPU

Open theO_MultiSample controls. O_MultiSample renders using the Local GPU specified, if available, rather than the
CPU. TheGPU may significantly improve processing performance.

If there is no suitable GPU, or the required NVIDIA CUDA drivers are unavailable, O_MultiSample defaults to using
the CPU. You can select a different GPU Device, if available, by opening Nuke's Preferences and selecting an
alternative card from theGPU Device dropdown.

NOTE: Selecting a different GPU requires you to restart Nuke before the change takes effect.

Channels

You can use theChannels control to select the channels you want to sample from the Source input. For example,
you can select disparity to sample the disparity vector data only in the selected area. The sample data can then be
applied to thewhole image, or the selected area can be filled (replaced) using the surrounding channel data. When
you select a channel set, the individual channels within that set are displayed to the right as checkboxes. You can
toggle these on and off to view selected channels.

When you select an additional channel from the second channel dropdown, the checkbox beside it is automatically
enabled. You can then toggle this on and off to use the additional channel.
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Sample

The Sample control defines the area to sample. You can connect a RotoPaint or Roto node to define an area, and
connect it to the Sample input, or you can use the source alpha channel.

NOTE: Areas with non-zero values in the Sample input are sampled. Pixels with higher values are given
moreweight when they are expanded.

Select one of the following options:

None Use the entire image area.

Source Alpha Use the alpha channel of the Source input to define the area of the Source input
that is sampled and expanded. The selected area is embedded in the image
sequence.

The left view. Amatte overlay of the Source alpha.
White pixels definewhere the Source

input is sampled.
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Source Inverted Alpha Use the inverted alpha channel of the Source input to define the area of the
Source input that is sampled and expanded. The selected area is embedded in the
image sequence.

The left view. A invertedmatte overlay of the inverted
Source alpha. White pixels determine
where the Source input is sampled.

Sample Luminance Use the luminance of the Sample input to define the area of the Source input that
is sampled and expanded.

Sample Inverted
Luminance

Use the inverted luminance of the Sample input to define the area of the Source
input that is sampled and expanded.

Sample Alpha Use the alpha channel of the Sample input to define the area of the Source input
that is sampled and expanded.

Sample Inverted Alpha Use the inverted alpha channel of the Sample input to define the area of the
Source input that is sampled and expanded.

Mask

TheMask control defines the area in which to expand the sample data. You can connect a RotoPaint or Roto node
to define an area, and connect it to theMask input, or you can use the source alpha channel.

NOTE: TheMask input is used to perform a keymix between the Source input and the expanded result.

Select one of the following options:

None TheMask input is not used, and therefore the sample data is expanded to fill the
whole image.
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Source Alpha Use the alpha channel of the Source input to define the area that is replaced by the
expanded data. The selected area is embedded in the image sequence.

The left view. Amatte overlay of the Source alpha.
White pixels define the area to be
replaced by the expanded data.

Source Inverted Alpha Use the inverted alpha channel of the Source input to define the area that is
replaced by the expanded data. The selected area is embedded in the image
sequence.

The left view. Amatte overlay of the Source alpha.
White pixels define the area to be
replaced by the expanded data.

Mask Luminance Use the luminance of theMask input to define the area that is replaced by the
expanded data.

Mask Inverted
Luminance

Use the inverted luminance of theMask input to define the area that is replaced by
the expanded data.

Mask Alpha Use the alpha channel of theMask input to define the area that is replaced by the
expanded data.

Mask Inverted Alpha Use the inverted alpha channel of theMask input to define the area that is
replaced by the expanded data.
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O_MultiSample Example
In this example, we first generate a disparity map for a stereo pair of images using O_DisparityGenerator. Then, we
useO_MultiSample to remove an area of the disparity and fill it using the surrounding disparity vector data.

Step by Step
1. Launch Nuke. Open the Project Settings (press S on theNodeGraph), select theViews tab, and click the Set up

views for stereo button.

2. Select Image > Read to import Dance_Group.exr.

3. To calculate disparity vectors, insert an O_DisparityGenerator node after the image sequence. See
DisparityGenerator formore information.

4. Select Ocula > Ocula 4.0 > O_MultiSample to insert an O_MultiSample node after theO_DisparityGenerator
node.

5. Insert a Roto node and connect it to the Sample input of theO_MultiSample node.

6. Attach a Viewer to theO_MultiSample node. Your node tree should now look something like this:

7. Select disparity from the channel dropdown above the Viewer to display the disparity map.

8. Select the red channel (R) from theRGB dropdown, and set the gain control to -1/45.

9. Adjust the gamma slider above the Viewer to display the disparity mapmore clearly.

10. Open the Roto controls and select Bezier to the left of the Viewer. Draw a bezier around the dancer on the right.

11. Open theO_MultiSample controls. Select disparity from theChannels control.

12. Set the Sample control to Sample Inverted Alpha. The selected area of disparity is now filled using the
surrounding disparity vector data, replacing the disparity in the selected area.
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The original left view of the disparity map
with a beziermarking the selected area.

The left of view of the disparity with the
selected area removed.
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Description
There are several tools in Ocula that you can use to check the quality of stereo footage and disparity in an image
sequence. These tools includeO_DisparityViewer, DisparityReviewGizmo and StereoReviewGizmo.

DisparityViewer

Description

TheO_DisparityViewer node allows you to visualise the disparity vectors in your node tree, display a histogram
detailing positive and negative parallax, or overlay the Viewer with parallax violations.

NOTE: All threeO_DisparityViewermodes are baked into your render if the node is enabled when you
write your sequence out. This allows you to render the output alongside disparity for review.

You can add O_DisparityViewer after any node in theNodeGraph. As long as there is a disparity channel at that
point in the tree, O_DisparityViewer produces a Viewer overlay with arrows showing the disparity vectors at regular
intervals, a histogram, or parallax violations depending on theDisplay control.

O_DisparityViewer allows you to view diagnostic tools to help you determinewhere your stereo footage needs work:

• DisparityViewer - the disparity vectors at any given point in your node tree for a selected view or both views.

• Displaying Parallax Histograms - a histogram showing the parallax, in pixels, on the x axis, the number of image
pixels on the y axis, and the negative and positive parallax violation areas in red and green, respectively.

• Displaying Parallax Violation Overlays - highlights the areas of negative and positive parallax violation - that is, areas
outside the limits specified in theNegative Limit and Positive Limit controls.

Displaying Disparity Vectors

To visualise the disparity vectors at any given point of your node tree, do the following:
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1. Select a node at any point in the node treewhere there is a disparity channel.

If you don’t have a disparity channel in the data stream, you can add one using an O_DisparityGenerator node.
SeeDisparityGenerator formore information.

2. ChooseOcula > Ocula 4.0 > O_DisparityViewer from the Toolbar.

This inserts an O_DisparityViewer node in your node tree.

3. UnderViews to Use, select the views you want to use to visualise the disparity vectors. These views are
mapped for the left and right eye.

4. Using theDisplaymenu, select DisparityVectors.

5. If you want to display the vectors for both views rather than just the current view, check Show Both
Directions.

Vectors for the left view. Vectors for both views.

6. Zoom in to better see the disparity vectors in the overlay.

7. If the Viewer seems too cluttered or the arrows overlap, increase theVector Spacing value.

8. If necessary, use thedisparityR and disparityL parameters to change the colour of the arrows. Youmay want
to do this, for example, if the default colour is very close to the colours in your input image, or if you want to
compare disparity methods and havemore than oneO_DisparityViewer overlay displayed at once. SeeO_
DisparityViewer Controls formore information.

NOTE: Disparity vectors are baked into your render if the node is enabled when you write your sequence
out.

Displaying Parallax Histograms

To view a parallax histogram for any given point of your node tree, do the following:

1. Select a node at any point in the node treewhere there is a disparity channel.

If you don’t have a disparity channel in the data stream, you can add one using an O_DisparityGenerator node.
SeeDisparityGenerator formore information.

2. ChooseOcula > Ocula 4.0 > O_DisparityViewer from the Toolbar.

This inserts an O_DisparityViewer node in your node tree.

3. UnderViews to Use, select the views you want to use to visualise as a histogram. These views aremapped for
the left and right eye.
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4. Using theDisplay dropdownmenu, select Parallax Histogram.

Parallax histogram.

The Viewer displays a histogram showing Parallax (in pixels) on the x axis, the number of image pixels on the y
axis, and the negative and positive parallax violation areas in red and green, respectively.

The screen is placed at zero on the x axis, so negative parallax refers to parts of the image that are in front of the
screen and positive parallax to the parts that are behind the screen.

5. Use theHistogram controls to define your histogram as necessary. SeeO_DisparityViewer Controls formore
information.

NOTE: Histograms are baked into your render if the node is enabled when you write your sequence out.

Displaying Parallax Violation Overlays

To view a parallax violation overlay for any given point of your node tree, do the following:

1. Select a node at any point in the node treewhere there is a disparity channel.

If you don’t have a disparity channel in the data stream, you can add one using an O_DisparityGenerator node.
SeeDisparityGenerator formore information.

2. ChooseOcula > Ocula 4.0 > O_DisparityViewer from the Toolbar.

This inserts an O_DisparityViewer node in your node tree.

3. UnderViews to Use, select the views you want to use to visualise parallax violation. These views aremapped
for the left and right eye.

4. Using theDisplay dropdownmenu, select Parallax Violation.
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Parallax violation overlay.

The parallax violation overlay appears in the Viewer, highlighting the areas of negative and positive parallax
violation - that is, areas outside the limits specified in theNegative Limit and Positive Limit controls.

5. Use the Parallax controls to define your overlay parameters as necessary. SeeO_DisparityViewer Controls for
more information.

NOTE: Parallax violation overlays are baked into your render if the node is enabled when you write your
sequence out.

Inputs

O_DisparityViewer has the following inputs:

Source This is any node in the node treewith a disparity map in the disparity channels.

To see a table listing the nodes or channels each Ocula node requires in its inputs, see Appendix B.

O_DisparityViewer Controls

Views to Use

From the views that exist in your project settings, select the two views you want to usewhen visualising the disparity
vectors. These views aremapped for the left and right eye.
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Display

Select the display mode from the dropdownmenu:

Disparity Vectors Overlays the disparity vectors at any given point in your node tree for a selected
view or both views.

Parallax Histogram Displays a histogram showing the parallax, in pixels, on the x axis, the number of
image pixels on the y axis, and the negative and positive parallax violation areas in
red and green, respectively.

Parallax Violation Highlights the areas of negative and positive parallax violation - that is, areas
outside the limits specified in theNegative Limit and Positive Limit controls.

Vectors

disparityR Colour of the arrows used for displaying left-to-right disparity. Youmay want to
change this, for example, if the colour of the arrows is very close to the colours in
your input image, or if you want to compare the vectors frommultiple O_
DisparityViewers in the same Viewer.

disparityL Colour of the arrows used for displaying right-to-left disparity. Youmay want to
change this, for example, if the colour of the arrows is very close to the colours in
your input image, or if you want to compare the vectors frommultiple O_
DisparityViewers in the same Viewer.

Show Both Directions Check this to show the disparity vectors for both views rather than just the current
view.

Vector Spacing Howoften a disparity vector is drawn. If necessary, you can increase this value to
make the display less cluttered. Youmay want to do so, for example, if the
disparities are large and you don’t want neighbouring vectors to overlap one
another.
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Histogram

Histogram Range Use thismenu to select the histogram range:

• Automatic - the range is scaled to fit the range of disparity.

•User Defined - the range is defined using theHistogram Min andMax controls
as a percentage of screen width.

Histogram Min Controls the lower limits of the histogram as a percentage of screen width, that is,
the left-most points on the x axis.

NOTE: This control is only activewhenHistogram Range is set to
UserDefined.

Histogram Max Controls the upper limits of the histogram as a percentage of screen width, that is,
the right-most points on the x axis.

NOTE: This control is only activewhenHistogram Range is set to
UserDefined.

Parallax

Negative Limit Sets the amount of negative parallax allowed as a percentage of screen width.
Areas outside this negative limit aremarked by the overlay in the colour specified in
theNegative Violation control.

Pixels Displays the number of pixels allowed by negative parallax.

Positive Limit Sets the amount of positive parallax allowed as a percentage of screen width. Areas
outside this positive limit aremarked by the overlay in the colour specified in the
PositiveViolation control.

Pixels Displays the number of pixels allowed by positive parallax.

Negative Violation Sets the overlay colour for pixels outside the specifiedNegative Limit value.

Positive Violation Sets the overlay colour for pixels outside the specified Positive Limit value.
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O_DisparityViewer Example

In this example, we useO_DisparityViewer to evaluate the disparity map produced by O_DisparityGenerator. For
information on where to get the sample footage, please see Example Images.

Step by Step
1. Start Nuke and press S on theNodeGraph to open the Project Settings. Go to theViews tab and click the Set

up views for stereo button.

2. Select Image > Read and browse to where you saved the tutorial files. Go to theO_DisparityGenerator
directory, select Dance_Group.exr, and clickOpen.

A Read node is added to theNodeGraph.

TIP: If you've already run through theO_DisparityGenerator Example to create a disparity map, you can
open the image you rendered earlier and skip to step 4.

3. Select Ocula > Ocula 4.0 > O_DisparityGenerator from the Toolbar.

This inserts an O_DisparityGenerator node.

4. Select theO_DisparityGenerator node (or the Read node pointing to your own pre-rendered image) and choose
Ocula > Ocula 4.0 > O_DisparityViewer from the Toolbar.

This inserts an O_DisparityViewer node and forces Ocula to calculate the disparity channel.

5. Connect a Viewer to theO_DisparityViewer node so we can seewhat’s happening. Your node tree should look
similar to the image shown.

6. Using the default O_DisparityViewer settings, the Viewer is a little crowded. Tomake the display less cluttered,
set Vector Spacing to 80.

7. To display vectors for both views, check Show Both Directions in theO_DisparityViewer controls. The vectors
for the left-to-right disparity are shown in red, and the vectors for the right-to-left disparity in green.
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Themain purpose of this tutorial is to show you how to use the Parallax Histogram and Parallax Violation
display modes.

8. In theO_DisparityViewer controls, click on theDisplay dropdownmenu and select Parallax Histogram.

The Viewer displays a histogram showing parallax (in pixels) on the x axis, the number of image pixels on the y
axis, and the negative and positive parallax violation areas in red and green, respectively.

NOTE: The screen is placed at zero on the x axis, so negative parallax refers to parts of the image that are
in front of the screen and positive parallax to the parts that are behind the screen.

HistogramRange defaults toUserDefined, so the graph producedmay not contain all the pixels in the image.

9. Click theHistogram Rangemenu and select Automatic.

The histogram is re-rendered to automatically fit the range of disparities in the image.
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As you can see in this example, a small proportion of the image exceeds the positive violation threshold (green)
and none of the image exceeds the negative threshold (red).

10. In theO_DisparityViewer controls, click on theDisplaymenu and select ParallaxViolation.

The parallax violation shown in the histogram is overlaid on the Viewer highlighting, in this case, the areas of
positive parallax violation.

11. If you adjust the Positive Limit slider down to 1.4 and up to 3, you can see the changing extent of the positive
violation limit. In the right-hand image, the violation has disappeared completely.

Low Positive Limit. High Positive Limit.

12. You can adjust theNegative Limit in the sameway, though in this case you’ll need to input a figure greater
than 0 to see any violation.
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DisparityReviewGizmo

Description

TheDisparityReviewGizmo node allows you to check the quality of the disparity vectors. TheDisparityReviewGizmo
node is inserted before the Viewer in the node tree. This displays the imagewith a desaturated background by
default, and highlights any depth changes, alignment changes, and occluded regions.

NOTE: To detect the occluded regions, you need to insert an O_OcclusionDetector node upstream in the
node tree.

Inputs

O_DisparityReviewGizmo has the following inputs:
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Source A stereo pair of images. DisaprityReviewGizmo requires upstreamdisparity vectors.
If they do not already exist, insert an O_DisparityGenerator node after the image
sequence to calculate them. SeeDisparityGenerator

To see a table listing the nodes or channels each Ocula node requires in its inputs, see Appendix B.

Using DisparityReviewGizmo

NOTE: DisparityReviewGizmo requires upstreamdisparity vectors to operate correctly.

1. If disparity vectors do not yet exist in the script, you need to insert an O_DisparityGenerator node after your
image sequence to calculate the disparity vectors. SeeDisparityGenerator for how to do this.

2. Select Ocula > Ocula 4.0 > DisparityReviewGizmo to insert an DisparityReviewGizmo node either after the
O_DisparityGenerator node if you added one in the previous step, or after the image sequence.

3. Connect a Viewer to theO_DisparityReviewGizmo node. Your node tree should now look something like this:

4. In theDisparityReviewGizmo controls, output is set to stereo by default. You can also change this to
disparityR (right), disparityL (left), or side-by-side. See the Controls section formore information.

5. You can choose different backgrounds to view including image, desaturated and disparity. By default, the
background control is set to desaturated. This displays the imagewith a desaturated background and
highlights the following:

• Depth changes are highlighted in red.

• Alignment changes are highlighted in green.

• Occluded pixels are highlighted in blue. To detect the occluded regions, you need to insert an O_
OcclusionDetector node upstream in the node tree.

The original left view of a stereo image. The left viewwith DisparityReviewGizmo
node highlighting any depth changes,

alignment changes, and occluded regions.
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6. Adjust the DisparityReviewGizmo controls to get the required overlay. See the following Controls section for
more information.

DisparityReviewGizmo Controls

Output

This is set to stereo by default. When you are using Ocula to update one view tomatch another, it is advised to
check the quality of the view that has been updated. Set the output to one of the following:

stereo Select stereo to check the quality of both views (left and right) at the same time.

disparityR (right) Select this to check the quality of the right view and disparityR only.

So theR in disparityRmeans that it samples from the right view and the vectors
originate in the left view. They define how tomatch the right view and rebuild the
left just from the right pixels.
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disparityL (left) Select this to check the quality of left view and disparityL only.

So the L in disparityLmeans that it samples from the left view and the vectors
originate in the right view. They define how tomatch the right view and rebuild the
left just from the right pixels.

side-by-side Select side-by-side to output both views beside each other.

Background

Use thebackground control to set the image displayed in the background, which the highlights are then displayed
on top of. This is set to desaturated by default.

image Select image to display the original
image in the background.
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desaturated Select desaturated to display a
greyscale version of the original image.
Thismakes the highlightsmore visible.

disparity Select disparity to view the disparity
vectors for the selected view. This is
useful for when you are tuning or
editing upstreamdisparity as it helps
you understand how the vectors change
as well as allowing you to quality check
the output. Set the disparity Limits
controls to grade the disparity vectors.

Intensity

Use the intensity control to set the intensity of the background image. To make the quality check highlightsmore
visible, reduce the intensity control.

xDisparity

You can use the xDisparity Intensity control to set the amount of horizontal disparity changes (depth changes)
displayed. These changes are highlighted in red. This is useful when you are tuning O_DisparityGenerator to ensure
depth changes are correct, or when checking a disparity precomp to determine if there are any irregularities that
need to be corrected.

yDisparity

Use the yDisparity Intensity control to set the amount of vertical disparity changes (alignment changes) displayed.
These changes are highlighted in green. This is useful to check the quality of vertical disparity when performing a
vertical alignment, or to check vertical alignment along with depth to see if there is amisalignment in the camera rig.
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Occlusion

NOTE: To detect the occluded regions, you need to insert an O_OcclusionDetector node upstream in the
node tree.

You can use the occlusion control to set the amount of occluded regions displayed. In DisparityReviewGizmo, these
changes are highlighted in blue. Occluded regions are pixels that are visible in one view and not the other. This is
useful to quality check occluded regions when rebuilding or updating one view from another.

Limits

NOTE: These controls are only available when thebackground control is set to disparity.

xMinimum Set theminimumparallax used to grade horizontal disparity.

xMaximum Set themaximumparallax used to grade horizontal disparity.

yMinimum Set theminimumpixel offset used to grade the vertical disparity.

yMaximum Set themaximumpixel offset used to grade the vertical disparity.

Set Limits

Click Set Limits to automatically set theminimumandmaximumparallax and vertical offset, by sampling the input
disparity at the current frame. You can keyframe the limit settings at different frames in the sequence.

Reset Limits

Click this to reset the disparity limits to the default values.

StereoReviewGizmo

Description

You can use the StereoReviewGizmo node to perform a quick quality check on stereo footage. StereoReviewGizmo
requires upstreamdisparity vectors. If disparity vectors do not already exist in the image sequence, the
StereoReviewGizmo node calculates disparity.
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The StereReviewGizmo can display a difference view to show the differences in the stereo sequencemore clearly.
You can set the point of interest using the Parallax controls and you can set a sample subject to focus on by
dragging and dropping the sample widget in the Viewer.

The original left view of a stereo image. The difference view created by the
StereoReviewGizmo node.

You can use StereoReviewGizmo to quickly toggle between the difference view, the stereo view, and the left and right
views to do quick comparisons. Perform a short playback in any view to check temporal stability, or animate the
depth rack to display the difference between the specified near and far settings.

Inputs

O_StereoReviewGizmo has the following inputs:

Source A stereo pair of images. StereoReviewGizmo uses disparity vectors. However, if
there are no disparity vectors available, StereoReviewGizmo calculates the
disparity.

To see a table listing the nodes or channels each Ocula node requires in its inputs, see Appendix B.

Using StereoReviewGizmo
1. Select Ocula > Ocula 4.0 > StereoReviewGizmo to insert an StereoReviewGizmo node either after theO_

DisparityGenerator node if you added one, or after the image sequence.

2. Connect a Viewer to theO_StereoReviewGizmo node. Your node tree should now look something like this:

3. Adjust the Parallax controls to re-converge on points of interest. You can either set the Parallax controls
manually, or you can click Auto Near/Far to automatically set the parallax range. The output control is
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automatically updated to far and a difference view is displayed in the Viewer, allowing you to adjust the settings
until the point is aligned. Thismakes it easier to line up the left and right view.

4. You can then use Toggle Left/Right to review the footage at this point with the left and right output.

5. Use Start Playback to play a 10 frame sequence for the current output. This allows you to review the point of
interest defined by the Parallax controls, for any temporal issues. This control now toggles to STOP Playback.
Click this to restore the timeline.

6. By default, subjectPt is enabled in the StereoReviewGizmo controls. With this enabled, you can drag and drop
the subjectPt widget in the Viewer to select a point of interest. To disable subjectPt, select thehide checkbox
to the right of the subjectPt controls.

7. Adjust the Parallax settings and toggle between different views using the output controls to examine the
differences.

8. Select Start Depth Rack to animate the through depth between the specified near and far settings. See the
following Controls section formore information.

StereoReviewGizmo Controls

Output

Use the output control to select the Viewer output. Select one of the following:

stereo The stereo output shows the input re-converged at the depth defined by slider.

left The left output shows the re-converged left view only.

right The right output shows the re-converged right view only.

slider Select this to show a difference view, re-converged by the Parallax controls. Adjust
the controls until the image becomes aligned on the point of interest.

near Select this to show a difference view, re-converged by the Parallax controls. Adjust
the controls until the image becomes aligned on the point of interest.

subject Select this to show a difference view, re-converged by the Parallax controls. Adjust
the controls until the image becomes aligned on the point of interest.

far Select this to show a difference view, re-converged by the Parallax controls. Adjust
the controls until the image becomes aligned on the point of interest.
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Align Input Checkbox

Select theAlign input for colour match review checkbox to align the input using disparity to review colour
differences only. You can toggle this option on and off to review the colourmatch if the input has not been aligned,
and to detect where there ismisalignment in the shot.

View Slider

UseView Slider to change the output to show the difference view, set by the Parallax – slider control.

Toggle Left/Right

Click Toggle Left/Rightmultiple times to toggle between the left and right views. You can use this to review the
footage at a particular point of interest, after re-converging using the Parallax – slider control.

Start Playback

Use Start Playback to play a 10 frame sequence of the current output. You can use this to review temporal
stability. After you click the Start Playback control, it toggles to STOP Playback; press this to restore the timeline.

NOTE: You can useCtrl/Cmd + click on the Viewer timeline to change the playback range.

Start Depth Rack

You can click Start Depth Rack to activate a FrameHold and animate through depth between the defined near and
far settings, showing the image difference. You can use this to check for alignment errors and colour differences
across depth. After you have press the Start Depth Rack control, it toggles to STOP Depth Rack; press this to
restore the timeline and disable the FrameHold.

NOTE: You canmanually scrub through the depth changes by dragging the Parallax – slider control.

Parallax Controls

Use the slider, near, subject and far controls to zero disparity and re-converge at a point of interest. When you
adjust one of these controls, the output is automatically updated to reflect it. For example, when you adjust the
near control, the output control is updated to near and a difference view is displayed in the Viewer.
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The difference view showing the
automatically specified near and far

controls.

The difference viewwith the Parallax
controls greatly increased.

Adjust the Parallax controls until the image is aligned at the point of interest. You can then use the Toggle
Left/Right control to switch between the input views at this point to review the input footage. You can also use the
Start Playback control to review the input at this depth.

Setup

Auto Near/Far

You can use theAuto Near/Far control to automatically set thenear and far parallax controls by sampling the
input disparity at the current frame. You can optionally key this at different frames in the shot.

subjectPt

By default, subjectPt is enabled. To disable it, select the hide checkbox to the right of the subjectPt controls. Use
this control to set the subject position at the current frame. Adjust the position to sample the input disparity and
automatically set the subject parallax. You can adjust the position by either entering the x and y coordinates of the
point, or by dragging and dropping the subjectPt widget in the Viewer.

NOTE: The subject point must be defined in the left view.

Bake Samples

Click Bake Samples to automatically sample the subject disparity at the animated sample position. You can use this
control when you are importing a track as the sample point in the left view. UseBake Samples to sample the
subject disparity and parallax for a specific frame range.
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Export Controls

Create Subject Transform

Use this control to export a Transformnode to align left and right views, using sampled subject disparity. First enable
the sample subject checkbox to sample the subject disparity. You can then useCreate Subject Transform to
create a separate transformnode that aligns the left and right views to quality check the subject.

You can create a transform for a tracked point by setting the track on the sample point and using Bake Samples.
The track has to be defined for the left view.

Views

Use theViews dropdown to set how the transform is applied, to line up the subject in the left and right view,
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Appendix A

Release Notes
This section describes the requirements, new features, improvements, fixed bugs, known bugs, and workarounds for
each release of Ocula.

Ocula 4.0v1
This is amajor new release of Ocula. The nodes have been rewritten to increase the stability and accuracy as well as
the ease of use in setting up and quality checking:

•New algorithms - the algorithms have been completely re-written producing state-of-the-art levels of accuracy,
saving a huge amount of clean-up time in post. Disparity vectors are cleaner andmore stable and image rebuilds
are sharper.

• GPU acceleration - the new algorithms now run on theGPU using BLINK technology to accelerate calculations,
producing the same results as the CPU, giving you piece-of-mind when rendering on a CPU farm.

See Requirements for GPU Acceleration formore information.

• Improved tools - this release also includesmajor feature updates to reduce iterations and speed-up shot turn-
around, making sure fixes are correct first time. New stream-lined controls enable you to easily tune results
manually, and Ocula now includes the ability to automate fixes offline using Nuke's python API.

• Toolsets and QC - new production tested Ocula templates have been included to push through production
footagewith newQC tools, making it easy to review corrections to get the best results fromOcula.

SeeNew Features and Enhancements for detailed information on individual tools.

Release Date

June 2014



162

MinimumSystemRequirements
• A version of Nuke 8.0 on:

• Windows 7 64-bit orWindows 8 64-bit

• Mac OS X 10.7 “Lion“, 10.8 “Mountain Lion“, or 10.9 “Mavericks“

NOTE: Nuke is expected to function correctly underMac OS X Mavericks (10.9), but we are seeing UI
performance degradation compared to previous OS X versions. We areworking on resolving these issues.

• Linux CentOS/RHEL 5 or CentOS/RHEL 6

• Foundry Licensing Tools (FLT 7.0v2 or later) for floating licenses.

Requirements for GPU Acceleration

To take advantage of GPU acceleration, youmust have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is
available at www.nvidia.co.uk/object/cuda_gpus_uk.html

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software
update.

• graphics drivers capable of running CUDA 4.2 or above.

• OnWindows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU.
Drivers fromApril 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us formore information.

• OnMac, the CUDA driver is separate from theNVIDIA graphics driver andmust be installed, if you don't have it
already. Theminimum requirement for CUDA 4.2 is driver version 4.2.5 which can be downloaded from
www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.

New Features and Enhancements

O_DisparityGenerator

O_DisparityGenerator has been rewritten from the ground up to provide cleaner, sharper vectors and useGPU
acceleration to perform the necessary complex processing, where available. The new vector engine is designed to
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provide clean separation in depth so that there is no roll-off between foreground and background regions, ensuring
that background corrections do not get dragged along with the foreground.

Ocula's O_DisparityGenerator no longer requires O_Solver alignment data by default. The Properties panel
Alignment control is set to 0 by default, which performs better when detecting changes in vertical alignment with
depth. Ocula also performs better with O_VerticalAligner's Local alignmentmode and produces better results
when picture building in O_NewView.

• BUG ID 42056 - A new Presets dropdown has been added to automatically adjust the refinement controls
depending on your selection.

O_OcclusionDetector

Occlusion detection has been rewritten to make best use of the new clean, sharp disparity vectors. Occlusion regions
are now clearly defined in themask_occlusion channel to identify where attention is required.

O_NewView

O_NewView now produces sharper images with greater fidelity to the original footage. O_NewView has been
updated to just rebuild one view from the other, including controls to handle occlusion and edge treatment.

• BUG ID 40303 - A new CleanPlate input has been added to allow you to supply a background for occlusion filling.

O_ColourMatcher

Colourmatching has been rewritten to make best use of the new clean, sharp disparity vectors and to simplify the
controls. Thematched results now have greater fidelity to the original image, allowing for smaller block sizes to
producemore detailed colour updates, while preserving the noise of the source.

• BUG ID 40300 - A new Stabilise occlusions check box has been added to the properties panel. When enabled,
Ocula uses occlusion data frommultiple frames to reduce flickering.

• BUG ID 42719 - A new control, Correction Scale, has been added to define the scale of colourmatching. Lower
values perform very local matching to preserve highlights in the reconstructed image. Higher values use amore
global correction, which better preserves the structure of the original image.

O_FocusMatcher

Focusmatching has been rewritten to explicitly match high-frequency edges between views. O_FocusMatcher now
looks and feelsmore likeO_ColourMatcher and no longer has issues with ringing, pixel shifts that change parallax,
and correlated noisewhen compared to Ocula 3.

• BUG ID 22995 - A new Stabilise occlusions check box has been added to the properties panel. When enabled,
Ocula uses occlusion data frommultiple frames to reduce flickering.
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O_Solver

A newKey Sequence button has been added to automatically analyse the source and place keys where a change in
camera alignment is detected.

Adding and aligning usermatches in O_Solver is nowmore accuratewith the addition of a zoomwindow and single
click workflow to create usermatches while viewing an image difference. Hotkeys have been added to toggle the
display between the left view and right views or display amix of both views. You can now click Delete Auto
Matches and solve the camera alignment with only usermatches.

If you have an interactive licence (ocula_i and nuke_i), O_Solver can now be executed from the terminal. You can
executemultiple frames, using Nuke's standard expressions and Python scripts, to automatically set up Ocula trees
and render corrections without the use of Nuke's interface. You can also set usermatches using Python.

O_VerticalAligner

TheO_VerticalAligner workflow has been streamlined, allowing you to perform several alignment calculations using a
single node in a fixed order. New controls have been added to enable you to fix plate scale and offset, change the
filter used to transform pixels, and output a vaSTMap channel containing uv data for use in an STMap node.

• BUG ID 21783 - All alignment options have now been incorporated into a single node to make it easier to select
and choose the best alignment correction.

• BUG ID 41700 - A new Zoom to prevent black in frame control has been added to correct areas pulled from
outside the bounding box after vertical alignment.

• BUG ID 42857 - You can now automate the setup of a CornerPin for a range of frameswithout having to manually
create the required analysis frames.

O_VectorGenerator

O_VectorGenerator has been rewritten from the ground up to provide cleaner, sharper vectors and useGPU
acceleration to perform the necessary complex processing, where available. The new vector engine is designed to
provide clean separation in depth so that there is no roll-off between foreground and background regions.

O_MultiSample

A brand new node, O_MultiSample, has been introduced. O_MultiSample uses the channels controls and Sample
andMask inputs to expand the sampled channels to fill the image orMask. This node can be used for different
tasks, such as:

• Expanding colours into black regions when aligning a plate.

• Removing and in-filling colour corrections at unreliable pixels.

• Painting corrections into disparity/motion vectors at unreliable pixels.
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Toolsets

Several pre-built NodeGraph templates have been added to automatically set up Nuke and Ocula to perform certain
tasks. The toolsets, accessed fromOcula 4.0 > Toolsets, provide example node trees with Backdrops to isolate
various parts of theworkflow and StickyNotes containing important information.

• FullPipeline - creates an entire workflow pipeline from reading in your stereo source, through various precomp
steps to add the required disparity and corrections, to reviewing corrections before handing off to the next stage
of post.

• InputReview - a simple pre-processing NodeGraph to read in your source and check colour and alignment.

•Output Review - a simple post-processing NodeGraph using the StereoReviewGizmo to performing some depth
correction review.

• Precomp_Alignment - creates a section of the FullPipeline toolset dealing with aligning views and rendering out
the results.

• Precomp_Disparity - creates a section of the FullPipeline toolset dealing with creating disparity and rendering out
the results.

• Precomp_PlateMatch - creates a section of the FullPipeline toolset dealing with colour and focusmatching and
rendering out the results.

QC Tools

Ocula now includes a new quality control gizmo, DisparityReviewGizmo, located in theOcula tool bar. The existing
StereoReviewGizmo has been rewritten to make it quick and easy to review colour and alignment at different depths,
review flicker and changes in depth, and bake out transforms to line up views for detailed review.

Miscellaneous
• The End User Licensing Agreement (EULA) that accompanies all The Foundry products has been amended. Please
see theOcula installer or Appendix D in theOcula User Guide formore information.

• BUG ID 35608 - Ocula did not fail to render from the command linewhen therewas an interruption in licence
serving. In Ocula 4.0, if there is an interruption between the licence server and Ocula, rendering aborts with an exit
code of 1. You can use the --cont command line argument to forceOcula to continue rendering on failure,
producing black licence failure frames rather than aborting thewhole render.

Bug Fixes
• BUG ID 25662 - Ocula 3.0v4: Setting theO_FocusMatcherDefocus size above 1 resulted in blank frames.

• BUG ID 30715 - O_Solver: The Viewer hotkeyM (Matte overlay) clashed with theDisplaymode hotkey.

• BUG ID 39910 -Mask inputs ignored the stereo offset control and split shapes in Roto nodes.
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• BUG ID 41688 - O_VerticalAligner: The bounding box was not updated after alignment corrections.

• BUG ID 42867 - O_Retimer: Retiming in Timing > Speedmode did not compute the retimed sequence length
correctly.

Known Issues and Workarounds
• BUG ID 43090 - Ocula's ReviewGizmos and Toolsets require standard left and right views to operate correctly.

• BUG ID 42742 - O_Solver: Deleting ormanipulating featurematches does not currently create an undo stack.

• BUG ID 42324 - O_Solver: The Viewer doesn't update after enabling downstreamnodes with postage stamps
enabled.

• BUG ID 41952 - O_Solver: The Preview Alignment overlay is not displayed until youmouse-over the Viewer.

Ocula 3.0v4
This release adds support for Nuke 8.0 and includes a bug fix.

Release Date

January 2014

MinimumSystemRequirements
• A version of Nuke 7.0 on:

• Windows XP Professional x64 Edition orWindows 7 HomePremium x64

• Mac OS X 10.6 “Snow Leopard”, 10.7 “Lion”, or 10.8 “Mountain Lion“

• Linux CentOS/RHEL 5 or CentOS/RHEL 6

• A version of Nuke 8.0 on:

• Windows 7 64-bit orWindows 8 64-bit

• Mac OS X 10.7 “Lion“, 10.8 “Mountain Lion“, or 10.9 “Mavericks“

NOTE: Nuke is expected to function correctly underMac OS X Mavericks (10.9), but we are seeing UI
performance degradation compared to previous OS X versions. We areworking on resolving these issues.

• Linux CentOS/RHEL 5 or CentOS/RHEL 6

• Foundry Licensing Tools (FLT 7.0v2 or later) for floating licenses.

New Features
• Ocula is now supported on Nuke 8.0 for all platforms.
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• The End User Licensing Agreement (EULA) that accompanies all The Foundry products has been amended. Please
see theUser Guide Appendices formore information.

Feature Enhancements

There are no enhancements this release.

Bug Fixes

BUG ID 39980 - O_Retimer: SettingWarp Mode > Simple when rebuilding views in Ocula caused Nuke to crash if
the input had an expanded bounding box that forced the bottom left of the image away from (0,0).

Known Issues andWorkarounds

BUG ID 22755 - O_Solver: Feature selection does not work withmultiple Viewers.

Ocula 3.0v3
This release adds support for Nuke 7.0 and contains two improvements.

Release Date

December 2012

MinimumSystemRequirements
• A version of Nuke 6.3 or 7.0 on:

• Windows XP Professional x64 Edition orWindows 7 HomePremium x64

• Mac OS X 10.5 “Leopard” (Nuke 6.3 only), 10.6 “Snow Leopard”, or 10.7 “Lion” (Nuke 7.0 only), 64-bit

• Linux RHEL 5.4 for Intel64 or AMD64

• Foundry Licensing Tools (FLT 7.0v2 or later) for floating licenses.

New Features

There are no new features in this release.
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Feature Enhancements
• BUG ID 22779 - Output from all Ocula nodes is now cached to prevent recalculation, improving the usability of
Ocula node trees considerably.

• BUG ID 32272 - O_DisparityGenerator and O_VectorGenerator now have aNoise parameter. This sets the
amount of noise these nodes should ignore in the input footagewhen calculating their results. The higher the
value, the smoother the results. Youmay want to increase this value if you find that your disparity ormotion
vector field is noisy in low-contrast image regions.

Bug Fixes
• BUG ID 24486 - O_DisparityGenerator: Connecting inputs with different bounding boxes caused Nuke to crash.

• BUG ID 26425 - Thedisparity channel was cropped to the bounding box even when rgba data existed outside the
bounds.

• BUG ID 29273 - O_DisparityViewer: Displaying the Parallax Histogram for images with a larger bounding box
than the format caused Nuke to crash.

• BUG ID 33006 - Ocula output was cropped when the bounding box was larger than the format.

• BUG ID 33022 - O_NewView: The view generated was incorrect when the inputs contained vertically offset
bounding boxes.

Known Issues andWorkarounds
• BUG ID 22755 - O_Solver: Feature selection does not work withmultiple Viewers.

Ocula 3.0v2
This release changes the licensing systemused by Ocula.

Release Date

January 2012

Requirements
• a version of Nuke 6.3 on

• Windows XP 64-bit orWindows 7 64-bit

• Mac OS X 10.5 “Leopard” or 10.6 “Snow Leopard”, 64-bit

• Linux RHEL 5.4 64-bit

• Foundry Licensing Tools (FLT) for floating licenses.
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New Features

The licensing systemused by Ocula has changed. Ocula now uses RLM licensing instead of FLEXlm. Formore
information, see Licensing Ocula on page 13.

Feature Enhancements

There are no improvements to existing features in this release.

Bug Fixes

There are no fixed bugs in this release.

Known Issues andWorkarounds
• BUG ID 22755 - O_Solver: Feature selection does not work withmultiple Viewers.

Ocula 3.0v1
This is amajor new release of Ocula. The plug-ins have been rewritten to increase the stability and accuracy as well as
the ease of use in setting up and quality checking. This release also introduces four new plug-ins and one new gizmo.

Release Date

November 2011

Requirements
• a version of Nuke 6.3 on

• Windows XP 64-bit orWindows 7 64-bit

• Mac OS X 10.5 “Leopard” or 10.6 "Snow Leopard", 64-bit

• Linux RHEL 5.4 64-bit

• Foundry FLEXlm Tools (FFT 5.0v1 or later) for floating licenses.

New Features

Ocula 3.0 introduces four new plug-ins:

• O_OcclusionDetector
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This plug-in outputs an occlusionmask for the left and right view to definewhere picture building with disparity is
incorrect.

The occlusionmask is required by O_ColourMatcher and the newO_FocusMatcher node to identify image regions
where local matching will fail. The occlusion layer can be edited to change how these plug-ins operate.

• O_FocusMatcher

This is a new plug-in that lets you rebuild one view from the other to match focus. Matching is based on a
combination of image rebuilding and deblurring.

You can also use this node to sharpen out-of-focus images.

There is an optionalKernel input to define the shape of the aperture causing the image blur.

• O_VectorGenerator

This plug-in calculates consistent left and right motion vectors for retiming. Themotion estimation algorithm is
based on the new disparity engine in O_DisparityGenerator and delivers vectors that maintain stereo alignment.

• O_Retimer

This plug-in lets you speed up or slow down a stereo clip based on the left and right motion vectors calculated by
O_VectorGenerator. You can control the new timing of the clip using either the Speed or the Frame control. Both
controls are animatable.

• StereoReviewGizmo

This gizmo lets you compare left and right views in various ways. For example, you can use it for testing vertical
alignment and colourmatches ormeasuring parallax. You can also convert it to a group to copy and edit the
internals. The gizmo is undocumented, but there are tool tips for all the controls.

Feature Enhancements

Ocula 3.0 includes key improvements to the quality and accuracy of existing plug-ins:

• All Ocula nodes

• BUG ID 22303 - Ocula nodes now cache results to disk to prevent recalculations and to reducememory
overhead.

• O_Solver

• O_Solver has been rewritten to increase the accuracy and the ease of use.

• The controls have been simplified.

• The node now uses a new, improved featurematching algorithm. This deliversmore accurate alignment data
to downstreamOcula nodes.

• The Feature Matches display option has been renamed to Keyframe Matches. As before, this shows
matches at keyframes only.

• There’s a new Preview Alignment display option that lets you preview the alignment of featurematches at
both keyframes and non-keyframes. This allows you to review howwell the interpolated solveworks and
whether additional keyframes are required. It also makes it simpler to delete badmatches and preview the
effect of usermatches.
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• In the Preview Alignment mode, there’s a newMatch Offset control that allows you to set the offset (in
pixels) applied to the aligned featurematches. You can also interactively control the offset using the < and >
keys on the Viewer. Increase the offset to view thematches with large disparities and spot badmatches.
Decrease the offset to set the disparity of matches to zero to examine the vertical offset at each feature.
Increase and decrease the offset interactively to viewwhichmatches do not move horizontally and are bad
matches.

• There is now an Error Threshold control that lets you select matches with a vertical error greater than the
threshold whenDisplay is set to PreviewAlignment. This allows you to delete badmatches with large errors
at keyframes and recalculate the alignment.

• The influence of usermatches has been increased and can now be previewed directly in the Preview
Alignment display.

• The right-click menu in the Viewer has been changed to provide access to theDisplay options and theMatch
Offset value. Shortcut keys have also been added.

• O_DisparityGenerator

• O_DisparityGenerator has been rewritten to deliver cleaner andmore accurate disparity vectors. This leads to
improved results in picture building operations, such as O_ColourMatcher, O_NewView, and O_
InteraxialShifter.

• The controls have been simplified.

• Disparity vectors now have a user-controlled weighting to match the alignment data from an upstreamO_
Solver.

• BUG ID 21787 & 22331 - Added new Parallax Limits withNegative and Positive controls. Negative sets
themaximumnegative parallax in pixels. Positive sets themaximumpositive parallax. There is also an
Enforce Disparity Limits control, which is off by default. Theworkflow is to review the disparities (you can
useO_DisparityViewer histograms). If there are some incorrect disparities that are too large, switch on Enforce
Disparity Limits and set the limits in terms of pixels.

• BUG ID 22430 - This node now has Fg and Ignoremask inputs. Use the foregroundmask to calculate vectors
for a specific foreground element and the ignoremask to exclude regions from the vector calculations.

• O_ColourMatcher

• There’s a new 3D LUT algorithm to calculate local colour updates in occluded regions defined by the newO_
OcclusionDetector plug-in.

• There is a new Export 3D LUT button. When you useO_ColourMatcher in 3D LUTmode, this allows you to
output the colour correction to a .vf file that you can use in Nuke’s Vectorfield node.

• In the Local Matchingmode, there is a newOcclusion Compensate checkbox that allows you to correct
the colour in occluded regions using the valid colourmatch fromunoccluded pixels. You can use the Edge
Occlusions, Colour Sigma, and Region Size controls to define how this is done. Occlusion Compensate
replaces theHalo Correct option in Ocula 2.

• The Pre-blur Disparity control has been removed.

• VerticalAligner

• If cameras are attached to O_Solver, the camera data is used per frame in theCamera Rotationmethod in O_
VerticalAligner. Previously, it was only taken from keyframes.
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• O_VerticalAligner has a newWarp Modemenu. Local Alignment can be used to rebuild a per-pixel vertical
alignment to remove the vertical disparity calculated by an upstreamO_DisparityGenerator.

• O_DisparityViewer

• BUG ID 21784 - Instead of displaying disparity information in a Viewer overlay, O_DisparityViewer now
renders it to the image.

• BUG ID 21786 - O_DisparityViewer has a newDisplay control, which you can set to showDisparity Vectors,
Parallax Histogram, or Parallax Violations. Parallax Histogram and Parallax Violations also have
associatedHistogram and Parallax controls. The limits and ranges are all defined as a percentage of screen
width, that is:

horizontal disparity (in pixels) * 100 / format width (in pixels).

• Correlate

The option to Correlate with Ocula has been removed. Curves can be correlated fromone view to another using
Correlate points or Correlate average based on the improved disparity delivered by O_DisparityGenerator.

Bug Fixes
• BUG ID 21147 - O_DisparityGenerator didn’t work with cropped images.

• BUG ID 21770 - O_Solver: The influence of usermatches has been increased.

Known Issues andWorkarounds
• BUG ID 22755 - O_Solver: Feature selection does not work withmultiple Viewers.
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Appendix B

Node Dependencies
This appendix lists the data each Ocula node requires in its inputs (in addition to a stereo pair of images).

Node and Settings Required Input Data or Channels

Solve
Data

Disparity
Map

Occlusion
Mask

Vector
Generator

Depth
Channel

Stereo
Camera

O_Solver

All modes

O_DisparityGenerator

With Alignment = 0 (the
default setting)

With Alignment > 0

O_OcclusionDetector

All modes

O_ColourMatcher

All modes

O_FocusMatcher

All modes
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Node and Settings Required Input Data or Channels

Solve
Data

Disparity
Map

Occlusion
Mask

Vector
Generator

Depth
Channel

Stereo
Camera

O_VerticalAligner

Globalmode

Localmode

O_NewView

All modes

O_InteraxialShifter

All modes

O_VectorGenerator

All modes

O_Retimer

NoMotion input

O_DepthToDisparity

All modes

O_DisparityToDepth

All modes

O_DisparityViewer

All modes

O_MultiSample

All modes
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Appendix C

Third Party Licences
This appendix lists third party libraries used in Ocula, along with their licences.

Library Description Licence

Boost Source code
function / template
library

Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization
obtaining a copy of the software and accompanying documentation covered
by this license (the “Software”) to use, reproduce, display, distribute, execute,
and transmit the Software, and to prepare derivative works of the Software,
and to permit third-parties to whom the Software is furnished to do so, all
subject to the following:

The copyright notices in the Software and this entire statement, including the
above license grant, this restriction and the following disclaimer, must be
included in all copies of the Software, in whole or in part, and all derivative
works of the Software, unless such copies or derivative works are solely in the
form of machine-executable object code generated by a source language
processor.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUTWARRANTYOF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUTNOT LIMITED TO THEWARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND
NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHTHOLDERSOR
ANYONEDISTRIBUTING THE SOFTWARE BE LIABLE FOR ANYDAMAGESOR
OTHER LIABILITY, WHETHER IN CONTRACT, TORTOROTHERWISE, ARISING
FROM, OUTOF OR IN CONNECTIONWITH THE SOFTWAREOR THEUSEOR
OTHER DEALINGS IN THE SOFTWARE.
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Library Description Licence

Expat XML parser Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd and
Clark Cooper

Copyright © 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the “Software”), to deal
in the Softwarewithout restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUTWARRANTYOF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUTNOT LIMITED TO THEWARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORSOR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGESOROTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORTOROTHERWISE, ARISING
FROM, OUTOF OR IN CONNECTIONWITH THE SOFTWAREOR THEUSEOR
OTHER DEALINGS IN THE SOFTWARE.

FreeType Font support Portions of this software are copyright © 2008 The FreeType Project

(www.freetype.org). All rights reserved.
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Library Description Licence

FTGL OpenGL support FTGL - OpenGL font library

Copyright © 2001-2004 Henry Maddocks ftgl@opengl.geek.nz

Copyright © 2008 SamHocevar sam@zoy.org

Copyright © 2008 SeanMorrison learner@brlcad.org

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the “Software”), to deal
in the Softwarewithout restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUTWARRANTYOF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUTNOT LIMITED TO THEWARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORSOR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGESOROTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORTOROTHERWISE, ARISING
FROM, OUTOF OR IN CONNECTIONWITH THE SOFTWAREOR THEUSEOR
OTHER DEALINGS IN THE SOFTWARE.
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Library Description Licence

VXL Computer vision Copyright © 2000-2003 TargetJr Consortium

GE Corporate Research and Development (GE CRD)

1 Research Circle

Niskayuna, NY 12309

All Rights Reserved

Reproduction rights limited as described below.

Permission to use, copy, modify, distribute, and sell this software and its
documentation for any purpose is hereby granted without fee, provided that
(i) the above copyright notice and this permission notice appear in all copies
of the software and related documentation, (ii) the name TargetJr
Consortium (represented by GE CRD), may not be used in any advertising or
publicity relating to the softwarewithout the specific, prior written
permission of GE CRD, and (iii) any modifications are clearly marked and
summarized in a change history log.

THE SOFTWARE IS PROVIDED “AS IS” AND WITHOUTWARRANTYOF ANY
KIND, EXPRESS, IMPLIED OROTHERWISE, INCLUDING WITHOUT
LIMITATION, ANYWARRANTYOF MERCHANTABILITYOR FITNESS FOR A
PARTICULAR PURPOSE. IN NO EVENT SHALL THE TARGETJR CONSORTIUM BE
LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECTOR CONSEQUENTIAL
DAMAGESOF ANY KIND OR ANYDAMAGESWHATSOEVER RESULTING FROM
LOSSOF USE, DATAOR PROFITS, WHETHERORNOT ADVISED OF THE
POSSIBILITYOF SUCH DAMAGES, ORON ANY THEORYOF LIABILITY ARISING
OUTOF OR IN CONNECTIONWITH THEUSEOR PERFORMANCEOF THIS
SOFTWARE.
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End User License Agreement (EULA)
PLEASE READ THIS EULA CAREFULLY BEFOREORDERING ORDOWNLOADING ANY SOFTWARE FROM THISWEBSITE.
YOUR ATTENTION IS PARTICULARLYDRAWN TOCLAUSES 12 AND 13 WHEREWE LIMIT OUR LIABILITY TOUSERSOF
OUR SOFTWARE PRODUCTS.

IMPORTANTNOTICE TO ALL USERS: BYDOWNLOADING THIS SOFTWARE YOU ACKNOWLEDGE THAT YOU HAVE
READ THIS EULA, UNDERSTAND IT AND AGREE TOBE BOUND BY ITS TERMS AND CONDITIONS. IF YOU DONOT
AGREE TO THE TERMSOF THIS EULADONOTDOWNLOAD, INSTALL, COPYOR USE THE SOFTWARE.

IMPORTANTNOTICE TO CONSUMERS: YOU HAVE THE RIGHT TOWITHDRAW FROM YOUR TRANSACTIONWITHOUT
CHARGE AND WITHOUT REASON AT ANY TIME BEFOREDOWNLOADING OUR PRODUCT(S). HOWEVER YOU WILL
LOSE THIS RIGHTONCE YOU BEGIN TODOWNLOAD OUR PRODUCT(S). THIS DOES NOT AFFECT YOUR CONSUMER
RIGHTS IN RELATION TODEFECTIVE PRODUCTSOR SERVICES.

This END USER LICENSE AGREEMENT (this "EULA") is incorporated into the agreement between The Foundry
Visionmongers Limited, a company registered in England andWales, ("The Foundry"), and you, as either an individual
or a single company or other legal entity ("Licensee") on the terms of which you will purchase the products and
services of The Foundry (the “Agreement”).

1. GRANT OF LICENSE

1.1 Subject to the limitations of clause 3 and all the other terms of the Agreement, The Foundry grants to Licensee a
limited, non-transferable (subject to clause 2.1 (b) below) and non-exclusive license to download, install and use a
machine readable, object code version (subject to clause 4 below) of the software program identified in the
Agreement (the "Software") and accompanying user guide and other documentation (the "Documentation"), solely
for Licensee's own internal purposes (the "License"); provided, however, Licensee's right to download, install and use
the Software and theDocumentation is limited to those rights expressly set out in this EULA.

1.2 Some types of license in clause 2.1 limit the installation and use of the Software to the country in which Licensee
is based at the date of purchase (the “HomeCountry”), unless otherwise agreed in writing. Notwithstanding such
limits, Licenseemay still use the Software outside theHomeCountry if traveling or working outside theHome
Country on a temporary basis provided that such use does not exceed 70 days in aggregate in any rolling twelve
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month period or, in the case of a Licenseewho has purchased a fixed term license for less than twelvemonths, does
not exceed the number of days representing 20% of the term of the license.

1.3 Only to the extent that is proportionate to, and reasonably necessary to support, Licensee’s licensed use of the
Software in accordancewith the Agreement, Licenseemay (provided valid license keys have been obtained) install
the Software onmore than one computer, provided always that Licensee’s concurrent use of different installations
of the Software does not exceed the number of valid Licenses that Licensee has paid for.

2. LICENSE MODELS

2.1 For each product purchased, the License shall be one of the following types of license, and is subject to the
following. Please note that some licensingmodels do not apply to certain products. Whichever licensingmodel
applies, Licensee shall not at any one time usemore copies of the Software than the total number of valid licenses
purchased by Licensee.

(a) “Node Locked License”

If Licensee purchases a Node Locked License, Licensee shall install and use only a single copy of the Software on only
one computer at a time, whichmay be located anywhere in theHomeCountry.

(b) “Individual License”

If Licensee purchases an Individual License, Licenseewarrants and represents that Licensee is a natural person and
that only Licensee shall use the Software. Licenseemay assign the Individual License to another natural person
(“Assignee”); subject to Licensee (i) notifying The Foundry and obtaining its express written consent, (ii) paying an
administrative feewith respect to such transfer, and (iii) after transferring a single copy of the Software to the
Assignee, deleting any copies of the Software that Licenseemay have in Licensee’s possession, custody or power. An
Individual License entitles Licensee to use the Software on only one computer at a time, whichmay be located
anywhere and is not restricted to theHomeCountry.

(c) “Floating License”

If Licensee purchases a Floating License, use of the Softwaremay be at any site in theHomeCountry.

2.2 Some of the Softwaremay bemade available at concessionary rates as follows:

(a) “Educational License”

If Licensee has purchased the Software on the discount terms offered by The Foundry’s Educational Policy published
on its website (the “Educational Policy”), Licenseewarrants and represents to The Foundry as a condition of the
Agreement that: (i) (if Licensee is a natural person) he or she is a part-time or full-time student at the time of
purchase and will not use the Software for any commercial, professional or for-profit purposes; (ii) (if the Licensee is
not a natural person) it is an organization that will use the Software only for the purpose of training and instruction,
and for no other purpose, and (iii) Licenseewill at all times comply with the Educational Policy (as such policy may be
amended from time to time). Unless the Educational License is a Floating License, Licensee shall use the Software on
only one computer at a time, whichmay be located anywhere in theHomeCountry.
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(b) “Personal Learning Edition License”

If the Software is a Personal Learning Edition (“PLE”), it will not require a license key to be issued to Licensee and will
have limited functionality as described in theDocumentation. Licenseemay use it only for the purpose of personal
or internal training and instruction, and for no other purpose. PLE versions of the Softwaremay not be used for
commercial, professional or for-profit purposes including, for the avoidance of doubt, the purpose of providing
training or instruction to third parties. Licensee shall use the Software on only one computer at a time, whichmay be
located anywhere in theHomeCountry.

(c) “MODO Steam Edition”

A version of MODOwith limited functionality as described in theDocumentation is available to purchase on discount
terms through Valve Corporation’s Steam store. If Licensee has purchased such version, Licenseewarrants and
represents to The Foundry as a condition of the Agreement that: (i) Licensee is a natural person; and (ii) Licenseewill
use the Software strictly through Steam and only for personal, recreational and non-commercial use, except only
that if Licensee uses the Software to create assets and content Licenseemay sell such assets and content through
Valve’s SteamWorkshop.

(d) “Trial License”

Licenseemay register for a “Trial License” of the Software (not available for all products or in all regions ormarkets).
A Trial License lasts a limited specified period on the expiry of which the Softwarewill automatically cease to
function. Licensee shall use the Software on only one computer at a time, whichmay be located anywhere in the
HomeCountry.

2.3 If Licensee has purchased a License that permits “non-interactive” use of the Software (“Headless Rendering”),
Licensee is authorized to use a non-interactive version of the Software for rendering purposes only (i.e. without a
user, in a non-interactive capacity) and shall not use such Software on workstations or otherwise in a user-interactive
capacity. Headless Rendering is not available on all products. In all cases except MODO (in respect of which there is
no limit on the amount of Headless Rendering allowed), Headless Rendering licenses are limited to one computer
such that the number of computers on which Headless Rendering can be carried out is limited to the number of valid
Licenses that have been purchased.

3. RESTRICTIONS ON USE

Please note that in order to guard against unlicensed use of the Software a license key is required to access and
enable the Software (other than Softwarewhich is licensed under the Personal Learning Editionmodel – see clause
2.2 (b) above). Licensee is authorized to use the Software inmachine readable, object code form only (subject to
clause 4), and Licensee shall not: (a) assign, sublicense, sell, distribute, transfer, pledge, lease, rent, lend, share or
export the Software, the Documentation or Licensee's rights under this EULA; (b) alter or circumvent the license keys
or other copy protectionmechanisms in the Software or reverse engineer, decompile, disassemble or otherwise
attempt to discover the source code of the Software; (c) (subject to clause 4) modify, adapt, translate or create
derivative works based on the Software or Documentation; (d) use, or allow the use of, the Software or
Documentation on any project other than a project produced by Licensee (an "Authorized Project") or to provide a
service (whether or not any charge ismade) to any third party; (e) allow or permit anyone (other than Licensee and
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Licensee's authorized employees to the extent they areworking on an Authorized Project) to use or have access to
the Software or Documentation; (f) copy or install the Software or Documentation other than as expressly provided
for in this EULA; or (g) take any action, or fail to take action, that could adversely affect the trademarks, service
marks, patents, trade secrets, copyrights or other intellectual property rights of The Foundry or any third party with
intellectual property rights in the Software (each, a "Third Party Licensor"). For purposes of this clause 3, the term
"Software" shall include any derivatives of the Software.

Unless Licensee has purchased an Individual License, if the Software ismoved fromone computer to another, the
issuing of replacement or substituted license keys is subject to and strictly in accordancewith The Foundry’s License
Transfer Policy, which is available on The Foundry’s website and which requires a fee to be paid in certain
circumstances. The Foundry may from time to time and at its sole discretion vary the terms and conditions of the
License Transfer Policy.

4. SOURCE CODE

Notwithstanding that clause 1 defines “Software” as an object code version and that clause 3 provides that Licensee
may use the Software in object code form only:

4.1 if The Foundry has agreed to license to Licensee (including by way of providing SDKs, upgrades, updates or
enhancements/customization) source code or elements of the source code of the Software, the intellectual property
rights in which belong either to The Foundry or to a Third Party Licensor (“Source Code”), Licensee shall be licensed to
use the Source Code as Software on the terms of this EULA and: (a) notwithstanding clause 3 (c) Licenseemay use
the Source Code at its own risk in any reasonable way for the limited purpose of enhancing its use of the Software
solely for its own internal business purposes and in all respects in accordancewith this EULA; (b) Licensee shall in
respect of the Source Code comply strictly with all other restrictions applying to its use of the Software under this
EULA as well as any other restriction or instruction that is communicated to it by The Foundry at any time during the
Agreement (whether imposed or requested by The Foundry or by any Third Party Licensor);

4.2 to the extent that the Software links to any open source software libraries (“OSS Libraries”) that are provided to
Licenseewith the Software, nothing in the Agreement shall affect Licensee’s rights under the licenses on which the
relevant Third Party Licensor has licensed theOSS Libraries, as stated in theDocumentation. To the extent that Third
Party Licensors have licensed OSS Libraries on the terms of v2.1 of the Lesser General Public License issued by the
Free Software Foundation (see http://www.gnu.org/licenses/lgpl-2.1.html) (the “LGPL”), thoseOSS Libraries are
licensed to Licensee on the terms of the LGPL and are referred to in this clause 4.2 as the LGPL Libraries. The
Foundry will at any time during the three year period starting on the date of the Agreement, at the request of
Licensee and subject to Licensee paying to The Foundry a charge that does not exceed The Foundry’s costs of doing
so, provide Licenseewith the source code of the LGPL Libraries (the “LGPL Source”) in order that Licenseemay
modify the LGPL Libraries in accordancewith the LGPL, together with certain object code of the Software necessary
to enable Licensee to re-link any modified LGPL Library to the Software (he “Object”); and

4.3 notwithstanding any other term of the Agreement The Foundry gives no express or implied warranty,
undertaking or indemnity whatsoever in respect of the Source Code, theOSS Libraries (including the LGPL Libraries),
the LGPL Source or theObject, all of which are licensed on an “as is” basis, or in respect of any modification of the
Source Code, theOSS Libraries (including the LGPL Libraries) or the LGPL Sourcemade by Licensee (“Modification”).
Licenseemay not use theObject for any purpose other than its use of the Software in accordancewith this EULA.
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Notwithstanding any other term of the Agreement, The Foundry shall have no obligation to provide support,
maintenance, upgrades or updates of or in respect of any of the Source Code, theOSS Libraries (including the LGPL
Libraries), the LGPL Source, theObject or any Modification. Licensee shall indemnify The Foundry against all liabilities
and expenses (including reasonable legal costs) incurred by The Foundry in relation to any claim asserting that any
Modification infringes the intellectual property rights of any third party.

5. BACK-UP COPY

Licenseemay store one copy of the Software and Documentation off-line and off-site in a secured location within
theHomeCountry that is owned or leased by Licensee in order to provide a back-up in the event of destruction by
fire, flood, acts of war, acts of nature, vandalism or other incident. In no event may Licensee use the back-up copy of
the Software or Documentation to circumvent the usage or other limitations set forth in this EULA.

6. OWNERSHIP

Licensee acknowledges that the Software (including, for the avoidance of doubt, any Source Code that is licensed to
Licensee) and Documentation and all related intellectual property rights and other proprietary rights are and shall
remain the sole property of The Foundry and the Third Party Licensors. Licensee shall not remove, or allow the
removal of, any copyright or other proprietary rights notice included in and on the Software or Documentation or
take any other action that could adversely affect the property rights of The Foundry or any Third Party Licensor. To
the extent that Licensee is authorized to make copies of the Software or Documentation under this EULA, Licensee
shall reproduce in and on all such copies any copyright and/or other proprietary rights notices provided in and on
thematerials supplied by The Foundry hereunder. Nothing in the Agreement shall be deemed to give Licensee any
rights in the trademarks, servicemarks, patents, trade secrets, confidential information, copyrights or other
intellectual property rights of The Foundry or any Third Party Licensor, and Licensee shall be strictly prohibited from
using the name, trademarks or servicemarks of The Foundry or any Third Party Licensor in Licensee's promotion or
publicity without The Foundry's express written approval.

Subject to clause 4.3, The Foundry undertakes (the “Undertaking”) to defend Licensee or at The Foundry’s option
settle any claim brought against Licensee alleging that Licensee’s possession or use of the Software or
Documentation in accordancewith the Agreement infringes the intellectual property rights of a third party in the
same country as Licensee (“Claim”) and shall reimburse all reasonable losses, damages, costs (including reasonable
legal fees) and expenses incurred by or awarded against Licensee in connection with any such Claim, provided that
the undertaking shall not apply where the Claim in question is attributable to possession or use of the Software or
Documentation other than in accordancewith the Agreement, or in combination with any hardware, software or
service not supplied or specified by The Foundry. TheUndertaking is conditional on Licensee giving written notice of
the Claim to The Foundry as soon as reasonably possible, cooperating in the defence of the Claim and not making
any admission of liability or taking any step prejudicial to the defence of the Claim. If any Claim ismade, or in The
Foundry's reasonable opinion is likely to bemade, against Licensee, The Foundry may at its sole option and expense
(a) procure for Licensee the right to continue using the Software, (b) modify the Software so that it ceases to be
infringing, (c) replace the Softwarewith non-infringing software, or (d) terminate the Agreement immediately by
notice in writing to Licensee and refund the License Fee (less a reasonable sum in respect of Licensee's use of the
Software to the date of termination) on return of the Software and all copies. TheUndertaking constitutes Licensee's
exclusive remedy and The Foundry's only liability in respect of Claims.
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7. LICENSE FEE

Licensee acknowledges that the rights granted to Licensee under this EULA are conditional on Licensee's payment in
full of the license fee payable in connection with the Agreement (the "License Fee").

8. UPGRADES/ENHANCEMENTS

If the Licensee has paid an annually renewable fee for access to support, upgrades and updates for the Software
("Annual Upgrade and Support Programme"), this is subject to the terms and conditions for the Annual Upgrade and
Support Programme available on The Foundry's website. The Foundry may from time to time and at its sole
discretion vary the terms and conditions of the Annual Upgrade and Support Programme.

9. TAXES AND DUTIES

Licensee agrees to pay, and indemnify The Foundry from claims for, any local, state or national tax (exclusive of taxes
based on net income), duty, tariff or other impost related to or arising from the transaction contemplated by the
Agreement.

10. LIMITED WARRANTY

10.1 Subject to clause 10.3, The Foundry warrants that, for a period of ninety (90) days after Licensee first
downloads the Software (“Warranty Period”): (a) that the Softwarewill, when properly used on an operating system
for which it was designed, perform substantially in accordancewith the functions described in theDocumentation;
and (b) that the Documentation correctly describe the operation of the Software in all material respects. If, within
theWarranty Period, Licensee notifies The Foundry in writing of any defect or fault in the Software as a result of
which it fails to perform substantially in accordancewith theDocumentation, The Foundry will, at its sole option,
either repair or replace the Software, provided that Licenseemakes available all the information that may be
necessary to identify, recreate and remedy the defect or fault. This warranty will not apply to any defect or fault
caused by unauthorised use of or any amendment made to the Software by any person other than The Foundry. If
Licensee is a consumer, thewarranty given in this clause is in addition to Licensee’s legal rights in relation to any
Software or Documentation that is faulty or not as described.

10.2 The Foundry does not warrant that the Software or Documentation will meet Licensee's requirements or that
Licensee's use of the Softwarewill be uninterrupted or error free.

10.3 If Licensee purchases a license of the Software that is of a fixed termduration, theWarranty Period in clause
10.1 shall apply only to Licensee’s first purchase of such license and not to any subsequent renewal(s) even if a
renewal involves another download.

11. INDEMNIFICATION

Licensee agrees to indemnify, hold harmless and defend The Foundry, the Third Party Licensors and The Foundry's
and each Third Party Licensor’s respective affiliates, officers, directors, shareholders, employees, authorized resellers,
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agents and other representatives from all claims, defence costs (including, but not limited to, legal fees), judgments,
settlements and other expenses arising fromor connected with any claim that any authorised or unauthorised
modification of the Software or Documentation by Licensee or any person connected with Licensee infringes the
intellectual property rights or other proprietary rights of any third party.

12. LIMITATION OF LIABILITY TO BUSINESS USERS

This clause applies where Licensee is a business user. Licensee acknowledges that the Software has not been
developed to meet its individual requirements, and that it is therefore Licensee’s responsibility to ensure that the
facilities and functions of the Software as described in theDocumentationmeet such requirements. The Software
and Documentation is supplied only for Licensee’s internal use for its business, and not for any re-sale purposes or
for the provision of services to third parties. The Foundry shall not under any circumstances whatever be liable to
Licensee, whether in contract, tort (including negligence), breach of statutory duty, or otherwise, arising under or in
connection with the Agreement for loss of profits, sales, business, or revenue, business interruption, loss of
anticipated savings, loss or corruption of data or information, loss of business opportunity, goodwill or reputation or
any indirect or consequential loss or damage. In respect of any other losses, The Foundry’smaximumaggregate
liability under or in connection with the Agreement whether in contract, tort (including negligence) or otherwise, shall
in all circumstances be limited to the greater of US$5000 and a sumequal to the License Fee. Nothing in the
Agreement shall limit or exclude our liability for death or personal injury resulting fromour negligence, fraud or
fraudulent misrepresentation or for any other liability that cannot be excluded or limited by applicable law. This
EULA sets out the full extent of our obligations and liabilities in respect of the supply of the Software and
Documents. Except as expressly stated in this EULA, there are no conditions, warranties, representations or other
terms, express or implied, that are binding on The Foundry. Any condition, warranty, representation or other term
concerning the supply of the Software and Documentation whichmight otherwise be implied into, or incorporated
in, the Agreement, whether by statute, common law or otherwise, is excluded to the fullest extent permitted by law.

13. LIMITATION OF LIABILITY TO CONSUMERS

This clause applies where Licensee is a consumer. Licensee acknowledges that the Software has not been developed
to meet Licensee’s individual requirements, and that it is therefore Licensee’s responsibility to ensure that the
facilities and functions of the Software as described in theDocumentationmeet such requirements. The Software
and Documentation are only supplied for Licensee’s domestic and private use. Licensee agrees not to use the
Software and Documentation for any commercial, business or re-sale purposes, and The Foundry has no liability to
Licensee for any loss of profit, loss of business, business interruption, or loss of business opportunity. The Foundry
is only responsible for loss or damage suffered by Licensee that is a foreseeable result of The Foundry’s breach of the
Agreement or its negligence but The Foundry is not responsible for any loss or damage that is not foreseeable. Loss
or damage is foreseeable if they were an obvious consequence of a breach or if they were contemplated by Licensee
and The Foundry at the time of forming the Agreement. Ourmaximumaggregate liability under or in connection
with the Agreement, whether in contract, tort (including negligence) or otherwise, shall in all circumstances be limited
to a sumequal to the greater of US$5000 and a sumequal to the License Fee. Nothing in the Agreement shall limit
or exclude our liability for death or personal injury resulting fromour negligence, fraud or fraudulent
misrepresentation or for any other liability that cannot be excluded or limited by applicable law.
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14. TERM; TERMINATION

The Agreement is effective upon Licensee's download of the Software, and the Agreement will remain in effect until
termination. Licenseemay terminate the Agreement at any time on written notice to The Foundry. If Licensee
breaches the Agreement, The Foundry may terminate the License by notice to Licensee. If the Agreement is
terminated, the Licensewill cease immediately and Licenseewill either return to The Foundry all copies of the
Software and Documentation in Licensee's possession, custody or power or, if The Foundry directs in writing,
destroy all such copies. In the latter case, if requested by The Foundry, Licensee shall provide The Foundry with a
certificate confirming that such destruction has been completed.

15. CONFIDENTIALITY

Licensee agrees that the Software (including, for the avoidance of doubt, any Source Code that is licensed to
Licensee) and Documentation are proprietary to and the confidential information of The Foundry or, as the case
may be, the Third Party Licensors, and that all such information and any related communications (collectively,
"Confidential Information") are confidential and a fundamental and important trade secret of The Foundry and/or
the Third Party Licensors. If Licensee is a business user, Licensee shall disclose Confidential Information only to
Licensee's employees who areworking on an Authorized Project and have a "need-to-know" such Confidential
Information, and shall advise any recipients of Confidential Information that it is to be used only as expressly
authorized in the Agreement. Licensee shall not disclose Confidential Information or otherwisemake any
Confidential Information available to any other of Licensee's employees or to any third parties without the express
written consent of The Foundry. Licensee agrees to segregate, to the extent it can be reasonably done, the
Confidential Information from the confidential information andmaterials of others in order to prevent commingling.
Licensee shall take reasonable security measures, whichmeasures shall be at least as great as themeasures Licensee
uses to keep Licensee's own confidential information secure (but in any case using no less than a reasonable degree
of care), to hold the Software, Documentation and any other Confidential Information in strict confidence and safe
custody. The Foundry may request, in which case Licensee agrees to comply with, certain reasonable security
measures as part of the use of the Software and Documentation. This clause shall not apply to any information that
is in or comes into the public domain, or was in Licensee’s lawful possession before receipt or which Licensee
develops independently and without breach of this clause. Licensee acknowledges that monetary damagesmay not
be a sufficient remedy for unauthorized disclosure of Confidential Information, and that The Foundry shall be
entitled, without waiving any other rights or remedies, to such injunctive or other equitable relief asmay be deemed
proper by a court of competent jurisdiction.

16. INSPECTION AND INFORMATION

16.1 Unless Licensee is a consumer, Licensee shall advise The Foundry on demand of all locations where the
Software or Documentation is used or stored. Licensee shall permit The Foundry or its authorized agents to audit all
such locations during normal business hours and on reasonable advance notice.

16.2 The Softwaremay includemechanisms to collect limited information from Licensee’s computer(s) and transmit
it to The Foundry. Such information (the “Information”) may include details of Licensee’s hardware, details of the
operating system(s) in use on such hardware and the profile and extent of Licensee’s use of the different elements of
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the Software. The Foundry may use the Information to (a) model the profiles of usage, hardware and operating
systems in use collectively across its customer base in order to focus development and support, (b) to provide
targeted support to individual customers, (c) to ensure that the usage of the Software by Licensee is in accordance
with the Agreement and does not exceed any user number or other limits on its use, and (d) to advise Licensee about
service issues such as available upgrades andmaintenance expiry dates. To the extent that any Information is
confidential to Licensee it shall be treated as such by The Foundry. To the extent that any Information constitutes
personal data for the purposes of the Data Protection Act 1998 it shall be processed by The Foundry in accordance
with that Act and with The Foundry’s privacy policy (see http://www.thefoundry.co.uk/privacy/). Licensee
undertakes to make all of users of the Software aware of the uses which The Foundry will make of the Information
and of the terms of The Foundry’s privacy policy.

17. U.S. GOVERNMENT LICENSE RIGHTS

All Software, including all components thereof, and Documentation qualify as “commercial items,” as that term is
defined at Federal Acquisition Regulation (“FAR”) (48 C.F.R.) 2.101, consisting of “commercial computer software”
and “commercial computer software documentation” as such terms are used in FAR 12.212. Consistent with FAR
12.212 and DoD FAR Supp. 227.7202-1 through 227.7202-4, and notwithstanding any other FAR or other
contractual clause to the contrary in any agreement into which this Agreement may be incorporated, a government
end user will acquire the Software and Documentation with only those rights set forth in this Agreement. Use of
either the Software or Documentation or both constitutes agreement by the government that all Software and
Documentation are “commercial computer software” and “commercial computer software documentation,” and
constitutes acceptance of the rights and restrictions herein. The Software is the subject of the following notices:

* Copyright © 2001 - 2014 The Foundry Visionmongers Limited. All Rights Reserved.

* Unpublished-rights reserved under the Copyright Laws of theUnited Kingdom.

18. SURVIVAL.

Clause 6 and clauses 9 to 20 inclusive shall survive any termination or expiration of the Agreement.

19. IMPORT/EXPORT CONTROLS

To the extent that any Softwaremade available under the Agreement is subject to restrictions upon export and/or
re-export from theUnited States, Licensee agrees to comply with, and not act or fail to act in any way that would
violate, the applicable international, national, state, regional and local laws and regulations, including, without
limitation, the United States Foreign Corrupt Practices Act, the Export Administration Act and the Export
Administration Regulations, as amended or otherwisemodified from time to time, and neither The Foundry nor
Licensee shall be required under the Agreement to act or fail to act in any way which it believes in good faith will
violate any such laws or regulations.
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20. MISCELLANEOUS

Unless Licensee is a consumer, the Agreement is the exclusive agreement between the parties concerning its subject
matter and supersedes any and all prior oral or written agreements, negotiations, or other dealings between the
parties concerning such subject matter. Licensee acknowledges that Licensee has not relied upon any representation
or collateral warranty not recorded in the Agreement inducing it to enter into the Agreement. The Agreement may be
modified only in writing. The failure of either party to enforce any rights granted under the Agreement or to take
action against the other party in the event of any such breach shall not be deemed awaiver by that party as to
subsequent enforcement of rights or subsequent actions in the event of future breaches. The Agreement and any
dispute or claim arising out of or in connection with it or its subject matter or formation (including, unless Licensee is
a consumer, non-contractual disputes or claims) shall be governed by, and construed in accordancewith English Law
and the parties irrevocably submit to the non-exclusive jurisdiction of the English Courts, subject to any right that a
consumermay have to bring proceedings or to have proceedings brought against them in a different jurisdiction.

If The Foundry fails to insist that Licensee performs any obligation under the Agreement, or delays in doing so, that
will not mean that The Foundry has waived its rights.

Unless Licensee is a consumer, Licensee agrees that The Foundry may refer to Licensee as a client or a user of the
Software, may display its logo(s) for this purpose andmay publish quotations and testimonials from Licensee, its
directors, partners, officers or employees. The Foundry agrees to promptly cease any such use on Licensee’s written
request.

The Foundry and Licensee intend that each Third Party Licensormay enforce against Licensee under the Contracts
(Rights of Third Parties) Act 1999 (the “Act") any obligation owed by Licensee to The Foundry under this EULA that is
capable of application to any proprietary or other right of that Third Party Licensor in or in relation to the Software.
The Foundry and Licensee reserve the right under section 2(3)(a) of the Act to rescind, terminate or vary this EULA
without the consent of any Third Party Licensor.

Copyright © 2014 The Foundry Visionmongers Limited. All Rights Reserved. Do not duplicate.
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